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This document describes how to contact Oracle Corporation if you have issues with 
the documentation or software. 

How to Contact Oracle Technical Publications
Oracle Corporation welcomes your comments and suggestions on the quality and 
usefulness of this publication. Your input is an important part of the information 
used for revision.

■ Did you find any errors?

■ Is the information clearly presented?

■ Do you need more information? If so, where?

■ Are the examples correct? Do you need more examples?

■ What features did you like most about this manual?

■ Do you have suggestions for improvement? Please indicate the chapter, section, 
and page number (if available). 

You can send comments regarding documentation to ntdoc@us.oracle.com

Read the section... If you...

"How to Contact Oracle Technical Publications" on page -xi Have issues with Documentation

"How to Contact Oracle Support Services" on page -xiv Have issues with Software

"Resources for Oracle Partners and Developers" on page -xiv Want to join an Oracle partner or application 
developer program
xi



How to Contact Oracle Support Services
Please copy this page and distribute within your organization as necessary.

Oracle Support Services can be reached at the following telephone numbers. The 
hours of business are detailed in your support contract and the Oracle Customer 
Support Guide in your kit.

Please complete the following checklist before you call. If you have this information 
ready, your call can be processed much quicker.

❏ Your CPU Support Identification Number (CSI Number) if applicable.

❏ The hardware name on which your application is running. 

❏ The operating system name and release number on which your application is 
running.

Oracle Support 
Services In... Call...

United States of 
America

+ (650) 506-1500 for customers with support contracts

+ (650) 506-5577 to obtain a support contract

Europe +44 1344 860 160 or the local support center in your country.

All other 
locations

The telephone number for your country listed at the following Web site:

http://www.oracle.com/support/html/suploc.html

Oracle Support Services telephone numbers are also listed in the Oracle 
Customer Support Guide in your kit.
xii



❏ The release numbers of the Oracle Server and associated products involved in 
the current problem. For example, Oracle8 Server release 8.0.6.0.0 and Oracle 
Replication Manager release 1.6.0.0.0.

❏ Are you using 16-bit or 32-bit Oracle software?

❏ The third-party vendor and version you are using.

❏ The exact error codes and messages. Please write these down as they occur. 
They are critical in helping Oracle Support Services to quickly resolve your 
problem.

❏ A description of the issue, including:

■ What happened? For example, the command used and its result.

■ When did it happen? For example, during peak system load, or after a 
certain command, or after an operating system upgrade.
xiii



■ Where did it happen? For example, on a particular system, or within a 
certain procedure or table.

■ What is the extent of the problem? For example, production system 
unavailable, or moderate impact but increasing with time, or minimal 
impact and stable.

❏ Keep copies of any trace files, core dumps, and redo log files recorded at or near 
the time of the incident. Oracle Support Services may need these to further 
investigate your problem.

Resources for Oracle Partners and Developers
This section provides information on partner programs and resources for Oracle 
database administrators and application developers.

Information Source Description

Oracle Corporation Home Page

http://www.oracle.com

This Web site is the starting point for general information on 
Oracle Corporation.

Alliance Online

http://alliance.oracle.com

Oracle provides leading-edge technology, education, and 
technical support that enables you to effectively integrate 
Oracle into your business. By joining the Oracle Partner 
Program, you demonstrate to customers that you are 
committed to delivering innovative Oracle-based solutions 
and services.

The greater your commitment to Oracle, the more we can 
help you grow your business. It’s that simple. The value you 
derive is associated directly with your level of commitment.
xiv



Oracle Education

http://education.oracle.com/

Customers come to Oracle Education with a variety of 
needs. You may require a complete curriculum based on 
your job role to enable you to implement new technology. Or 
you may seek an understanding of technology related to 
your key area of responsibility to help you meet technical 
challenges. You may be looking for self-paced training that 
can be used as an ongoing resource for reference and 
hands-on practice. Or, you may be interested in an overview 
of a new product upgrade. Whatever your training need, 
Oracle Education has the solution. 

Oracle Technology Network

http://technet.oracle.com/

The Oracle Technology Network is your definitive source for 
Oracle technical information for developing for the Internet 
platform. You will be part of an online community with 
access to free software, Oracle Technology 
Network-sponsored Internet developer conferences, and 
discussion groups on up-to-date Oracle technology. 
Membership is free.

Oracle Store

http://oraclestore.oracle.com/

This is Oracle’s online shopping center. Come to this site to 
find special deals on Oracle software, documentation, 
publications, computer-based training products, and much 
more.

Oracle Support Services’ Support Web Center

http://www.oracle.com/support/

Oracle Support Services offers a range of programs so you 
can select the support services you need and access them in 
the way you prefer: by telephone, electronically, or face to 
face. These award-winning programs help you maintain 
your investment in Oracle technology and expertise.

Here are some of the resources available in the Support Web 
Center:

OracleMetaLink

http://www.oracle.com/support/
elec_sup/index.html

OracleMetaLink is Oracle Support Services' premier Web 
support service. It is available to Oraclemetals customers 
(Gold, Silver, Bronze), 24 hours a day, seven days a 
week.

OracleLifecycle

http://www.oracle.com/support/
sup_serv/lifecycle/index.html

OracleLifecycle is designed to deliver customized, 
industry-focused, full life-cycle support solutions that 
enable industry leaders to use Oracle technology to 
make smart business decisions, achieve operational 
excellence, and succeed in their markets.

Information Source Description
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ExpertONLINE

http://www.oracle.com/support/
sup_serv/online/index.html

Oracle Support Services has launched a new line of 
services called ExpertONLINE. These services provide 
online database administration for companies looking 
to supplement their existing DBA staff or fill a DBA 
role. Services range from ExpertDETECT, a monitoring, 
diagnostic, and recommendation service, to ExpertDBA, 
a full online database administration service.

Virtual Support Analyst (VSA)

http://www.oracle.com/support/
sup_serv/vsa_start.html

VSA is Oracle’s Internet e-mail service; it is available to 
U.S. customers with an Oraclemetals support agreement. 
With VSA, you can initiate a request for assistance 
through e-mail, bypassing the queues you may 
encounter when using telephone support. VSA also 
enables you to access Oracle’s bug database.

Customer Service

http://www.oracle.com/support/
cus_serv/index.html

This site provides resources to make your interactions 
with Oracle as easy as possible. Among the things you 
can do are

■ Learn what is a CPU Support Identification (CSI) 
number

■ Update your technical contact information

■ Find out whom to contact for invoice and collection 
issues

■ Request product update shipments

■ Access a glossary of Oracle Support Services terms

U.S. Customer Visit Program

http://www.oracle.com/support/
cus_serv/cus_visit.html

This U.S.-based program has been established to help 
our customers understand and obtain maximum benefit 
from the support services they have purchased.

The visit typically offers a customized orientation 
presentation, a comprehensive overview and 
demonstration of Oracle’s electronic services, and 
helpful tips on working more effectively with Oracle 
Support Services.

Support Web Center Library

http://www.oracle.com/support/
library/index.html

This site contains articles, guides, and other 
documentation to help you leverage the wealth of 
knowledge and reference material that Oracle Support 
Services produces.

Product Availability

infowin@us.oracle.com

Send an e-mail to request information on future product 
releases on Oracle for Windows NT and Windows 95/98.

Information Source Description
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Before You Begin

This guide is your primary source of introductory, post installation, configuration 
and administration information for Net8.

Specific topics discussed are:

■ Intended Audience

■ Prerequisites

■ How This Manual Is Organized

■ Related Documents

■ Conventions

■ Types of Documentation
xvii



Intended Audience
This user guide is for both end-users and network administrators who install, 
configure, and use Oracle Networking Products.

Prerequisites
This guide assumes that you are familiar with:

■ Windows NT or Windows 95/98 and have installed and tested it for your 
personal computer (PC) and network hardware

■ Relational database management concepts

How This Manual Is Organized
This manual is organized as follows:

Chapter 1, "Introducing Net8" 
Describes the connectivity architecture of Net8.

Chapter 2, "Introducing Net8 Products"
Describes Net8 products and features.

Chapter 3, "Understanding Post Installation Tasks"
Describes the results of installation.

Chapter 4, "Understanding Coexistence and Migration Issues"
Describes implications of migrating from SQL*Net to a Net8, and installing 
Net8 into the same Oracle home as SQL*Net.

Chapter 5, "Using Net8 with Multiple Oracle Homes"
Describes Net8 implications when using multiple Oracle homes.

Chapter 6, "Configuring the Network"
Describes how to configure and test your network using various Net8 methods.

Chapter 7, "Connecting To a Database"
Describes how to make database connections.
xviii



Chapter 8, "Performing Advanced Configuration"
Describes how to use optional configuration tools for specialized 
configurations.

Chapter 9, "Using the Oracle SNMP Agent"
Describes how to use and configure the Oracle SNMP Agent Kit.

Chapter 10, "Performing Administration Tasks"
Describes basic administrative tasks for the server, Oracle Names Server, 
Connection Manager, and client. Also, describes enabling tracing.

Appendix A, "Directory Structure"
Shows the installed directory structure as it relates to Net8.

Appendix B, "Modifying and Adding Configuration Parameters"
Describes how to add and modify Net8 configuration parameters.

Appendix C, "Configuration Files"
Describes the contents and parameters of the configuration files.

Appendix D, "Troubleshooting"
Describes diagnosing Net8 problems and resolving common error messages.

Appendix E, "Net8 Services and Port Numbers"
Lists the Window NT services and their port numbers.

Glossary
Provides brief descriptions of terms used throughout this guide.
xix



Related Documents
For more information, see the following guides:

■ Oracle8 Client Getting Started for Windows NT and Windows 95

■ Oracle8 Enterprise Edition Getting Started for Windows NT

■ Oracle8 Getting Started for Windows NT

■ Oracle8 Server Concepts

■ Oracle8 Server Reference Manual

■ Net8 Administrator’s Guide 

■ Oracle Security Server Guide 

■ Oracle Advanced Networking Option Administrator's Guide 

■ Oracle Cryptographic Toolkit Programmer's Guide

Conventions
The following conventions are used in this guide:

Convention Example Meaning

All uppercase plain ORANT\DATABASE\INITORCL.ORA Indicates command names, SQL 
reserved words, and keywords, as in 
ALTER DATABASE. All uppercase 
plain is also used for directory names 
and file names

Italic Italic used to indicate a variable:

filename.ORA

Italic used for emphasis:

The WHERE clause may be used to join 
rows in different tables.

Indicates a value that you must 
provide. For example, if a command 
asks you to type filename, you must 
type the actual name of the file.

Italic is also used for emphasis in the 
text and to indicate the titles of other 
guides.
xx



C:\> C:\ORANT\DATABASE> Represents the Windows NT command 
prompt of the current hard disk drive. 
Your prompt reflects the subdirectory 
in which you are working. Referred to 
as the MS-DOS command prompt in this 
guide.

Backslash (\) before a 
directory name

\DATABASE Indicates that the directory is a 
subdirectory of the root directory.

ORACLE_HOME Go to the ORACLE_HOME\DATABASE 
directory.

SVRMGR> @%ORACLE_
HOME%\RDBMS80\ADMIN\CATALOG.SQL

Oracle home is represented as the hard 
drive letter and the top level directory 
where your Oracle software is installed. 
In this guide, the convention ORACLE_
HOME is used to indicate your Oracle 
home directory, which may be:

■ C:\ ORANT for Windows NT

■ C:\ ORAWIN95 for Windows 95

or whatever you may have called your 
Oracle home.

In Server Manager commands, you 
may see %ORACLE_HOME%. Server 
Manager is able to locate your Oracle 
Home directory using the  %ORACLE_
HOME% variable. This convention can 
be used in Server Manager, SQL*Plus, 
Export, and Import.

HOME_NAME OracleHOME_NAMETNSListener80 Represents the Oracle home name if 
you use multiple Oracle homes. This 
convention is not applicable for the first 
Oracle home.

The home name can be up to sixteen 
alphanumeric characters. The only 
special character allowed in the home 
name is the underscore. 

Convention Example Meaning
xxi



HOMEID HOME0, HOME1, HOME2 Represents a unique registry subkey for 
each Oracle home directory in which 
you install products. A new HOMEID 
is created and incremented each time 
you install products to a different 
Oracle home directory on one 
computer. Each HOMEID contains its 
own configuration parameter settings 
for installed Oracle products.

Symbols period  .

comma  ,

hyphen  -

semicolon  ;

colon  :

equal sign  =

backslash  \

single quote  ‘

double quote  “

parentheses ()

Symbols other than brackets and 
vertical bars must be entered in 
commands exactly as shown.

Convention Example Meaning
xxii



Types of Documentation
Your documentation set consists of two types of documentation:

Documentation Type Describes...

Operating System-specific Installation, configuration, and use of Oracle Parallel Server in a 
Windows NT environment. Operating system-specific documents are 
occasionally referred to in the generic documentation set. These 
documents are easy to identify because they always mention their 
specific operating system in their title.

Generic Products that are uniform across all operating system platforms. The 
vast majority of documents in your documentation set belong to this 
category. While reading through the generic documentation set, you are 
occasionally asked to refer to your platform-specific or operating 
system-specific documentation for procedures specific to the Windows 
NT and Windows 95/98 operating systems.

To easily identify where these generic documentation references are 
described in this document, see the index of this guide for the following 
entry:

generic documentation references

All generic documentation references described in this guide appear 
under this index entry.
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                                                         Introducing
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Introducing Net8

This chapter covers the following topics: 

■ Net8 Release 8.0 Overview

■ Oracle Connectivity Overview

■ Architectural Overview
 Net8 1-1



Net8 Release 8.0 Overview
Net8 Release 8.0 Overview
Net8 replaces SQL*Net as the networking services and connectivity component for 
Oracle8. Net8 has evolved considerably from SQL*Net, supporting application 
programming interfaces, Java-enabled Internet browsers and network services such 
as naming and security—hence the name change. 

Net8 is the foundation of Oracle’s family of networking products, allowing 
databases and their applications to reside on different computers and communicate 
as peer applications. Net8 allows clients to communicate with Oracle8 and Oracle7 
servers through service names, which are easy to remember aliases for database 
addresses. Setting up Net8 primarily involves creating service names for clients so a 
simple connect string, such as CONNECT SCOTT/TIGER@SERVICE_NAME, can 
be used to make a connection from a client to a server. 

Depending on your needs, service names can be stored in a variety of places, 
including the Domain Name System (DNS), configuration files on each client, a 
centrally located Oracle Names Server, or a non-Oracle naming service. Wherever 
you choose to store your service names, Net8 offers tools to easily configure service 
names.
1-2 Net8 Getting Started                     



Oracle Connectivity Overview
Oracle Connectivity Overview
The main function of Net8 is to establish sessions and transfer data between a client 
and a server or between two servers. Once a session is established, Net8 acts as a 
data courier for the client and the server. The connection operation is initiated 
during any standard database login between the client application and the server, 
with information such as the client computer name and user name passed to the 
remote computer.

Sessions are established with the help of a network listener, located on the server. 
The network listener brokers the client request, handing off the request to the 
server. Every time a client (or server acting as a client) requests a session with a 
server, a network listener receives the actual request. The network listener 
determines the location of the server and enables the client to connect to the server. 
The network listener is a separate process whose responsibility is to listen for 
incoming client connection requests and manage the traffic to the server. 

Client Request
The user requests a database connection from the server by supplying input (SQL 
command) through a client-side application such as SQL*Plus. The application 
sends the request to Net8 to be transported across the network to the server. After 
the connection request is accepted by the network listener on the server, the client 
application requests database information from the server.

Server Response to Client Request
The server runs the Oracle8 database software and a Net8 network listener 
program. The Net8 network listener, through an Oracle Protocol Adapter, accepts 
connections from client applications on the network. 

Net8 on the server delivers the client data transfer request to the Oracle8 database. 
The database performs the function requested by the user on the client computer. 
Finally, Net8 transfers the results of the database functions to the client computer.
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Architectural Overview
Net8, the networking layer formerly known as SQL*Net, uses the Transparent 
Network Substrate (TNS) and standard industry network protocols to connect a 
client to a server and establish an Oracle session. The following figure shows the 
basic connectivity architecture and process, with a connection request originating 
from a client side application. The database returns the queried information in the 
reverse direction.

The following is an overview of Oracle network connectivity components:

■ Net8

■ Oracle Protocol Adapters

■ Network–Specific Protocol Stack

Net8
Net8 is a software layer that is required to communicate between Oracle clients and 
servers. The role of Net8 is to establish and maintain a connection between the 
client application and the server and exchange messages between them. It provides 
both client to server and server to server communications across any network. It 
enables client tools to access, modify, share, and store data on Oracle8 Servers over a 
network. The communication between client applications and servers takes place 
across one or more networks and is referred to as client/server communication. 

Net8

Oracle Protocol Adapter

Protocol Stack

Client Application

Net8

Oracle Protocol Adapter

Protocol Stack

Oracle8 ORDBMS

Client Side Server Side

Physical Network
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Transparent Network Substrate (TNS)
The TNS is an underlying layer of Net8 that receives requests and settles all generic 
connectivity functions such as opening and closing a session or sending and 
receiving requests or responses. TNS then passes control to an Oracle Protocol 
Adapter to make the protocol-specific call.

Oracle Protocol Adapters 
The Oracle Protocol Adapters are responsible for mapping TNS functionality to 
industry–standard protocols used in the client/server connection. Each adapter is 
responsible for mapping the equivalent functions between TNS and a specific 
protocol.

An Oracle Protocol Adapter translates (or adapts):

■ function calls of specific network protocols (such as TCP/IP) into equivalent 
function calls of the Oracle Transparent Network Substrate (TNS). 

■ TNS generic function calls into specific function calls for the underlying 
network protocol. 

Network–Specific Protocol Stack
The protocol stack (third party software) supplies a reliable means of 
communication across the network. All Oracle software in the client/server 
connection process requires an existing network protocol stack to make the 
machine–level connection between two computers. The network protocol is 
responsible only for getting the data from the client computer to the server 
computer, at which point the data is passed to the Oracle Protocol Adapter on the 
server side.

Additional Information: See: 

■ the third-party network documentation that came with your 
protocol software for a detailed technical discussion of these 
protocols.

■ Chapter 2, "Introducing Net8 Products", for a list of available 
protocol adapters.
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Introducing Net8 Products

This chapter describes Net8 components and features.

Specific topics discussed are:

■ Net8 Products

■ Supported Protocol Stack Vendors

■ Oracle Advanced Networking Option Products

■ Net8 Features
ducts 2-1
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Net8 Products
The table below lists each component of Oracle Networking Products and the 
platform on which it can be installed.

Net8 Products NT as 
Oracle 
Server

NT as 
Oracle 
Client

95/98 as 
Oracle 
Client

Separately 
Installable?

Net8 Client1 yes yes yes yes

Net8 Server yes no no yes

Oracle Protocol Adapters

■ TCP/IP Protocol Adapter yes yes yes yes

■ SPX Protocol Adapter yes yes yes yes

■ Named Pipes Protocol Adapter yes yes yes yes

■ Logical Unit Type 6.2 (LU6.2) Protocol 
Adapter2

yes yes no yes

■ Bequeath Protocol Adapter3 yes yes yes4 no

Configuration Tools

■ Net8 Easy Configuration Tool yes yes yes5 no

■ Oracle Net8 Assistant yes yes yes5 yes

Oracle Names Server yes no no yes

Oracle Connection Manager6 yes no no yes

Oracle SNMP Agent yes no no yes

NetWare Directory Services (NDS) Native 
Naming Adapter

no yes yes7 no

Authentication Adapters

■ NDS Authentication Adapter no yes yes7 no

■ Windows NT Native Authentication 
Adapter

yes yes yes no
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The Net8 products are described below:

Oracle Advanced Networking Option 
Products8

Network Security and Single Sign-On yes yes yes yes

■ CyberSAFE Authentication Adapter yes yes yes yes

■ Identix (Biometric) Authentication Adapter yes yes yes yes

■ Kerberos Authentication Adapter yes yes yes yes

■ SecurID Authentication Adapter yes yes yes yes

DCE Integration yes yes yes yes
1 If you choose to install only the Net8 Client software, Oracle Net8 Assistant and Oracle Net8 Easy Config 

configuration tools will not be installed on your system. To install these configuration tools, choose Custom 
Install, and select Oracle Net8 Assistant from the Available Products list in Oracle Installer.

2 Microsoft SNA Server version 3.0 is required for LU6.2 on Windows NT.
3 The local, non-network Bequeath Protocol Adapter is automatically installed with Net8 on Windows NT and is 

available for 32 bit applications, allowing client applications to communicate with a database server running on 
the same computer.

4 Bequeath only works on Windows 95/98 for connections to a Personal Oracle8 database.
5 We were not able to qualify these Java based products on Windows 98 for this release, as an officially supported 

version of Java is not yet available for Windows 98. No problems were found using these tools on Windows 98 
during testing.

6 Oracle Connection Manager is only available in the Oracle8 Enterprise Edition CD-ROM.
7 NDS Authentication and Naming Adapters are not supported for Windows 98 in this release.
8 The Advanced Networking Option is packaged separately from Net8.

Product Description

Net8 Client Provides products that allow client connection to databases across a 
network. A client-side application sends a request to Net8 to be 
transported across the network to the server. 

Net8 Server Provides products that allow the network listener, through an Oracle 
Protocol Adapter, to accept connections from client applications on the 
network. 

Net8 Products NT as 
Oracle 
Server

NT as 
Oracle 
Client

95/98 as 
Oracle 
Client

Separately 
Installable?
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Oracle Protocol Adapters The following Oracle Protocol Adapters are available:

■ TCP/IP Protocol Adapter Enables client/server conversation over a network using TCP/IP and 
Net8. This combination of Oracle products enables an Oracle application 
on a client to communicate with remote Oracle databases through 
TCP/IP (if the Oracle database is running on a host system that supports 
network communication using TCP/IP).

■ SPX Protocol Adapter Enables client/server conversation over a network using SPX and Net8. 
This combination of Oracle products enables an Oracle application on a 
client to communicate with remote Oracle databases through SPX (if the 
Oracle database is running on a host system that supports network 
communication using SPX). This protocol is predominantly used in 
Novell Netware environments. 

■ Named Pipes Protocol 
Adapter

Enables client/server conversation over a network using Named Pipes 
and Net8. This combination of Oracle products enables an Oracle 
application on a client to communicate with remote Oracle databases 
through Named Pipes (if the Oracle database is running on a host system 
that supports network communication using Named Pipes).

The Named Pipes Protocol Adapter is a high-level interface providing 
interprocess communications between clients and servers (distributed 
applications). One process (the server side of the application) creates the 
pipe, and the other process (the client side) opens it by name. What one 
side writes, the other can read, and vice versa. Named Pipes is specifically 
designed for PC LAN environments. 

■ Logical Unit Type 6.2 (LU6.2) 
Protocol Adapter

The adapter is part of the IBM Advanced Program-to-Program 
Communication (APPC) architecture. 

APPC is the IBM peer-to-peer (program-to-program) protocol for a 
System Network Architecture (SNA) network. SNA is an IBM reference 
model similar to the Open Systems Interconnect (OSI) model of the 
International Standards Organization (ISO).

APPC architecture lets the client and host communicate over an SNA 
network without forcing the client to emulate a terminal (as in 
terminal-to-host protocols). APPC architecture allows peer-to-peer 
communication; the client can initiate communication with the server.

An SNA network with the LU6.2 and Physical Unit Type 2.1 (PU2.1) 
protocols provides APPC. The LU6.2 protocol defines a session between 
two application programs; LU6.2 is a product-independent LU-type.

The LU6.2 Protocol Adapter enables an Oracle application on a PC to 
communicate with an Oracle database. This communication occurs over 
an SNA network with the Oracle database on a host system that supports 
APPC.

Product Description
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■ Bequeath Protocol Adapter Enables clients to retrieve information from the database without using 
the network listener. The Bequeath Adapter internally spawns a server 
thread for each client application. In a sense, it does the same operation 
that a remote network listener does for your connection, yet locally.

The Bequeath Protocol Adapter:

■ does not use a network listener (therefore, no network listener 
configuration is required)

■ is used for local connections where an Oracle client application (such 
as SQL*Plus) communicates with an Oracle server running on the 
same computer

■ only works in Dedicated Server mode. It cannot be used in a 
Multi-Threaded Server (MTS) mode.

■ is supported on Windows NT for 32-bit applications. It also works on 
Windows 95/98 for connections to a Personal Oracle8 database for 
32-bit applications.

■ is installed by default with Net8 Client

Configuration Tools Net8 has a number of new features that simplify configuration and 
administration of the Oracle network:

■ Net8 Easy Configuration Tool This Java-based tool enables you to set up service names in the 
TNSNAMES.ORA file. Use this tool for configuring simple networks and 
testing the configuration.

For more information, see "Using the Local Naming Method" on page 6-6.

■ Oracle Net8 Assistant Oracle Net8 Assistant helps you to configure and administer:

■ Service Names — The tool enables the user to create or edit the local 
naming file (TNSNAMES.ORA). 

■ Profile — The tool enables the user to create or edit the local 
configuration file (SQLNET.ORA) on the local computer.

■ Network Listeners — The tool enables the user to create or edit the 
local configuration file (LISTENER.ORA) on the local computer.

■ Oracle Names Servers — The tool enables the user to configure and 
control a Names Server from the local computer, and to control other 
Names Servers on remote computers.

For more information, see:

■ "Using the Local Naming Method" on page 6-6.

■ Oracle Net8 Administrator’s Guide

Product Description
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Oracle Names Server Oracle Names is a distributed naming service developed for Oracle 
environments to help simplify the setup and administration of global, 
client/server computing networks. Oracle Names does this by 
establishing and maintaining an integrated system of Names Servers. 
Names Servers work like a directory service storing addresses for all the 
database services on a network and making them available to clients 
wishing to make a connection. 

For more information, see "Using the Oracle Names Method" on 
page 6-11.

Oracle Connection Manager The Oracle Connection Manager provides three capabilities for Oracle8:

■ Connection Concentration Allows you to multiplex multiple logical client sessions through a single 
transport connection to an Oracle server destination. This permits large 
numbers of users to access a single database which is running in 
Multi-Threaded Server (MTS) mode, and thus increases the server’s 
scalability. To enable connection concentrations, add the following 
parameter to the INTISID.ORA configuration file for that server:

MTS_DISPATCHERS = (MULT=ON)

For more information, see:

■ "Configuring Oracle Connection Manager" on page 6-23.

■ Oracle Net8 Administrator’s Guide

■ Network Access Control (also 
known as firewall support) 

Provides a proxy for denying or allowing access to a database server. This 
feature, implemented only over the TCP/IP protocol, provides network 
filtering similar to that offered with a firewall.

For more information, see:

■ "Configuring Oracle Connection Manager" on page 6-23.

■ Oracle Net8 Administrator’s Guide

■ Multi-Protocol Support Replaces the Multi-Protocol Interchange. Allows client and database 
servers operating on different protocol stacks to communicate with each 
other. For more information, see:

■ For more information, see "Configuring Oracle Connection Manager" 
on page 6-23.

■ Oracle Net8 Administrator’s Guide

Oracle SNMP Agent Oracle SNMP Agent enables Oracle products running anywhere on an 
enterprise’s network to be located, identified, and monitored by a 
management station running at one or more centrally located nodes. 

For more information, see Chapter 9, "Using the Oracle SNMP Agent".

Product Description
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NetWare Directory Services 
(NDS) Native Naming Adapter

Enables you to integrate Oracle service names (or database aliases) and 
addresses into your existing non-Oracle name services. This feature 
allows users from multiple points to use a single login to access a 
multi-server and multi-database network, and view the entire network 
under a single directory tree.

The NDS Native Naming Adapter uses the NDS naming environment to 
store service names and addresses of Oracle8 Server for NetWare 
databases. This environment allows users to connect to Oracle8 databases 
on NetWare servers whose server name is defined as an NDS object 
name. 

To use the NDS Naming Adapter, you must configure your Windows 
client computer to a Novell NetWare 4.x Workstation.

Authentication Adapters Net8 offers the following authentication adapters:

■ NDS Authentication Adapter Allows a single login access a multi-server and multi-database network 
and view the entire network under a single NDS directory tree.

■ Windows NT Native 
Authentication Adapter

Allows operating system authentication to be performed between a client 
and an Oracle server on Windows NT.

Oracle Advanced Networking 
Option

See "Oracle Advanced Networking Option Products" on page 2-10.

Product Description
Introducing Net8 Products 2-7



Supported Protocol Stack Vendors
Supported Protocol Stack Vendors
The table below lists the supported protocol vendor for each Oracle Protocol 
Adapter: 

Oracle Protocol 
Adapter

Platform Supported Vendor

TCP/IP Protocol 
Adapter

Windows NT and 
Windows 95/98

Microsoft TCP/IP

SPX Protocol Adapter Windows NT and 
Windows 95/98

Microsoft NW Link

Novell NetWare Client 32 version 4.1

Novell IntranetWare Client version 4.1 for 
Windows NT

Novell IntranetWare Client version 2.2 for 
Windows 95

Note: For Microsoft NW Link, Client 
Service for NetWare must be installed.

Named Pipes Protocol 
Adapter

Windows NT and 
Windows 95/98

Microsoft NETBEUI

LU6.2 Protocol Adapter Windows NT Microsoft SNA Server version 3.0

Host Naming Adapter Windows NT Microsoft TCP/IP

NDS Native Naming 
Adapter

Windows NT and 
Windows 95

Novell NetWare Client 32 version 4.1

Novell IntranetWare Client version 4.1 for 
Windows NT

Novell IntranetWare Client version 2.2 for 
Windows 95/98

Note: An Oracle7 Server release 7.2.2 or 
above for Netware release 4.1 is required.

NDS Authentication 
Adapter

Windows NT and 
Windows 95

Novell NetWare Client 32 version 4.1

Novell IntranetWare Client version 4.1 for 
Windows NT

Novell IntranetWare Client version 2.2 for 
Windows 95/98

Note: An Oracle7 Server release 7.2.2 or 
above for Netware release 4.1 is required.
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Windows NT Native 
Authentication Adapter

Windows NT and 
Windows 95/98

Microsoft

ANO CyberSAFE 
Authentication Adapter

Windows NT and 
Windows 95/98

CyberSafe Application Security Toolkit 
version 1.0.4a

ANO Identix 
(Biometric) 
Authentication Adapter

Window NT and 
Windows 95/98

Identix hardware and driver on an Oracle8 
client.

ANO Kerberos 
Authentication Adapter

Windows NT and 
Windows 95/98

No vendor software requirements on an 
Oracle8 client or server

ANO SecurID 
Authentication Adapter

Windows NT and 
Windows 95/98

No vendor software requirements on an 
Oracle8 client or server, but a SecurID card 
is needed

ANO DCE Integration Windows NT and 
Windows 95/98

Gradient PC-DCE/32 Runtime Services 
Kit version 2.0

Oracle Protocol 
Adapter

Platform Supported Vendor
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Oracle Advanced Networking Option Products
The Advanced Networking Option (ANO) is an optional product that provides 
enhanced functionality to Net8. Its set of features provides enhanced security and 
authentication to your network, and enables integration with a Distributed 
Computing Environment (DCE).

ANO includes the following components:
:

Component Description

Network Security This Oracle network data encryption and checksumming service ensures 
secure transmission of data over networks. Network Security uses 
encryption and authentication engines from RSA Data Security, 
Incorporated.

The following algorithms are supported:

Encryption

■ RC4_40 (US, Export & Upgrade versions of ANO) 

■ RC4_56 (US only) 

■ RC4_128 (US only)

■ DES_56 (US & Upgrade) 

■ DES_40 (US, Export & Upgrade) 

Checksumming

■ MD5     (US, Export & Upgrade) 

Single Sign-On Allows users to access multiple accounts and applications with a single 
password. This feature eliminates the need for multiple passwords for 
users and simplifies management of user accounts and passwords for 
system administrators.

Centralized, secure authentication services allow you to have high 
confidence in the identity of users, clients, and servers in distributed 
environments. Network authentication services can also provide the 
benefit of single sign–on for users. 

The following adapters are supported:

■ CyberSAFE Authentication Adapter

■ Identix (Biometric) Authentication Adapter

■ Kerberos Authentication Adapter

■ SecurID Authentication Adapter
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DCE Integration Distributed Computing Environment (DCE) Integration enables users to 
transparently use Oracle tools and applications to access Oracle8 
databases in a DCE environment. The Oracle DCE Integration product 
consists of two major components: 

■ DCE Communications/Security Adapter 

■ DCE CDS (Cell Directory Service) Naming Adapter

Additional Information: See the Oracle Advanced Networking Option 
Administrator’s Guide.

Component Description
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Net8 Features
Net8 supports very large scale mission-critical environments, offers a 
state-of-the-art security server and simplifies administration and configuration of 
all environments, large and small. The major enhancements in Net8 can be grouped 
into these areas:

■ Manageability 

■ Naming Methods

■ Scalability

■ Security

■ Enhancements for Developers

Feature Description

Manageability Net8 has a number of features that simplify configuration and 
administration of the Oracle network:

■ Net8 Easy Configuration Tool This Java-based tool enables you to graphically set up service names. This 
tool succeeds the previously available tool called SQL*Net Easy 
Configuration (SQL*Net release 2.x). 

For more information, see "Using the Local Naming Method" on page 6-6.

■ Oracle Net8 Assistant This Java-based graphical configuration and management tool succeeds 
Oracle Network Manager, included in previous SQL*Net release 2.x 
releases. Oracle Net8 Assistant helps you to configure and administer 
complex networks.

For more information, see:

■ "Using the Local Naming Method" on page 6-6.

■ Oracle Net8 Administrator’s Guide

■ Trace Assistant Formats level 16 (SUPPORT) traces into paragraphs that are easier to read 
than unformatted trace files.

For more information, see:

■ "Enabling Tracing" on page 10-18.

■  "Trace Assistant" on page D-10.
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Naming Methods Net8 clients communicate with Oracle8 servers through service names, 
which are easy to remember aliases for database addresses. Net8 resolves 
service names using the following naming methods:

■ Host Naming Resolves Oracle service names via the existing name resolution service in 
a TCP/IP network. This name resolution service might be Domain Name 
System (DNS) or simply a centrally-maintained set of /ETC/HOSTS files. 
Host naming allows users to connect to an Oracle server simply by using 
the host’s network name. No client configuration is required to take 
advantage of this feature. 

For more information, see "Using the Host Naming Method" on page 6-4.

■ Local Naming Resolves service names using a local TNSNAMES.ORA configuration file.

For more information, see "Using the Local Naming Method" on page 6-6

■ Oracle Names Resolves service names using Oracle Names Servers. 

Oracle Names is a distributed naming service for Oracle networks. Oracle 
Names helps administrators manage large numbers of clients and servers 
in their environments.

For more information, see "Using the Oracle Names Method" on 
page 6-11.

■ External Naming Resolves service names using a supported third-party naming service. 
External naming is implemented with the NetWare Directory Services 
(NDS) Native Naming Adapter.

For more information, see "Using the External Naming Method" on 
page 8-2.

Feature Description
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Scalability Scalability refers to the ability to support simultaneous network access by 
a large number of clients to a single server. With Net8, this is 
accomplished by optimizing the usage of network resources by reducing 
the number of physical network connections a server must maintain. 

■ Oracle Connection Manager’s 
Connection Concentration

The Oracle Connection Manager uses multiplexing to combine the 
network traffic from several clients onto a single physical connection to 
the server, therefore conserving server resources. Unlike connection 
pooling, client connections to the server are maintained continually. This 
makes it ideal for applications requiring continuous connectivity (such as 
process control or a stock ticker). This functionality is supported by 
Multi-Threaded Server (MTS) configurations. 

For more information, see:

■ "Configuring Oracle Connection Manager" on page 6-23.

■ Oracle Net8 Administrator’s Guide

■ Connection Pooling Connection pooling is a feature implemented with Net8 clients and 
dispatchers for Multi-Threaded Server (MTS) configurations. It allows a 
limited number of (physical) transport connections to be shared among a 
large number of (logical) network sessions. This is achieved by using a 
time-out mechanism to temporarily release an idle transport connection 
while maintaining its network session. The transport connection is 
released only if it has been idle for the specified time-out period, all the 
transport connections in the pool are busy, and an active network session 
needs a transport connection. Use of connection pooling optimizes 
network resource utilization and increases the number of client-server 
sessions possible across a fixed number of physical server ports. It is ideal 
when many clients run interactive, “high idle/search time” applications, 
such as messaging or OLAP. 

Connection pooling is enabled by setting the MTS_DISPATCHERS 
parameter to the INTISID.ORA initialization file in ORACLE_
HOME\DATABASE.

Note: Connection pooling is only available with MTS on TCP/IP 
networks. 

For more information, see:

■ Oracle8 Server Reference Manual

■ Oracle Net8 Administrator’s Guide

■ your Getting Started guide

Feature Description
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■ Listener Load Balancing Distributes the number of incoming sessions over multiple network 
listeners for a single database or for two or more equivalent databases. 
This feature is configured by defining multiple network listeners for each 
database. To enable multiple network listeners for Multi-Threaded Server 
(MTS), add the MTS_MULTIPLE_LISTENERS=TRUE parameter to the 
INTISID.ORA initialization file in ORACLE_HOME\DATABASE.

For more information, see:

■ Oracle Net8 Administrator’s Guide

■ your Getting Started guide

■ Multi-Threaded Server 
Support (MTS)

Net8 supports the MTS only in TCP/IP network environments.

Note: IPC Dispatchers are not supported in this release.

For more information, see:

■ your Getting Started guide

■ Oracle8 Concepts

■ WINSOCK2 Support This release of Net8 supports both the WINSOCK 1.1 and WINSOCK2 
socket interface. Net8 automatically detects WINSOCK2 on Windows NT 
and uses it if it is available. 

WINSOCK2 is a standard feature of Windows NT 4.0. Oracle uses these 
WINSOCK2 features in Net8:

■ overlapped I/O with events

■ shared sockets (can be enabled as an optional feature), as described 
in Appendix B, "Modifying and Adding Configuration Parameters"

WINSOCK2 support enables Net8 features such as:

■ Multi-Threaded Server (MTS) support

■ Oracle Connection Manager

■ connection pooling 

Security Net8 offers the following security features:

■ Oracle Security Server Supports authentication and authorization in an Oracle network 
environment using public-key cryptography. The Oracle Security Server 
is a separate product bundled with Oracle8 and Net8.

For more information see the Oracle Security Server Guide.

■ Oracle Connection Manager’s 
Network Access Control

Incorporates a Net8 application proxy for implementing firewall-like 
functionality.

For more information, see "Configuring Oracle Connection Manager" on 
page 6-23.

Feature Description
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Enhancements for Developers Net8 offers the following enhancement for developers:

■ Net8 OPEN Net8 OPEN is an application programming interface (API) that allows 
users to write applications that use Net8 for connectivity. Net8 OPEN:

■ enables developers to develop both database and non-database 
applications that use the Net8 network already deployed in their 
environment

■ enables developers to deploy an application developed on one 
computer to another without needing to modify their calls to the 
network interface

■ provides developers with a single common interface to all industry 
standard network protocols

■ On Windows NT and Windows 95, use $ORACLE_
HOME\NET80\LIB\TNSAPI.LIB and the include file 
$ORACLE_HOME\NET80\INCLUDE\TNSAPI.H.

Note: The TRCROUTE application is not supported on Windows 
platforms.

For more information, see Oracle Net8 Administrator’s Guide.

Feature Description
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3

Understanding Post Installation Tasks

This chapter describes what happens during the installation of Net8 and what tasks 
must be performed after installation for basic operation. 

Specific topics discussed are:

■ Typical Installation Results

■ Verifying Installation and Setup
Tasks 3-1
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Typical Installation Results
If a Typical Installation is performed, the following Net8 products are installed:

Installation of some Oracle Protocol Adapters (TCP/IP, SPX and Named Pipes) is 
done based on automatic detection of protocol stacks. LU6.2 must be installed 
separately through the Oracle Installer’s Custom Installation option.

When you install Net8, Oracle services are created and displayed in the Services 
dialog box. Note that some service names include a HOME_NAME. You can now 
have multiple active Oracle homes usable concurrently on a single computer. Each 
Oracle home has a unique HOME_NAME to distinguish it from all other Oracle 
homes active on your computer. This HOME_NAME is reflected in the names of the 
services. HOME_NAME is null for the first Oracle home. See Chapter 5, "Using Net8 
with Multiple Oracle Homes", for more information about HOME_NAME.

Oracle8 Database Oracle8 Client

Net8 Server and Net8 Client Net8 Client

Oracle Protocol Adapter(s):

■ TCP/IP

■ SPX

■ Named Pipes

Note: Installation of adapters is 
dependent on protocol stacks on the 
system.

Oracle Protocol Adapter(s):

■ TCP/IP

■ SPX

■ Named Pipes

Note: Installation of adapters is 
dependent on protocol stacks on the 
system.

Oracle Names Server

Additional Information: See the CD-ROM insert for more 
information about the Oracle Installer and its options.
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Custom Connection Manager Installation
The following Net8 Windows NT services are installed:

Custom Connection Manager Installation
When Connection Manager is installed through the Custom Installation option, the 
following NT services are installed. After configuration, you must start service(s) 
you need:

Oracle Service Description Server Client

OracleHOME_NAMEClientCache80 Service to enable client caching.

Not started, and set up as Manual 
Startup.

yes yes

OracleHOME_NAMENamesService80 Service associated with the Oracle Names 
Servers.

Not started, and set up as Manual 
Startup.

yes no

OracleHOME_NAMETNSListener80 Service associated with the network 
listener.

Started, and set up as Automatic 
Startup.1

1 The network listener is set to Automatic Startup mode if no other network listener is started on the system or set 
up as Automatic Startup mode. Otherwise, the network listener is setup in Manual Startup mode.

yes no

Oracle Service Description

OracleHOME_NAMECMAdminService80 Service associated with the Connection Manager’s 
administrative process. This service registers the 
Connection Manager with the Names Servers and acquires 
information about the Names Servers.

Not started, and set up as Manual Startup.

OracleHOME_NAMECManService80 Service associated with the Connection Manager’s main 
process.

Not started, and set up as Manual Startup.
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Verifying Installation and Setup
To verify installation:

1. Start the Oracle Installer:

From the taskbar, select Start > Programs > Oracle for Windows NT or 
Windows 95/98 - HOME_NAME > Oracle Installer.

The Software Asset Manager window appears with the currently installed 
products listed in the list box on the right side of the window.

2. Click Exit to exit the Oracle Installer.

A dialog box appears, asking you if you want exit the Oracle Installer.

3. Choose Yes.

Oracle Installer exits.

Note: Third-party network protocol stacks must also be installed 
and tested prior to installing Oracle8. 
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Understanding Coexistence and Migration

Issues

This chapter describes migration and coexistence issues for SQL*Net release 2.x and 
Net8. Specific topics discussed are:

■ Net8 and SQL*Net Differences

■ Migration and Coexistence Overview

■ Migration Issues

■ Coexistence Issues
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Net8 and SQL*Net Differences
When dealing with SQL*Net to Net8 migration and SQL*Net and Net8 coexistence, 
keep in mind the following features that impact the location and structure of the 
configuration files:

This Feature... SQL*Net Net8

Configuration File 
Location

SQL*Net stores files in ORACLE_
HOME\NETWORK\ADMIN

Net8 stores files in ORACLE_
HOME\NET80\ADMIN

Multiple Protocol 
Support

Multi-Protocol Interchange allows 
applications in TNS networks to 
communicate across different     
protocols.

The Oracle Connection Manager 
has a multi-protocol support feature 
which allows client and database 
servers operating on different 
protocol stacks to communicate 
with each other. 

For more information, see 
"Configuring Oracle Connection 
Manager" on page 6-23.

Configuration Tools SQL*Net provides:

■ SQL*Net Easy Configuration to 
create service names

■ Oracle Network Manager for 
complex configurations

Net8 provides:

■ Net8 Easy Configuration Tool 
to create service names

■ Oracle Net8 Assistant for 
complex configurations and 
network administration

External Procedures Not Applicable Support for external procedure, a 
function or procedure written in a 
third-generation language (3GL) 
that can be called from PL/SQL 
code.
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Migration and Coexistence Overview
When installing Oracle Networking Products, you have these installation decisions 
to make:

Migration and Coexistence Considerations
This section discusses:

■ Oracle7 Client Connections to Oracle8 Databases

■ Oracle8 Client Connections to Oracle7 Databases

■ Oracle Names

Oracle7 Client Connections to Oracle8 Databases
As the diagram below depicts, an Oracle7 Client requires SQL*Net Client, and an 
Oracle Server requires Net8 Server. When the client and server are on the same 
computer, both SQL*Net Client and Net8 Server are required. 

Installation Decision Description

Coexistence Install Net8 into the same Oracle home as your SQL*Net release 
2.x.

Migration Migration is the process of moving from SQL*Net release 2.x to 
Net8. Migration involves installing Net8 and de-installing 
SQL*Net release 2.x.

Oracle8
Database

Oracle7 Client Application

   SQL*Net Client Net8 Server 
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Migration and Coexistence Overview
Consider the following questions for your own environment.

■ Will my third party Oracle7 applications be able to take advantage of Net8 
features?

No. You must rebuild or upgrade applications to work with Net8 libraries.

■ Do my Oracle7 clients require Net8 Client to connect to a remote Oracle8 database?

No. If an Oracle7 client needs to connect to a remote Oracle8 database, only 
SQL*Net Client release 2.x has to be configured on the Oracle7 client. Net8 is 
backward compatible with SQL*Net release 2.x. The only limitation is that the 
new network features available with Net8 are unavailable with this connection 
type. 

■ Do my Oracle7 clients require Net8 Client to connect to a local Oracle8 database?

Yes. If the Oracle7 client needs to connect to a local Oracle8 database, you should 
have SQL*Net Client release 2.x, Net8 Client, and Net8 Server on the same 
system. SQL*Net Client 2.x needs to be in the Oracle7 Client Oracle home, while 
the Net8 Client and Server should be in the Oracle8 Oracle home. Note that 
Net8 Client and Net8 Server are already installed during the installation of 
Oracle8/TM Enterprise Edition or Oracle8. 

If you are using Oracle7 release 7.3.4 and SQL*Net release 2.3.4, you can connect 
to the Oracle8 database without specifying a service name. Oracle7 client 
automatically uses the Bequeath Protocol Adapter when connecting to an 
Oracle8 database.

If you are using Oracle7 release 7.3.3 (or lower) and SQL*Net release 2.3.3 (or 
lower), you need to create a service name using SQL*Net Easy Configuration or 
Oracle Network Manager in the SQL*Net Client release 2.x TNSNAMES.ORA 
file. Ensure you specify this service name in the connect string when connecting 
to the Oracle8 database. 

The service can use any protocol adapter installed except the Bequeath Protocol 
Adapter. The figure below gives an example of this network configuration:
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Oracle8 Client Connections to Oracle7 Databases
An Oracle8 Client requires Net8 Client, and an Oracle7 Server requires SQL*Net 
Server. When the client and server are on the same computer, both Net8 Client and 
SQL*Net Server are required.

Consider the following questions for your own environment.

■ Do my Oracle8 clients require SQL*Net Client release 2.x to connect to a remote 
Oracle7 database?

No. If an Oracle8 client needs to connect to a remote Oracle7 database, only Net8 
Client needs to be configured on the Oracle8 client. SQL*Net release 2.x is 
upwards compatible with Net8. The only limitation is that the new network 
features available with Net8 are unavailable with this connection type.

■ Do my Oracle8 clients require SQL*Net Client release 2.x to connect to a local Oracle7 
database?

Yes. If the Oracle8 client needs to connect to a local Oracle7 database, you need 
both SQL*Net Server release 2.x and Net8 Client on the same system. Net8 
Client needs to be in the Oracle8 Oracle home, while SQL*Net 2.x should be in 
the Oracle7 Oracle home. Note that the Oracle8 client uses the Bequeath 
protocol adapter by default to connect to an Oracle7 database. 

Oracle7
Database

Oracle8 Client Application

   Net8 Client SQL*Net Server 
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Migration and Coexistence Overview
Oracle Names
If you migrate all or part of your network to Net8, and you add or upgrade any 
release 8 Names Servers to an existing network, you should upgrade all the Names 
Servers in the region to version 8. There should be at least two Names Servers, for 
fault-tolerance. 

■ Can my Oracle7 clients use Oracle Names version 8 to resolve service names?

Yes. 

■ Can my Oracle7 client then use the connect string returned form Oracle Names version 
8 to connect to an Oracle7 or Oracle8 database?

Yes, if the connect string was specified correctly when it was entered into Oracle 
Names. In other words, if the connect string worked from a TNSNAMES.ORA 
file, it will work from Oracle Names.

Net8 Client is not available for Windows 3.1x, however, SQL*Net version 2 
clients can be used to connect to Oracle8 databases.
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Migration Issues
SQL*Net release 2.x clients should migrate to Net8 only when their client 
applications migrate to Oracle8.

Installation
If you are migrating from SQL*Net release 2.x to Net8 in the same Oracle home, 
Oracle Installer automatically performs these tasks:

1. Configuration files are copied from ORACLE_HOME\NETWORK\ADMIN 
and saved into ORACLE_HOME\NET80\ADMIN.

2. SQL*Net release 2.x network listener is stopped. The startup type is changed 
from Automatic to Manual (Windows NT Control Panel).

3. Net8 network listener is setup as Automatic startup and is started.

4. Entries are added to the TNSNAMES.ORA and LISTENER.ORA files for 
external procedures, if the entries are not already present.

When migrating from Oracle7 Server release 7.3.x to Oracle8 release 8.0.6, install the 
appropriate version of SQL*Net for the server before using Oracle Data Migration 
Assistant. Migration will be unsuccessful if you do not install the appropriate 
versions of SQL*Net.

You do not need to install a SQL*Net patch when migrating from Oracle7 release 
7.3.4 to Oracle8 release 8.0.6.
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Migrating from... Install...

Oracle7 release 7.3.2.x to Oracle8 SQL*Net release 2.3.2.1.4

SQL*Net patch 2.3.2.1.12

Note:  If you do not have SQL*Net release 2.3.2.1.4 on your system, you 
must install it before installing SQL*Net patch 2.3.2.1.12. SQL*Net release 
2.3.2.1.4 is not available on the release 8.0.6 CD-ROM. You must install it 
from the release 7.3.2 CD-ROM. 

Oracle7 release 7.3.3.x to Oracle8 SQL*Net release 2.3.3.0.3

To install SQL*Net patch 2.3.2.1.12 or patch 2.3.3.0.3

1. Start Oracle Installer from the CD-ROM. See Oracle8 Enterprise Edition 
Installation Release 8.0.6 for Windows NT for complete installation 
instructions.

2. Answer questions about language and Oracle home directory location.

3. Select Custom Installation. The Software Asset Manager window 
appears.

4. Click From...

5. Navigate to \PATCHES\SQLNET\232112 on the CD-ROM if you 
want to install SQL*Net patch 2.3.2.1.12. Navigate to 
\PATCHES\SQLNET\23303 if you want to install SQL*Net patch 
2.3.3.0.3.

6. Select SQL*Net Server 2.3.2.1.12 and SQL*Net Client 2.3.2.1.12 if you 
want to install SQL*Net patch 2.3.2.1.12. Select SQL*Net Server 
2.3.3.0.3 and SQL*Net Client 2.3.3.0.3 if you want to install SQL*Net 
patch 2.3.3.0.3.

7. Click Install.

A window appears showing the progress of the installation. After 
installation is complete, a message appears confirming the installation.

8. Click Exit to exit Oracle Installer.
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File Names
In Net8, executables (.EXE files) and dynamic link libraries (.DLL files) are 
contained in the directory:

ORACLE_HOME\BIN

File names in Net8 typically have an 80 appended to the corresponding name in 
SQL*Net release 2.x. This suffix prevents conflict with SQL*Net release 2.x files.

Service Names
Net8 service names differ from SQL*Net release 2.x service names:

Migrating a Database to a New Oracle Home
When a database is migrated from one Oracle home to another Oracle home, the 
SID of the migrated database is added to the SID_LIST section of the 
LISTENER.ORA file located in the ORACLE_HOME\NET80\ADMIN directory for 
the second Oracle home, but the SID for the first Oracle home still remains in the 
LISTENER.ORA file for the first Oracle home. This entry can cause a conflict in the 
SIDs if you need to bring up both the listeners. You should either:

■ ensure that the listener for the first Oracle home is not brought up

or

■ remove the SID from the SID_LIST section of the LISTENER.ORA in the first 
Oracle home.

Net8 Component SQL*Net V2 Name  Net8 Name

Listener OracleTNSListener OracleHOME_NAMETNSListener80

Oracle Names OracleNamesService OracleHOME_NAMENamesService80

Oracle Connection 
Manager

n/a OracleHOME_
NAMECMAdminService80

OracleHOME_NAMECMANService80

Client Cache n/a OracleHOME_NAMEClientCache80

SNMP n/a OracleSNMPPeerMasterAgent

SNMP n/a OracleSNMPPeerEncapsulator
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Coexistence Issues
SQL*Net release 2.x can coexist with Net8 on the same computer in the same Oracle 
home directory.

Installation
If you are not migrating, and you are installing Net8 onto the same computer where 
SQL*Net release 2.x exists, Oracle Installer automatically performs these tasks to 
enable coexistence:

1. Configuration files are copied from ORACLE_HOME\NETWORK\ADMIN 
and saved into ORACLE_HOME\NET80\ADMIN.

2. The Net8 network listener is setup as Manual startup. The network listener is 
not started.

3. Entries are added to the TNSNAMES.ORA and LISTENER.ORA file for external 
procedures, if the entries are not already present.

Listener
To use the version 8 network listener, you may need to change your network 
configuration on either the SQL*Net release 2.x or Net8 configurations to prevent 
conflict. For example, you may need to change:

■ Port number on a TCP/IP network

■ Service name on an SPX network

■ Pipe name on a Named Pipes network

■ KEY for IPC connection

You may also need to start the Net8 network listener, and change the status to 
Automatic startup, depending upon your network needs. If you make changes to 
the network listener, you must make changes to client configuration files to ensure 
that clients can connect to the network listener.

One Listener Supporting Multiple Oracle Homes
You can use one listener for spawning databases for multiple Oracle homes. You 
only need to add all the System Identifiers (SIDs) to the SID_LIST section in the 
ORACLE_HOME\NET80\ADMIN\LISTENER.ORA file. Since the SID is unique on 
a system across different Oracle homes, the listener can spawn the database thread 
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for a specific SID in the correct Oracle home, and the ORACLE_HOME parameter 
(used in UNIX environments only) is not needed in the LISTENER.ORA.

You can use release 8.0.6 listeners to spawn release 8.0.6 or 7.3.x databases. In a 
mixed environment, however, you cannot enable the use of shared sockets. Oracle 
Corporation recommends using different listeners for release 8.0.4, 8.0.5 and 8.0.6 
databases.

There are some restrictions in using release 8.0.6 listeners to spawn release 8.0.4, 
8.0.5 and 8.0.6 databases. These restrictions include:

■ Since release 8.0.4 only supports process mode external procedures, you should 
enable process mode external procedures for release 8.0.5 and 8.0.6. Releases 
8.0.5 and 8.0.6 support both process and thread external procedures.

■ You must install the 8.0.4.0.3 (or later) patch for Net8.

■ You cannot enable the use of shared sockets.
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Configuration Files
SQL*Net release 2.x will use configuration files from ORACLE_
HOME\NETWORK\ADMIN, while Net8 will use files from ORACLE_
HOME\NET80\ADMIN by default. If you want both SQL*Net and Net8 to use 
configuration files from the same directory, set the registry variable TNS_ADMIN.

Additional Information: See Appendix B, "Modifying and Adding 
Configuration Parameters", for more information on setting TNS_
ADMIN.
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Using Net8 with Multiple Oracle Homes

This chapter describes how you work with multiple Oracle homes and Net8.

Specific topics discussed are:

■ Multiple Oracle Homes Overview

■ Control Utilities with Multiple Oracle Homes

■ Service Names

■ Network Listener

■ Configuration File Port Numbers

■ Oracle Names Server

■ Oracle Connection Manager
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Multiple Oracle Homes Overview
Multiple Oracle Homes Overview
Previous releases of Oracle for Windows NT and Windows 95 supported only single 
Oracle homes, allowing you to install and run only one SQL*Net or Net8 version in 
a single Oracle home directory. For example, you could not install SQL*Net release 
2.3.2 and SQL*Net release 2.3.3 or multiple installations of Net8 release 8.0.3 on the 
same computer.

Releases 8.0.4, 8.0.5, and 8.0.6 supports multiple Oracle homes, a feature that allows 
you to install one or more Net8 releases on the same computer (in multiple Oracle 
home directories). For example, using multiple Oracle homes, you can install 
release 8.0.4 products and 8.0.6 products in different Oracle homes on the same 
computer.

Control Utilities with Multiple Oracle Homes
The Oracle home in which you installed products most recently is the first directory 
listed in your PATH (primary home). As such, it has priority over the other Oracle 
home entries in your PATH. If you invoke a control utility, the version of the 
product invoked will be that stored in the Oracle home listed first in your path.

You can specify a different version of a control utility by:

■ Specifying the Absolute Path

■ Changing the Value of PATH

Specifying the Absolute Path
Oracle Corporation recommends going to the absolute path to the version of the 
LSNRCTL80, NAMESCTL80, CMCTL80 control utility (ORACLE_HOME\BIN) you 
want to use prior to starting it. 

Changing the Value of PATH
You can change the value of PATH so that the first entry points to the binary files for 
the product version you want to use by resetting PATH from the:

■ Oracle Home Selector

■ System Level

■ Command Line
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Control Utilities with Multiple Oracle Homes
Oracle Home Selector
Oracle Home Selector is a graphical user interface (GUI) that enables you to edit 
your environment path to make an appropriate Oracle home directory your 
primary home. This tool can only be used when you have multiple, active Oracle 
home directories on a single computer. 

1. Choose Start > Programs > Oracle for Windows NT - HOME_NAME > Oracle 
Home Selector.

The Oracle Home Selector window appears.

2. Enter the Oracle home in the drop-down list that you want to be the primary 
Oracle home.

System Level
The new value you assign to PATH exists until you change the value of PATH again.

To change the value of PATH at the system level:

1. Choose Start > Settings > Control Panel.

The Control Panel window appears.

2. Double-click on the System icon.

The System Properties window appears.

3. Click on the Environment tab.

The System Variables appear.

4. Edit the value of the PATH in the Systems Variables window and click OK to 
exit when you are satisfied with the changes you have made.

Command Line
The value of PATH reverts to its previous value when you quit the session.

To change the value of PATH at the command line:

At the command prompt enter:

SETPATH=pathname;%PATH%
where pathname is the full path to the binary files for the products you want to use.
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Service Names
Multiple Oracle homes affect the naming conventions for Oracle services. If you 
have only one Oracle home directory on a computer, there are no differences 
between the conventions for naming service names in this release and previous 
releases (that is, no Oracle HOME_NAME is required and the SID is typically the 
default of ORCL.) However, as you perform subsequent installations into different 
Oracle home directories you must specify a different Oracle HOME_NAME for each 
Oracle home directory during installation, which is added to some service names.
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Network Listener
To use the version 8 network listener, you may need to change your network 
configuration in one of your multiple Oracle homes to prevent conflict. For 
example, you may need to change:

■ port number on a TCP/IP network

■ service name on an SPX network

■ pipe name on a Named Pipes network

■ KEY for IPC connection

Listener Startup Mode
If any other network listener (for a different Oracle home or Oracle7 network 
listener) is already started or set up in Automatic Startup mode, the new network 
listener is installed with Manual Startup mode, and is not started for you. You must 
start the network listener manually after proper configuration to resolve any 
possible conflict.

Configuration File Port Numbers
When the network listener, Oracle Names, and Oracle Connection Manager are 
installed into another Oracle home, the configuration files installed specify the 
default port numbers. These port numbers may be in conflict with the configuration 
file of another Oracle home. Ensure each Oracle home contains configuration files 
(located in ORACLE_HOME\NET80\ADMIN) with unique port number.

Additional Information: See Appendix E, "Net8 Services and Port 
Numbers", for default port number assignments.
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Oracle Names Server
If you are using multiple Oracle homes on an Oracle Names Server, Oracle 
Corporation recommends using the more recent version in order to take advantage 
of new functionality.

Oracle Connection Manager
If you are using multiple Oracle homes on a computer with Oracle Connection 
Manager, Oracle Corporation recommends using the more recent version in order to 
take advantage of new functionality.
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Configuring the Network

This chapter describes how to configure your network.

Specific topics discussed are:

■ Configuration Overview

■ Using the Host Naming Method

■ Using the Local Naming Method

■ Using the Oracle Names Method

■ Configuring Oracle Connection Manager

■ Testing the Configuration on the Server

■ Testing the Configuration on the Client
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Configuration Overview
Before a database server can receive connections from clients, clients must be 
configured with service names (easy to remember aliases for database addresses) 
that match the address preconfigured in each server computer’s LISTENER.ORA 
file. These addresses are used by the client to connect to the network listener during 
a connection. During a connection, a client passes the system ID (SID) of the server 
to which it wants to connect.

The LISTENER.ORA file identifies and controls the behavior of the network 
listeners that listen for the databases on the computer. This file includes network 
listener descriptors and addresses of all network listeners on a computer, the SIDs 
of the databases they listen for, and various control parameters. 

Client configuration is accomplished by creating a list of the service names and 
addresses of network database destinations through a TNSNAMES.ORA client 
configuration file or an Oracle Names Server. A client (or a server that is part of a 
distributed database) needs this information to know where to make connections.

Configuration is based upon one of two models:

Network Configuration 
Model Suitable When... Naming Method Configuration Tool

Localized management Network addresses are mapped in 
a TNSNAMES.ORA file on each 
node (no Oracle Names Server).

Host naming

Local naming

External naming

Net8 Easy Configuration 
Tool

Centralized 
management

Networks where an Oracle Names 
Server performs network address 
resolution. An Oracle Names 
Server stores client configuration 
profiles in one location.

Oracle Names Oracle Net8 Assistant
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Naming Methods
Service names can be created using the following configuration methods:

Configuration Files
Depending on the naming method you use, the following configuration files may be 
created or updated in ORACLE_HOME\NET80\ADMIN:

Naming Method Description

Host Naming Resolves service names through a TCP/IP network’s Domain Name System (DNS) 
or in the /ETC/HOSTS file. This method is recommended for simple TCP/IP 
environments.

See "Using the Host Naming Method" on page 6-4.

Local Naming (no 
Oracle Names Server)

Resolves service names to network addresses by using information configured and 
stored on each individual client. Local Naming is most appropriate for simple 
distributed networks with a small number of services that change infrequently. 

See "Using the Local Naming Method" on page 6-6.

Oracle Names Stores names and addresses of all database services on a network on an Oracle 
Names Server. Connection requests are routed through an Oracle Names Server, 
which resolves the service name to a network address. The information is then 
returned to the client.

See "Using the Oracle Names Method" on page 6-11.

External Naming External naming refers to service name resolution by using a supported third-party 
naming service. 

See "Using the External Naming Method" on page 8-2.

Configuration File Description

LISTENER.ORA Includes addresses of all network listeners on a server, the 
SIDs of the databases for which they listen, and various 
control parameters used by the network listener. This file 
resides on the server.

TNSNAMES.ORA Includes a list of service names of databases. This file resides 
on clients.

SQLNET.ORA Includes the names resolution method. This file resides on 
clients.

SDNS.ORA Includes lists of Oracle Names Servers. This file resides on 
clients.



Using the Host Naming Method
Using the Host Naming Method
The host naming method is enabled by default during Typical installation for 
TCP/IP network environments only. The LISTENER.ORA has a line which specifies 
the TCP/IP host name of your server. Clients that use this host name in their 
connect string can connect.

Your client computer may connect to a database using the host name of the 
computer on which the database resides if: 

■ you are connecting to an Oracle8 database with Net8 Server/Client software 
installed 

■ your client and server are connecting over a TCP/IP protocol

■ all names are resolved through an IP address translation mechanism such as 
DNS, or a centrally maintained TCP/IP hosts file

■ no advanced features like Oracle Connection Manager are requested or required 

Additional Information: See Appendix C, "Configuration Files" for 
more information about these files.
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Server Configuration
Ensure GLOBAL_DBNAME = HOSTNAME as specified in the ORACLE_
HOME\NET80\ADMIN\LISTENER.ORA configuration file, where HOSTNAME is 
the TCP/IP host name or alias of the server system. 

During the installation of Net8, the GLOBAL_DBNAME of the default database is 
set to the system name. 

To verify GLOBAL_DBNAME is correctly specified, manually check the 
LISTENER.ORA file of use the Oracle Net8 Assistant:

Client Configuration
No client configuration is necessary for using the Host Naming Adapter. The 
connection is established by using the default TCP/IP port for the network listener. 

Multiple Databases On a Server
If you have multiple databases on a server, you can set TCP/IP aliases for the server 
system, and assign a separate GLOBAL_DBNAME parameter for each different 
databases in the LISTENER.ORA file. 

The client will then connect to the specific database based on the host name used for 
connection.

Check the LISTENER.ORA file... Use the Oracle Net8 Assistant...

Ensure the line shown in bold exists:

SID_LIST_LISTENER_NAME=
   (SID_LIST =
      (SID_DESC =
         (SID_NAME = SID)
         (GLOBAL_DBNAME = HOSTNAME)
      )
   )

1. Choose Start > Programs > Oracle for 
Windows NT - HOME_NAME > Oracle 
Net8 Assistant.

The Oracle Net8 Assistant starts.

2. Double-click the Listeners folder.

3. Select the appropriate network listener 
from the Listeners folder.

The network listener details appear on the 
right side of the screen:

4. Select Database Services from the 
drop-down list.

5. Ensure the TCP/IP host name is correctly 
specified in the Global Database Field.

6. Choose Save Network Configuration 
from the File menu.

7. Choose Exit from the File menu to exit the 
Oracle Net8 Assistant application.
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Using the Local Naming Method
With the local naming method, service names are added to the TNSNAMES.ORA 
files. Service names are mapped to database address. Clients use this service name 
in their connect string to connect.

Server Configuration
To configure using the local naming method:

1. Choose Start > Programs > Oracle for Windows NT - HOME_NAME > Net8 
Easy Configuration Tool.

The Oracle Net8 Easy Config wizard starts:

2. Enter a new service name (up to 64 characters) in the New Service Name field 
to create a new service name, and click Next. The service name can be any name 
you choose.

Note: Net8 Easy Configuration Tool only supports configurations 
using TCP/IP, SPX, Named Pipes, and Bequeath Protocol Adapters. 
To configure a service name using the LU6.2 Protocol Adapter, you 
must manually edit the configuration files.
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The next page appears:

3. Select the network protocol you want to use (this protocol adapter must also be 
installed on the clients), and click Next.
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The page appropriate for your protocol adapter appears; in the example here, 
TCP/IP is assumed:

4. Enter the appropriate information for your chosen protocol in the fields, and 
click Next.
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The next page appears:

5. Enter the name of the SID of the database to which you want to connect in the 
Database SID field, and click Next. The default SID is ORCL.

The following page appears:

6. Click Next (testing is performed later in this chapter).
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7. Click Finish to save your configuration and quit the Net8 Easy Configuration 
Tool.

Oracle Net8 Easy Config adds the new service names to the TNSNAMES.ORA 
in ORACLE_HOME\NET80\ADMIN.

8. If you have more than one supported Oracle Protocol Adapter in your 
ORACLE_HOME directory, use Net8 Easy Configuration Tool to configure other 
services following the same steps.

Client Configuration
After the server is configured, it is best to simply copy over the TNSNAMES.ORA 
configuration file located at ORACLE_HOME\NET80\ADMIN on the server to the 
same location on the clients. This will ensure the files are consistent. Otherwise, you 
must use the Oracle Net8 Easy Config tool on every client, introducing possible 
errors.
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Oracle Names simplifies the setup and administration of global, client/server 
computing networks. Oracle Names makes network address and database link 
information available to all nodes throughout the network. Each database server’s 
network address is identified with a simple service name. Client applications then 
can request a database connection with that name rather than a lengthy address. 

Oracle Names is made up of Names Servers that store a service's name and network 
address. Services include databases, database link definitions, and object aliases. 
Client applications request a connection using a simple name, rather than the 
lengthy address, and the name is resolved to the address by a Names Server. Oracle 
Names shields users and applications from changes made to the network 
infrastructure. It provides for centralized administration of network service names. 

The diagram below shows that:

1. Oracle services can dynamically register themselves with Oracle Names 
Servers.

2. Clients seeking to locate a service on an Oracle network contact their closest 
Oracle Names Server to retrieve the network address.

3. Clients then transparently connect to the service.

 

Database

Net8 Network

Clients

Oracle Names Server

3

2
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Oracle Names Features
The automatic discovery feature of Oracle Names version 8 enables network 
connectivity with virtually no configuration files. 

Oracle Names version 8 includes three features to improve network performance 
and ease of administration: 

■ Dynamic Service Registration

■ Client Discovery of Names Servers

■ Client Caching of Oracle Names Servers

Feature Description

Dynamic Service 
Registration

With dynamic service registration, a Net8 network listener automatically locates a 
Names Server through the mechanism of a well-known address and registers its 
services with Oracle Names. A single database network listener can service 
connection requests for several database instances. At startup, the network listener 
forwards connect descriptors and global names for each of these services. When the 
service or network listener is shut down, the network listener automatically 
deregisters its services with Oracle Names. 

The network listener registers with the Oracle Names Servers by looking for a 
Names Server with a well-known address. The well-known Names Server address 
on a TCP/IP network is a host aliased to oranamesrvr0, 
oranamesrvr1,...oranamesrvr4, using port 1575. 

Once the service is registered, its address is made available to all other Names 
Servers in the region. The address information is shared in one of two ways: 

■ Service Replication — In service replication, service information is stored in a 
Names Server's cache and is instantly replicated to the caches of all other 
Names Servers. 

■ Oracle Names database — If an Oracle database is used as the registration 
repository, the registration information is stored in the database, and from there 
is accessible to all the Names Servers. 
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Client Discovery of 
Names Servers

The discovery process involves running an REORDER_NS command from the 
NAMESCTL80 utility or choosing Discover Oracle Names Server (from the Tools 
menu) in the Net8 Assistant. This produces a SDNS.ORA file in the ORACLE_
HOME\NET80\NAMES directory. This file contains a list of the Oracle Names 
Servers the client can connect.

The discovery process allows the client to: 

■ retrieve a list of all of the existing Names Server addresses with minimal 
network configuration at installation 

■ find out about new Names Servers as they appear in the network. 

This allows for dynamic changes in the network topology with minimal 
involvement on the user’s part and with little or no impact on the performance of a 
normal query. 

Clients discover Names Servers in much the same way that services find them for 
registration: 

1. A client first looks in its own SDNS.ORA client cache file. If it has contacted a 
Names Server within the past 24 hours, the address of a Names Server may be 
in the cache. 

2. A client looks for a Names Server with a well-known address. The well-known 
Names Server address on a TCP/IP network is a host aliased to oranamesrvr0, 
oranamesrvr1,...oranamesrvr4, using port 1575. 

Once a Names Server is found, the addresses of all the other version 8 Names 
Servers in the region are made available to the client. 

Client Caching of Oracle 
Names Servers

After the clients have discovered Oracle Names Servers, the SDNS.ORA client cache 
file can simply be updated with new Oracle Names Server information by starting 
the OracleHOME_NAMEClientCach80 service on the client(s). 

OracleHOME_NAMEClientCache80 contacts each of the Names Servers in turn, and 
orders the list on the basis of the speed of each Names Server’s response. 
Subsequently, when a client makes a query to a Names Server, the Names Server at 
the top of the list in the SDNS.ORA file is contacted first. 

The local client-side cache is particularly advantageous if at some time no Names 
Server is available. In this case, the local client-side cache has the current list of 
recently accessed services. 

All the information in the client cache has a time to live (TTL). At the end of that 
TTL, the information is flushed from the cache. The purpose of this feature is to 
avoid having stale information in the client cache. The default TTL is 86,400 seconds 
(24 hours). It cannot be changed.

Feature Description
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Differences Between Versions of Oracle Names 
There are significant differences between this version of Oracle Names and earlier 
versions:

■ In Oracle Names version 1, administrators configured Names Servers using 
Oracle Network Manager and stored all topology data in a database. All the 
Names Servers in a region shared the same information because they accessed 
the same database. 

■ In Oracle Names version 2, the administrator could choose between continuing 
Names Server configuration as in version 1, or using the Dynamic Discovery 
Option. The Dynamic Discovery Option was recommended only for a network 
with a flat namespace (that is, only one domain). If the Dynamic Discovery 
Option was chosen, no database was needed; each Names Server automatically 
replicated its data to all other well-known Names Servers in the region. 
Network listeners could register themselves with well-known Names Servers 
and clients could find them without configuration. Otherwise, Oracle Names 
could be used just as the earlier version had been. 

■ Oracle Names version 8 takes the features of the Dynamic Discovery Option 
and expands on them significantly. Included among the differences are the 
following: 

– A service can register itself with any Names Server it can find, and its name 
and address are made available to all Names Servers in the region. 
Similarly, if an administrator manually registers a service to any Names 
Server, that service information is available to all other Names Servers. 

– A client-side process times the connections from the client to all Names 
Servers in the region, and maintains an ordered list so that the client queries 
the Names Server that has the shortest response time first. Clients using 
SQL*Net release 2.3. are able to take advantage of this feature. 

– On most platforms, the client maintains a client-side cache that includes the 
results of the client’s queries to the Names Servers. This feature improves 
performance as it reduces the number of client-Names Server queries. 

– Oracle Names version 8 does not require a database to hold topology 
information. However, an administrator may choose to use one, and it is 
recommended. 
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Setting Up and Oracle Names Server
The steps to set up an Oracle Names Server include:

Step 1: Install

Step 2: Configure the Server

Step 3: Define a Well-Known Oracle Names Server

Step 4: Create a Well-Known Oracle Names Server

Step 5: Configure Clients and Servers To Use Oracle Names Server

Step 1: Install
Ensure the following are installed:

■ Oracle Names Server on its own computer that is designated as the Oracle8 
Server

■ Net8 Client on the clients

■ Net8 Server on the server

■ TCP/IP, or Named Pipes or SPX on all clients

Note: Oracle Names Server only supports TCP/IP, Named Pipes 
and SPX Protocol Adapters.

Additional Information: See "Verifying Installation and Setup" on 
page 3-4 to verify installation and the CD-ROM insert for more 
information about the Oracle Installer and its options.
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Step 2: Configure the Server
On the server, the network listener must be configured to identify a database 
listener on that server for an Oracle Names Server. 

To configure the network listener:

1. From the Control Panel window, double-click Services.

The Services window appears.

2. Check the status of the network listener OracleHOME_NAMETNSListener. If 
the network listener is stopped (the status column is blank), go to the Step 3. If 
the status is Started, stop the network listener:

To stop the network listener:

a. From the Control Panel’s Services window, select OracleHOME_
NAMETNSListener80 (the service name if you are using the default network 
listener name LISTENER) or OracleHOME_NAMETNSListener80LSNR (where 
LSNR is the non-default network listener name), and click Stop. 

The Services confirmation dialog box appears, prompting you if it is OK to 
stop the service.

b. Click Yes.

The network listener is stopped. The status column is blank.

3. Click Close to quit the Services window.

4. Set the global database name and register services with the Oracle Names 
Server using the Oracle Net8 Assistant or editing the ORACLE_
HOME\NET80\ADMIN\LISTENER.ORA file. 

The global database name specifies the name by which the network listener 
registers the database instance with an Oracle Names Server and the name by 
which the Oracle Names Server identifies a database. You can use any alias, but 
Oracle Corporation recommends setting the global database name to the value 
of the INITSID.ORA’s DB_NAME and DB_DOMAIN parameters. The default 
global database name is ORACLE.WORLD. 

When clients request the connect information for a database from an Oracle 
Names Server, this is the alias they use. The domain must also be added to the 
end of this name. 

Registering services with the Oracle Names Server instructs the network 
listener to find and register with a well-known Oracle Names Server. When the 
network listener starts, it looks for hosts with the well-known host names, tries 
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to gather connection information from the Oracle Names Server, and registers 
its SID(s) with it.

Use the Net8 Assistant... Modify the LISTENER.ORA file...

1. Choose Start > Programs > Oracle for 
Windows NT - HOME_NAME > Oracle 
Net8 Assistant.

The Oracle Net8 Assistant starts.

2. Double-click the Listeners folder.

3. Select the appropriate network listener 
from the Listeners folder.

The network listener details appear on 
the right side of the page:

4. Select Database Services from the 
drop-down list.

5. Modify the Global Database Field with 
the an alias. Preferably, use the values 
of DB_NAME and DB_DOMAIN from 
the INITSID.ORA as the alias.

6. Select General Parameters from the 
drop-down list.

7. Select Register Services with Oracle 
Names.

8. Choose Save Network Configuration 
from the File menu.

9. Choose Exit from the File menu to exit 
the Oracle Net8 Assistant. 

Ensure GLOBAL_DBNAME is set to an alias. Preferably, 
use the values of DB_NAME and DB_DOMAIN from 
the INITSID.ORA as the alias. For example:

SID_LIST_LISTENER_NAME=
   (SID_LIST =
      (SID_DESC =
         (SID_NAME = SID)
         (GLOBAL_DBNAME = GLOBAL_DBNAME.DOMAIN)
      )
   )
USE_PLUG_AND_PLAY_listener = ON
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Step 3: Define a Well-Known Oracle Names Server
To define a well-known Oracle Names Server:

For all clients and servers, ensure your network administrator has named the Oracle 
Names Servers as a well-known names server, allowing clients to access the Oracle 
Names Servers using the well-known name. 

Well-known names are dependent on the protocol adapter:

This implies you can have as few as one well-known Oracle Names Server (whose 
alias would be oranamesrvr0) and as many as five (with aliases oranamesrvr0 to 
oranamesrvr4).

The numbers 0 to 4 indicate the order in which the client tries to contact the Oracle 
Names Servers, if more than one exists in the network.

For example, for TCP/IP, Oracle Names Servers are made well-known by adding 
aliases oranamesrvr(0-4) to the Domain Name Service (DNS) or in the 
SYSTEMROOT\SYSTEM32\DRIVERS\ETC\HOSTS file.

The HOSTS file may include the following entries:

144.25.219.146 host0  oranamesrvr0
144.25.219.147 host1  oranamesrvr1
144.25.219.148 host1  oranamesrvr2

The well-known host names 
for TCP connections 

The well-known computer 
Names for Named Pipes 
connections1

1 Well-known Names Server names for Names Pipes must be in all uppercase letters.

The well-known service 
name for an SPX 
connection

oranamesrvr0
oranamesrvr1
oranamesrvr2
oranamesrvr3
oranamesrvr4

ORANAMESRVR0
ORANAMESRVR1
ORANAMESRVR2
ORANAMESRVR3
ORANAMESRVR4

oranamesrvr
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Step 4: Create a Well-Known Oracle Names Server
You may use the Oracle Names Control Utility (NAMESCTL80), or the Oracle Net8 
Assistant to create a well-known Oracle Names Server on the computer where 
Oracle Names Server is installed.

Prior to creating a well-known Oracle Names Server, you must decide whether:

■ You need support for one or more administrative regions. An administrative 
region consists of a collection of Oracle Names Servers in one or more domains. 

■ You need service registration data replicated continuously among Oracle 
Names Servers, or want Oracle Names Server to store their registration data in 
an Oracle database.

See Chapter 6, “Oracle Names,” of the Oracle Net8 Administrator’s Guide to help with 
these decisions.

Oracle Corporation recommends you create at two least Oracle Names Servers, one 
to act as the Oracle Names Server and one to act as a backup Oracle Names Server. 
Each of these should reside on its own computer.

To create a well-known Oracle Names Server, use the Oracle Net8 Assistant or the 
NAMESCTL control utility:

Note: Keep the following considerations in mind when 
configuring Oracle Names Servers with the Oracle Net8 Assistant:

■ Removal of Oracle Names Servers is not supported. You must 
manually delete Oracle Names Server entries in the ORACLE_
HOME\NET80\ADMIN\NAMES.ORA and ORACLE_
HOME\NET80\NAMES\CKP*.ORA files.

■ Creation of Oracle Names Servers on Windows 95 is not 
supported, but the functionality is not disabled from the Oracle 
Net8 Assistant. The Oracle Net8 Assistant allows you to create 
Oracle Names Servers, but you cannot start, stop, or configure 
them.
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Use the Net8 Assistant... Use the control utility NAMESCTL80...

1. If you want to create a region database, follow 
Steps 1-2 in Section 6.7, “Creating a Database 
to Store Names Server Information”, of the 
Oracle Net8 Administrator’s Guide.

2. On the computer where Oracle Names 
software resides, choose Start > Programs > 
Oracle for Windows NT - HOME_NAME > 
Oracle Net8 Assistant.

The Oracle Net8 Assistant starts.

3. Select the Oracle Names Servers folder. 

A message appears, saying the Oracle Net8 
Assistant does know of any Oracle Names 
Servers in the network.

4. Click OK to acknowledge message.

5. Choose Create from the Edit menu, or click on 
the “+” button to create a new Names Server. 

The Names Wizard starts.

6. The wizard guides you through the creation 
and configuration process.

■ a unique Oracle Name Server name

■ an address for the Oracle Names Server

■ a choice to store information in a database or 
replicate information among Oracle Names 
Server

If you choose to store information in a 
database, you are prompted for the listener 
address, and database SID, user name and 
password.

■ to identify if this Oracle Names Server is in the 
root region

7. Choose Exit from the File menu to exit the 
Oracle Net8 Assistant application.

8. Repeat Steps 2-7 to create additional Oracle 
Names Servers on different computers within 
a region or another region. The Oracle Net8 
Assistant does not support creation of 
multiple Oracle Names Servers on one 
computer. 

1. If you want to create a region database, 
follow Steps 1-2 in Section 6,7, “Creating a 
Database to Store Names Server 
Information”, of the Oracle Net8 
Administrator’s Guide.

2. Start the Oracle Names Server on each 
computer where Oracle Names software 
resides:

From the MS-DOS command prompt, 
enter:

C:\> NAMESCTL80

NAMESCTL> START

Or, from the Control Panel’s Services 
window, select OracleHOME_
NAMENamesService80, and click Start.

3. Create a SDNS.ORA file in ORACLE_
HOME\NET80\NAMES.

This file contains the names of the Oracle 
Names Server(s) in a particular region. The 
computer reads this file to find the 
addresses of other Oracle Names Servers.

From the command line, enter:

NAMESCTL> REORDER_NS
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Step 5: Configure Clients and Servers To Use Oracle Names Server
To configure the client and server computers to recognize Oracle Names Servers, 
use the Oracle Net8 Assistant or the NAMESCTL control utility:

Use the Net8 Assistant... Use the control utility NAMESCTL80...

Note: Discovery of Oracle Names Servers may 
take several minutes.

1. Choose Start > Programs > Oracle for 
Windows NT/Windows 95/98 - HOME_
NAME > Oracle Net8 Assistant.

The Oracle Net8 Assistant starts.

2. Select the Oracle Names Servers folder. 

A message appears, saying the Oracle 
Net8 Assistant does know of any Oracle 
Names Servers in the network.

3. Choose Discover Oracle Names Servers 
from the Tools menu. 

This produces an SDNS.ORA file in 
ORACLE_HOME\NET80\NAMES. This 
file contains the names of the Oracle 
Names Server(s). This file is read to find 
the addresses of Oracle Names Servers.

The following message appears:

“Discovered Oracle Names Server in the 
region. Please exit the tool and start again.” 

4. Choose Exit from the File menu to exit the 
Oracle Net8 Assistant application.

From the command line, enter:

C:\> NAMESCTL80

NAMESCTL> REORDER_NS

This produces an SDNS.ORA file in 
ORACLE_HOME\NET80\NAMES. This 
file contains the names of the Oracle 
Names Server(s). This file is read to find 
the addresses of Oracle Names Servers.
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5. Ensure Oracle Names is the first method Net8 will use to reconcile service 
names by using the Oracle Net8 Assistant or editing the ORACLE_
HOME\NET80\ADMIN\SQLNET.ORA file:

Use the Net8 Assistant... Modify the SQLNET.ORA file...

1. Choose Start > Programs > Oracle for 
Windows NT/Windows 95/98 - HOME_
NAME > Oracle Net8 Assistant.

The Oracle Net8 Assistant starts.

2. Click the Profiles icon.

The profile details appear on the right 
side of the page:

3. Select Naming from the drop-down list.

4. Click the Methods tab.

5. Choose ONAMES from the Available 
Methods list, and click <.

6. Select the ONAMES in the Selected 
Methods list, and click the Promote 
button to move the selection to the top of 
the list.

7. Choose Save Network Configuration 
from the File menu.

8. Choose Exit from the File menu to exit the 
Oracle Net8 Assistant application.

Oracle Names Server configuration is 
complete.

Add the NAMES.DIRECTORY_PATH parameter, so 
it includes ONAMES:

NAMES.DIRECTORY_PATH = (ONAMES, 
TNSNAMES)

The order is important. Net8 tries to use the first 
method. If the first method fails to resolve the service 
name, Net8 tries to use the next method.

Oracle Names configuration is complete.
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Configuring Oracle Connection Manager
The Oracle Connection Manager provides three capabilities for Oracle8:

■ Connection Concentration

Allows you to multiplex multiple logical client sessions through a single 
transport connection to an Oracle server destination. This permits large 
numbers of users to access a single database which is running in multi-threaded 
server (MTS) mode, and thus increases the server’s scalability. This feature is 
available only in a TCP/IP network.

Concentration reduces the demand on resources needed to maintain multiple 
connections between two processes by enabling the server to use fewer 
connection end points for incoming requests. This enables you to increase the 
total number of sessions that a server can handle. By using multiple Connection 
Managers, it is possible for thousands of concurrent users to connect to a server.

■ Network Access Control

Provides a proxy for denying or allowing access to a database server. This 
feature, implemented only over the TCP/IP protocol, provides network filtering 
similar to that offered with a firewall. 

■ Multi-Protocol Support

Replaces the Multi-Protocol Interchange. Allows client and database servers 
operating on different protocol stacks to communicate with each other.

The clients require a TNSNAMES.ORA file or Oracle Names Server, the Oracle 
Connection Manager requires a CMAN.ORA, and the server requires multiplexing 
parameters set in the INITSID.ORA.
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Conditions for Using Oracle Connection Manager
■ TCP/IP must be installed and configured for local connectivity, because the 

Oracle Connection Manager Administration service (OracleHOME_
NAMECMAdminService80) uses TCP/IP for communication with Oracle 
Connection Manager.

■ The parameter AUTOMATIC_IPC=OFF must be set up in the SQLNET.ORA 
configuration file in order for a client to use Oracle Connection Manager.

■ When Connection Manager is used in an Oracle Names environment, it 
automatically attaches itself to every listener address registered for an Oracle 
Names Server. If the listener address list contains greater than or equal to five 
addresses, then you may not be able to connect to that particular listener 
through the Connection Manager. In that case you need to reduce the listener 
address list.

Setting Up an Oracle Connection Manager
The steps to set up an Oracle Connection Manager include:

Step 1: Install

Step 2: Configure Clients

Step 3: Configure Oracle Connection Manager

Step 4: Configure the Server

Step 1: Install
Ensure the following are installed:

■ Oracle Connection Manager on its own computer

■ Net8 Client on the clients

■ Net8 Server on the server

Additional Information: See "Verifying Installation and Setup" on 
page 3-4 to verify installation and the CD-ROM insert for more 
information about the Oracle Installer and its options.
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Step 2: Configure Clients 
To configure the client:

Set the Oracle Connection Manager address through a TNSNAMES.ORA file or 
Oracle Names Server. 

If using Oracle Names Server, the Oracle Connection Manager automatically 
updates the addresses in the Names Server, inserting the address for the CMAN 
into the existing address. 

If you are using the local naming method, modify the ORACLE_
HOME\NET80\ADMIN\TNSNAMES.ORA file located in ORACLE_
HOME\NET80\ADMIN.

To modify the TNSNAMES.ORA file:

1. Choose Start > Programs > Oracle for Windows NT/Windows 95/98 - HOME_
NAME > Oracle Net8 Assistant.

The Oracle Net8 Assistant appears.

2. Select the Service Names folder.
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The list of current service names appears:

3. Select CMEXAMPLE.WORLD:

4. Modify the Address 1 tab with the address information for the Oracle 
Connection Manager.

5. Click Advanced.

The Advanced Options dialog box appears:
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6. Ensure Source Route is checked, and click OK. 

This option creates a source route of addresses through all Oracle Connection 
Managers to the destination address.

7. Select the Address 2 tab and modify it with the address information for the 
server. The second address is used by the Oracle Connection Manager to 
connect to the server. 

8. You can have multiple CMAN addresses in the ADDRESS_LIST if necessary. 
The Oracle Connection Managers basically act as routers, pointing the 
connection request to the next hop. 

9. Choose Save Network Configuration from the File menu.

10. Choose Exit from the File menu to exit the Oracle Net8 Assistant.
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Below is a comparison of a regular TNSNAMES.ORA file and a TNSNAMES.ORA 
file with an entry to use the Oracle Connection Manager (Connection Manager 
entries are shown in boldface text):

INVENTORYDB.WORLD= 
   (DESCRIPTION= 
        (ADDRESS= 
              (PROTOCOL=TCP) 
              (HOST=INVENTORY) 
              (PORT=1521) 
        ) 
       (CONNECT_DATA= 
              (SID=ORCL) 
       ) 
    )

INVENTORYDB.WORLD= 
   (DESCRIPTION= 
       (ADDRESS_LIST= 
           (ADDRESS= <---CMAN address
               (PROTOCOL=TCP) 
               (HOST=CMAN) 
               (PORT=1610) <---must match  port in CMAN.ORA file
           ) 
          (ADDRESS= 
               (PROTOCOL=TCP) 
               (HOST=INVENTORY) 
               (PORT=1521) 
          ) 
        ) 
       (CONNECT_DATA= 
              (SID=ORCL) 
       ) 
      (SOURCE_ROUTE=YES) 
    ) 
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Enabling Multi-Protocol Support
Below is a TNSNAMES.ORA entry set up to use the Oracle Connection Manager 
with multiple protocols: 

INVENTORYDB.WORLD= 
   (DESCRIPTION= 
       (ADDRESS_LIST= 
           (ADDRESS= 
               (PROTOCOL=SPX) 
               (SERVICE=CMAN) 
          (ADDRESS= 
               (PROTOCOL=TCP) 
               (HOST=INVENTORY) 
               (PORT=1521) 
          ) 
        ) 
       (CONNECT_DATA= 
              (SID=ORCL) 
       ) 
      (SOURCE_ROUTE=YES) 
    ) 

In this example, the client will use SPX to connect to the CMAN, then the CMAN 
will use TCP/IP to connect to the server. This is the same functionality that was 
provided with the Oracle Multi-Protocol Interchange (MPI) of Oracle7. 

Step 3: Configure Oracle Connection Manager
Configuration of the Oracle Connection Manager may require the modification of 
the CMAN.ORA file located in ORACLE_HOME\NET80\ADMIN if you are using 
protocol adapters other than TCP/IP or require additional features.

Non-TCP/IP Protocol Adapters
If you used protocols other than TCP/IP between the client and Oracle Connection 
Manager, you must modify the line beginning : 
CMAN = (ADDRESS_LIST=
to listen to the protocols adapter address the same way you would modify 
LISTENER.ORA file.
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Enabling Connection Concentration
Section 7.3.2, “Enabling Connection Concentration Features,” of the Oracle Net8 
Administrator’s Guide explains how to enable multiplexing.

Enabling Specifying Network Access Control Rules
Section 7.3.3, “Enabling Connection Concentration Features,” of the Oracle Net8 
Administrator’s Guide explains how to enable network access rules.

Enabling Optional Parameters
If you require other optional parameters, you must remove the ‘#’ preceding those 
parameters from the CMAN.ORA file.

Step 4: Configure the Server
To use the multiplexing, configure the server for Multi-Threaded Server (MTS) by 
setting MTS parameters in the ORACLE_HOME\DATABASE\INITSID.ORA for 
each instance. See Appendix B, “Initialization Parameter Files”, in your Getting 
Started guide.

Additional Information: See "Understanding the CMAN.ORA 
File" on page C-29 for a complete description of the CMAN.ORA 
file and its parameters.
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Testing the Configuration on the Server
Once you have configured the network, test the configuration by performing a 
loopback test on the server. 

A loopback test uses Net8 to go from the server back to itself, bypassing the 
Interprocess Communication (IPC). Performing a successful loopback verifies that 
Net8 is functioning on the server side.

The steps to test the configuration are:

Step 1: Start Oracle Names Server

Step 2: Start the Network Listener

Step 3: Start Oracle Connection Manager

Step 4: Perform a Loopback Test
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Step 1: Start Oracle Names Server
If you are using Oracle Names, start an Oracle Names Server on the computer 
where Oracle Names Server is installed and configured with the NAMESCTL80 
control utility or the Control Panel:

Use the control utility NAMESCTL80... Use the Windows NT Control Panel...

1. From the command line, enter:

C:\> NAMESCTL80

NAMESCTL> STATUS

If the STATUS command indicates the 
Oracle Names Server is running, go to 
Step 3. If the Oracle Names Server is not 
running, go to Step 2.

2. Start the Oracle Names Server. Enter:

NAMESCTL> START

3. Exit from the NAMESCTL utility. Enter:

NAMESCTL> EXIT

1. From the Control Panel window, 
double-click Services.

The Services window appears. Look for 
the OracleHOME_
NAMENamesService80 service. A 
blank in the Status column indicates 
that the service is not running. If the 
service is already running, close the 
window and go to the section "Step 2: 
Start the Network Listener" on 
page 6-33.

2. Select the service, and click Start.

The service starts.

3. In the Services window, click Close.
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Step 2: Start the Network Listener
For Net8 to accept connections on the server, a network listener must be started. If 
you have started an Oracle Names Server, the network listener upon startup 
automatically registers the databases specified in the SID_LIST_LISTENER_NAME 
section of the ORACLE_HOME\NET80\ADMIN\LISTENER.ORA file with the 
well-know Oracle Names Servers.
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On the server, start the listener with the LSNRCTL80 control utility or the Control 
Panel:

Use the control utility LSNRCTL80... Use the Windows NT Control Panel...

1. From the command line enter:

C:\> LSNRCTL80

LSNRCTL> STATUS LISTENER_NAME

where LISTENER_NAME is the name of 
the network listener defined in the 
LISTENER.ORA file with the alias 
LISTENER. It is not necessary to identify 
the network listener if you are using the 
default network listener, named 
LISTENER.

If the STATUS command indicates the 
network listener is running, go to Step 2. 
If the network listener is not running, go 
to Step 3.

2. Even if the network listener is running, 
Oracle Corporation advises you to stop 
the network listener, and start it again. 
To stop the network listener, enter:

LSNRCTL> SET PASSWORD 
PASSWORD

LSNRCTL> STOP LISTENER_NAME

SET PASSWORD is only required if the 
password is set in the LISTENER.ORA 
file. The password defaults to ORACLE.

3. Start the network listener. Enter:

LSNRCTL> START LISTENER_NAME

OracleHOME_
NAMETNSListener80LSNR is created if 
this command is run for the first time 
against a non-default network listener 
name.

4. Exit from the LSNRCTL80 utility. Enter:

LSNRCTL> EXIT

1. From the Control Panel window, 
double-click Services. 

The Services window appears. Look for 
OracleHOME_NAMETNSListener80 
(the service name if you are using the 
default network listener name 
LISTENER) or OracleHOME_
NAMETNSListener80LSNR (where 
LSNR is the non-default network 
listener name). OracleHOME_
NAMETNSListener80LSNR is only 
created if the following command has 
been run:

LSNRCTL80 START LISTENER_NAME

A blank in the Status column indicates 
that the service is not running. If the 
service is already running, close the 
window and go to the section "Step 3: 
Start Oracle Connection Manager" on 
page 6-35.

2. Select the service, and click Start.

The service starts.

3. In the Services window, click Close.
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Step 3: Start Oracle Connection Manager
If you are using Oracle Connection Manager, start it on the computer where Oracle 
Connection Manager is installed and configured with the CMCTL80 control utility 
or the Control Panel:

Use the control utility CMCTL80... Use the Windows NT Control Panel...

1. From the command line, enter:

C:\> CMCTL80

CMCTL> START CMAN

2. Exit from the CMCTL80 utility. Enter:

CMCTL> EXIT

1. From the Control Panel window, 
double-click Services.

The Services window appears. 

2. If you are using Oracle Names, select 
the OracleHOME_
NAMECMAdminService80 and click 
Start. If you are not using Oracle 
Names, do not start this service, and go 
to Step 3.

The service starts.

3. Select the OracleHOME_
NAMECManService80, and click Start. 
A blank in the Status column indicates 
that the service is not running.

The service starts.

4. In the Services window, click Close.
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Step 4: Perform a Loopback Test
A loopback test is when the server makes a connection to a database on its own 
computer.

To perform the loopback test:

1. Choose Start > Programs > Oracle for Windows NT - HOME_NAME > Net8 
Easy Configuration Tool.

Oracle Net8 Easy Config starts.

2. Click Test.

3. Select a service name from the Existing Services list box you created in "Using 
the Local Naming Method" on page 6-6.

4. Click Next.

Note: The instructions below only apply if you have configured 
using the  local naming method. If you have not configured with 
the local naming method, connect to the database using the 
instructions in "Step 5: Connect to the Database" on page 7-7.
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The Connection Test page appears:

5. Enter a valid user account user ID and password, such as SYSTEM and 
MANAGER, for the database you want to connect to, and click Test. The 
database administrator can provide this information.

The status of the test appears in the field below the Test button. A successful 
test display the following message:

The connection test was successful.

6. Click Done when the test is complete.

The final page appears.

7. Click Finish to dismiss Net8 Easy Configuration Tool wizard.
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Testing the Configuration on the Client
After performing a loopback test, use any of the mechanisms below to test client 
connections:

■ Verify TCP/IP Network Connections (if you are using TCP/IP)

■ Verify Oracle Database Connections Using TNSPING

■ Verify Oracle Database Connection Using Oracle Net8 Easy Configuration Tool

Verify TCP/IP Network Connections
If you are using TCP/IP, follow the instructions below to specify the destination 
address for TCP/IP and use PING to see if the server is running.

Determine the Server’s IP Address

Use PING

Most TCP/IP transports attempt to use the DNS. DNS is a mechanism used to 
translate the host name specified in the TNSNAMES.ORA file into the host internet 
address (IP). If a DNS is present on your network and the TCP/IP vendor supports 
DNS, the host name is successfully translated to the host address. The host IP 
address can be determined by using the Control Panel’s Network utility to access 
DNS information.

Depending on your vendor, workstation configuration, and network configuration, 
your TCP/IP software can also use a 
SYSTEMROOT\SYSTEM32\DRIVERS\ETC\HOSTS file to map host names to 
Internet addresses if DNS is not detected or supported. 

If DNS and the HOSTS file are unable to resolve the host name during a remote 
database connection, the following error message appears:

ORA-12545: TNS: name lookup failure

If your network administrator cannot resolve the problem, the solution to this error 
message is to go around DNS and the HOSTS file by modifying the (HOST = 
SERVER_NAME) section of the TNSNAMES.ORA, so SERVER_NAME is changed 
to the IP address of the server.

The following sections explain how to determine the server’s IP address and verify 
that DNS and the HOSTS file are working correctly. 
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Determine the Server’s IP Address
If you are not using TCP/IP, go to "Verify Oracle Database Connections Using 
TNSPING" on page 6-42.

To determine the server’s TCP/IP internet address:

1. From the Control Panel window, double-click Network.

The Network window appears.

2. Choose the Protocols tab.

The Protocols view appears:

3. From the Protocol view, select the TCP/IP Protocol Adapter, and click 
Properties.

Note: If you are not authorized for access on the server, ask your 
server administrator for assistance. 
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The Microsoft TCP/IP Properties dialog box appears with the IP Address view:

4. Obtain the IP address, and click Cancel to close the Microsoft TCP/IP Properties 
dialog box.

5. Click Cancel to close the Network window.

6. Continue to the next section, "Use PING".

Use PING 
If you are using TCP/IP, PING allows you to determine if DNS or the HOSTS file 
are correctly set up and your network operating system is functioning correctly.

To use PING:

From the client, enter the following at the command prompt:

C:\> PING SERVER_NAME

where SERVER_NAME is the host name, alias, or Internet address of the server to 
which you are trying to connect. 
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If your network is functioning correctly, the following message appears:

Reply from SERVER_NAME: bytes=nn time=nnms
If there is a problem, this message appears:

Request timed out

Or:

Reply from SERVER_NAME: Destination host unreachable

The following is a partial list of reasons why a host is inaccessible:

■ the server is not accessible through the network

■ the remote host is not online

■ the domain name server is not functioning 

■ a domain name server is not accessible through the network

■ the server name does not exist in the HOSTS file

If PING returns an error message, ask your network administrator to help you 
resolve the problem. If the problem is not resolved, and you attempt to make a Net8 
connection, you may receive one of the following error messages:

■ ORA-12203: TNS: unable to connect to destination 

■ ORA-12535: TNS: Failure to redirect to destination

■ ORA-12541: TNS: no listener
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Verify Oracle Database Connections Using TNSPING
Use the TNSPING80 utility to determine whether or not you can reach the network 
listener service. TNSPING80, however, never actually connects with the network 
listener. A socket is never created and opened. TNSPING80 only checks to ascertain 
that a network listener is present on the server side.

When you connect to a network listener using TNSPING80, an estimate of the 
round trip time in milliseconds appears. If TNSPING80 fails, a network error 
message appears without the resource use of a database connection.

To use TNSPING80:

From the client, enter:

TNSPING80 SERVICE_NAME COUNT 

where SERVICE_NAME is the service name (defined in the TNSNAMES.ORA) you 
created in "Using the Local Naming Method" on page 6-6 and COUNT is the 
number of times the program attempts to reach the server. COUNT is optional.

The output looks like:

TNS Ping Utility for 32-bit Windows: Version 8.0.6.0.0 - Production on 01 AUG-99 
20:20:33

Copyright, 1999(c) Oracle Corporation 1999. All rights reserved.

Attempting to contact (ADDRESS=(COMMUNITY=tcp.world)(PROTOCOL=TCP)(Host=host_
name)(Port=1521))
OK (60 msec)
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Verify Oracle Database Connection Using Oracle Net8 Easy Configuration Tool

Use the Oracle Net8 Easy Configuration Tool application to determine whether or 
not you can reach the network listener service. 

To verify connectivity for a client computer:

1. Choose Start > Programs > Oracle for Windows NT - HOME_NAME > Net8 
Easy Configuration Tool.

Oracle Net8 Easy Config starts.

2. Click Test.

3. Select a service name from the Existing Services list box you created in "Using 
the Local Naming Method" on page 6-6.

4. Click Next.

Note: The instructions below only apply if you have configured 
using the  local naming method. If you have not configured with 
the local naming method, connect to the database using the 
instructions in "Step 5: Connect to the Database" on page 7-7.
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The Connection Test page appears:

5. Enter a valid Username and Password, such as SYSTEM and MANAGER, for 
the database you want to connect to, and click Test.

The status of the test appears in the field below the Test button. A successful 
test displays the following message:

The connection test was successful.

6. Click Done when the test is complete.

The final page appears.

7. Click Finish to save your configuration and dismiss the Net8 Easy 
Configuration Tool.
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Connecting To a Database

This chapter describes how to connect to a database from a client computer.

Specific topics discussed are:

■ Connection Overview

■ Step 1: Start Oracle Names Server(s)

■ Step 2: Start the Network Listener

■ Step 3: Start Oracle Connection Manager(s)

■ Step 4: Start Client Cache Service

■ Step 5: Connect to the Database
base 7-1



Connection Overview
Connection Overview
Client workstations and other servers connect to a network listener with a service 
name when logging onto an Oracle server. The appropriate Oracle Protocol Adapter 
is used when the database alias (or service name) used to request a connection 
specifies that protocol in the configuration file.

Step 1: Start Oracle Names Server(s)
If you are using Oracle Names, start an Oracle Names Server on the computer 
where Oracle Names Server is installed and configured with the NAMESCTL80 
control utility or the Control Panel:

Use the control utility NAMESCTL80... Use the Windows NT Control Panel...

1. Verify whether the Oracle Names Server 
is running or not running. 

From the command line, enter:

C:\> NAMESCTL80

NAMESCTL> STATUS

If the STATUS command indicates the 
Oracle Names Server is running, go to 
Step 3. If the Oracle Names Server is not 
running, go to Step 2.

2. Start the Oracle Names Server. Enter:

NAMESCTL> START

3. Exit from the NAMESCTL80 utility. 
Enter:

NAMESCTL> EXIT

1. From the Control Panel window, 
double-click Services.

The Services window appears. Look for 
the OracleORACLE_
HOMENamesService80 service. A blank 
in the Status column indicates that the 
service is not running. If the service is 
already running, close the window and 
go to "Step 2: Start the Network Listener" 
on page 7-3.

2. Select the service, and click Start.

The service starts.

3. In the Services window, click Close.
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Step 2: Start the Network Listener
For Net8 to accept connections on the server, a network listener must be started. If 
you have started an Oracle Names Server, the network listener upon startup 
automatically registers the databases specified in the SID_LIST_LISTENER_NAME 
section of the ORACLE_HOME\NET80\ADMIN\LISTENER.ORA file with the 
well-known Oracle Names Servers.

Note: Start Oracle SNMP support (if needed) after starting the 
network listener. See Chapter 9, "Using the Oracle SNMP Agent".
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On the server, start the listener with the LSNRCTL80 control utility or the Control 
Panel:

Use the control utility LSNRCTL80... Use the Windows NT Control Panel...

1. From the command line enter:

C:\> LSNRCTL80

LSNRCTL> STATUS LISTENER_NAME

where LISTENER_NAME is the name of 
the network listener defined in the 
LISTENER.ORA file with the alias 
LISTENER. It is not necessary to identify 
the network listener if you are using the 
default network listener, named 
LISTENER.

If the STATUS command indicates the 
network listener is running, go to Step 2. 
If the network listener is not running, go 
to Step 3.

2. Even if the network listener is running, 
Oracle Corporation advises you to stop 
the network listener, and start it again. 
To stop the network listener, enter:

LSNRCTL> SET PASSWORD PASSWORD

LSNRCTL> STOP LISTENER_NAME

SET PASSWORD is only required if the 
password is set in the LISTENER.ORA 
file. The password defaults to ORACLE.

3. Start the network listener. Enter:

LSNRCTL> START LISTENER_NAME

OracleORACLE_
HOMETNSListenerLSNR is created if 
this command is run for the first time 
against a non-default network listener 
name.

4. Exit from the LSNRCTL80 utility. Enter:

LSNRCTL> EXIT

1. From the Control Panel window, 
double-click Services. 

The Services window appears. Look for 
OracleHOME_NAMETNSListener80 
(the service name if you are using the 
default network listener name 
LISTENER) or OracleHOME_
NAMETNSListener80LSNR (where 
LSNR is the non-default network 
listener name). OracleHOME_
NAMETNSListener80LSNR is only 
created if the following command has 
been run:

LSNRCTL80 START LISTENER_NAME

A blank in the Status column indicates 
that the service is not running. If the 
service is already running, close the 
window and go to "Step 3: Start Oracle 
Connection Manager(s)" on page 7-5.

2. Select the service, and click Start.

The service starts.

3. In the Services window, click Close.
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Step 3: Start Oracle Connection Manager(s)
If you are using Oracle Connection Manager, start it on the computer where Oracle 
Connection Manager is installed and configured with the CMCTL80 control utility 
or the Control Panel:

Use the control utility CMCTL80... Use the Windows NT Control Panel...

1. From the command line, enter:

C:\> CMCTL80

CMCTL> START CMAN

2. Exit from the CMCTL80 utility. Enter:

CMCTL> EXIT

1. From the Control Panel window, 
double-click Services.

The Services window appears. If you are 
using Oracle Names, select the 
OracleHOME_
NAMECMAdminService80 to acquire 
information about available Oracle 
Names Servers, and click Start. If you 
are not using Oracle Names, do not start 
this service.

The service starts.

2. Select the OracleHOME_
NAMECManService80 to start the 
Oracle Connection Manager, and click 
Start.

A blank in the Status column indicates 
that the service is not running.

The service starts.

3. In the Services window, click Close.
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Step 4: Start Client Cache Service
If you are using Oracle Names, you may enable client caching on clients with the 
NAMESCTL80 control utility or the Control Panel (for Windows NT only). Client 
caching will update the SDNS.ORA file with the new Oracle Names Server 
information. If you do not want to update the SDNS.ORA file, it is not necessary to 
start this service.

Use the control utility NAMESCTL80 Use the Windows NT Control Panel...

1. At the client command prompt, enter:

C:\> NAMESCTL80

NAMESCTL> START_CLIENT_CACHE

2. Exit from the NAMESCTL utility. Enter:

NAMESCTL> EXIT

Note: The Control Panel is not available for 
Windows 95/98 clients. You must use the 
NAMESCTL80 control utility.

1. From the client Control Panel window, 
double-click Services.

The Services window appears. Look for 
the OracleHOME_NAMEClientCache80 
service. A blank in the Status column 
indicates that the service is not running. 
If the service is already running, go to 
Step 3.

2. Select the service, and click Start.

3. In the Services window, click Close.
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Step 5: Connect to the Database
Two ways to make database connections are to:

■ Use Server Manager

■ Use SQL*Plus

Use Server Manager
To connect to a database using Server Manager:

1. Enter the following at the MS-DOS command prompt at any computer in the 
network:

C:\>SVRMGR30

The SVRMGR> prompt appears.

2. Connect to the database:

Server Manager returns a “Connected” message to the screen.

3. Issue SQL commands, such as:

SELECT * FROM DUAL;

For... Enter...

Host Naming method SVRMGR> CONNECT USERNAME/PASSWORD@HOSTNAME1

1 If you cannot make a connection to the database, verify that the GLOBAL_DBNAME parameter 
in the LISTENER.ORA file specifies a complete name, including domain, for the server computer.

Local Naming method SVRMGR> CONNECT USERNAME/PASSWORD@SERVICE_
NAME

Oracle Names method SVRMGR> CONNECT USERNAME/PASSWORD@GLOBAL_
DBNAME

GLOBAL_DBNAME is the global database name and domain 
you defined in the LISTENER.ORA for the Oracle Names 
Server.

Bequeath Protocol 
Adapter

SVRMGR> CONNECT SYSTEM/MANAGER2

2 Bequeath is from a server to itself.
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4. When done, enter:

SVRMGR> EXIT

Exiting Server Manager closes the database connection.

Use SQL*Plus
To connect to a remote database using SQL*Plus:

1. Choose Start > Programs > Oracle for Windows NT or Windows 95/98 > 
SQL*Plus 8.0.

A Log On dialog box appears.

2. Connect to the database:

3. Click OK.

The Oracle SQL*Plus window appears with a SQL> prompt.

4. Issue SQL commands, such as:

SQL> SELECT * FROM DUAL;

5. When done, enter:

SQL> EXIT

Exiting SQL*Plus closes the database connection.

User Name USERNAME

Password PASSWORD

Host String ■ HOSTNAME for host naming method

■ SERVICE_NAME for local naming method

■ GLOBAL_DBNAME in the LISTENER.ORA for Oracle 
Names 

■ blank for Bequeath
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Performing Advanced Configuration

This chapter describes optional advanced configuration:

Specific topics discussed are:

■ Using the External Naming Method

■ Configuring Authentication Adapters

■ Configuring Security for the Named Pipes Protocol Adapter

■ Configuring ANO

■ Configuring External Procedure Calls
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Using the External Naming Method
External naming refers to service name resolution by using a supported third-party 
naming service. The NDS Native Naming Adapters resolve service names stored in 
a native naming service. 

The NDS Native Naming Adapter for Windows NT and Windows 95 clients uses 
the NDS naming environment to store service names and addresses of Oracle7 
NetWare Servers. This lets an NDS user view the entire network under a single NDS 
directory tree. You can use native name services in addition to, or instead of, Oracle 
Names or the TNSNAMES.ORA file. 

If the NDS Authentication Adapter is also used, a single log on can access a 
multi-server and multi-database network.

NetWare Server Configuration
To configure the server:

1. Install and configure Net8 for NetWare on the server.

2. Log into the NDS tree.

3. Add NDS to the NAMES.DIRECTORY_PATH parameter in the SQLNET.ORA 
file:

NAMES.DIRECTORY_PATH = (NDS, TNSNAMES, ONAMES)

Note: To connect from a client using the NDS Native Naming 
Adapter, the server must be running the NetWare operating system.

Additional Information: See: 

■ Oracle Advanced Networking Option Administrator’s Guide for 
more information about the Native Naming Adapter

■ Novell NetWare documentation for further information about 
NDS

■ Oracle8 NetWare documentation
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Client Configuration
To configure a client:

1. Install and configure the NDS Native Naming Adapter and Net8 on the client.

2. When you configure the NDS Native Naming Adapter, add NOVELL to the 
NAMES.DIRECTORY_PATH parameter in the SQLNET.ORA file:

NAMES.DIRECTORY_PATH = (NDS, TNSNAMES, ONAMES)

Client Connection
To connect from a client with the NDS Native Naming Adapter:

Enter the following command at the MS-DOS command prompt to access an 
Oracle8 database for NetWare database:

C:\>SVRMGR30
SVRMGR> CONNECT USERNAME/PASSWORD@DATABASE_OBJECT_NAME

where DATABASE_OBJECT_NAME identifies the Oracle8 database in NDS. 

Note: To Support backward compatibility NOVELL is also 
supported in place of NDS.
Performing Advanced Configuration 8-3



Configuring Authentication Adapters
Configuring Authentication Adapters
Net8 provides these authentication adapters:

■ NDS Authentication Adapter

■ Windows NT Native Authentication Adapter

NDS Authentication Adapter

The NDS Authentication Adapter allows client applications and users to access a 
NetWare server running Oracle using NDS. A user logged into an NDS directory 
tree can be automatically authenticated to use an Oracle8 database on a NetWare 
server in the same NDS directory tree. This lets a user access an Oracle8 database on 
NetWare without entering an additional user name and password.

If the NDS Naming Adapter is also used, an NDS user can view the entire network 
under a single NDS directory tree. 

NetWare Server Configuration
To configure the server:

1. Install and configure Net8 for NetWare on the server.

2. Add the following entry to the SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NDS)

Note: To connect from a client using the NDS Authentication 
Adapter, the server must be running the NetWare operating system.

Additional Information: See:

■ "Configuring Security for the Named Pipes Protocol Adapter" 
in this chapter for more information about ANO NDS Native 
Naming Adapter

■ Novell NetWare documentation for more information about 
NDS

■ Oracle8 NetWare documentation
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Client Configuration
To configure a client:

1. Install and configure the Net8 on a client.

2. Add the following entry to the SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NDS)

Client Connection
To connect from a client with the NDS Authentication Adapter:

1. Log into the NDS tree.

2. Enter the following command to access an Oracle8 database for NetWare 
database:

C:\>SVRMGR30
SVRMGR> CONNECT /@SERVICE_NAME

Windows NT Native Authentication Adapter
The Windows NT Native Authentication Adapter (automatically installed with 
Net8 Server and Net8 Client) enables database user authentication through 
Windows NT. This enables client computers to make secure connections to an 
Oracle8 database on a Windows NT server. A secure connection is when a Windows 
NT client user name is retrieved on a Windows NT server through the Windows NT 
Native Authentication Adapter. The Windows NT server then permits the user 
name to perform the database actions on the server. 

To configure the Windows NT Native Authentication Adapter:

1. For both clients and server, add the following entry to the SQLNET.ORA file:

SQLNET.AUTHENTICATION_SERVICES = (NTS)

2. Follow the instructions in “Connecting Without a Password as a Nonprivileged 
Database User” in Chapter 11, “Authenticating Database Users Through 
Windows NT”, of your Getting Started guide.
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Configuring Security for the Named Pipes Protocol Adapter
If you are using Oracle Named Pipes Protocol Adapter with Oracle Names Server, 
the network listener may not be able to connect to the Oracle Names Server. 

Oracle Names Server creates a Names Pipe at startup time. The network listener 
tries to open the Named Pipe at startup. If it cannot, the network listener uses the 
default system account “Local System.” The network listener service may not be 
able to open the Named Pipe created by the Oracle Names Server unless the 
OracleTNSListener80(LSNR) service has a valid user ID and password associated. 

To set up the network listener permissions:

1. From the Control Panel window, double-click Services.

The Services window appears. 

2. Select the OracleHOME_NAMETNSListener80(LSNR) service and double-click. 

The Service dialog box appears.

3. Choose the:

■ This Account option button 

■ “...” button next to the This Account option button

The Add User dialog box appears.

4. Select your log on ID (user ID) from the Names list box and choose the Add 
button. 

The user ID appears in the Add Name field.

5. Click OK.

The Services dialog box appears with the user ID displayed in the This Account 
field.

6. Enter your password in the Password field.

7. Retype the same log on ID password in the Confirm Password field.

8. Click OK.
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Configuring ANO
This section describes additional Windows NT and Windows 95 tasks that must be 
performed in order to run ANO that are not described in the Oracle Advanced 
Networking Option Administrator’s Guide and the Oracle Net8 Assistant online help.

CyberSAFE Authentication Adapter
Before using the CyberSAFE Authentication Adapter, run the CyberSAFE 
Challenger Client to get your ticket-granting ticket.

Identix Authentication Adapter
If during the installation of Oracle Enterprise Manager Biometrics Manager, you 
chose not to allow the Installer to set up your Identix TouchSafe II Device Driver, 
then you can configure it manually as follows.

To install the TouchSAFE II Encrypt device driver for Windows NT: 

1. Change directory to ORACLE_HOME\IDENTIX 

■ If you are using the default I/O port number 280 and the default Windows 
NT directory, go to Step 4.

■ If you are not using the default I/O port number 280, go to Step 2. 

■ If you are not using the default Windows NT directory 
WINNT35\SYSTEM32\DRIVERS, go to Step 3.

2. Modify the IoPortAddress parameter in ETSIINT.INI to the current TouchSafe II 
Encrypt I/O port setting. For example: 

IoPortAddress = REG_DWORD 0x00000360  for I/O port 0x360

3. Modify the Windows NT directory setting in ETSIINT.BAT with your Windows 
NT directory. 

For example:      

copy etsiint.sys c:\winnt\system32\drivers   
-> copy etsiint.sys path\drivers 

4. Run the batch file ETSIINT.BAT. 

Additional Information: See the CyberSAFE Application Security 
Toolkit documentation.
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5. Use the SetKey utility in the Identix demo program to set a hash key in Hex. Set 
the key to C001BABY for example (do not use this value!). Make sure the hash 
key matches exactly the one set in the DEFAULT Security policy. 

6. Reboot the system, and the device driver will start to work. 

7. To make sure the device driver is running, check the Device Control Panel after 
reboot. The device ETSIINT should be started already. 

Authentication Servers for Identix
If you are using the Identix Adapter you may need to use Non authentication 
between the Oracle8 database and the Identix Authentification server.On the 
Windows NT computer where the Oracle8 database is located, modify the 
TNSNAMES.ORA file located in ORACLE_HOME\NET80\ADMIN to include the 
following:

    (CONNECT_DATA =    
      (SID = SID))
         (SECURITY=(AUTHENTICATION_SERVICES=NONE)
 ...

Kerberos Authentication Adapter
To use the Kerberos Authentication Adapter, you need to have the root 
drive:\USR\TMP subdirectory present.

SecurID Authentication Adapter
To use the SecurID Authentication Adapter, you need the following from your 
SecurID administrator:

■ SDCONF.REC file present in the root drive:\VAR\ACE

■ port numbers and service names present in the Windows NT SERVICES file
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Configuring External Procedure Calls
External procedures are functions written in a third-generation language (3GL) such 
as C, and callable from within PL/SQL or SQL as if they were a PL/SQL procedure 
or function. External procedures enable you to take advantage of the strengths and 
capabilities of a 3GL programming language in a PL/SQL environment.   

The following cartridges also require external procedures:

■ Image Cartridge

■ Time Series Cartridge

■ VIR Cartridge

Oracle8 External Procedures Requirements
Follow the procedures in the CD insert to install these products on your Windows 
NT server:

■ Oracle8

■ PL/SQL, from which external procedures are called, and the PL/SQL external 
procedure program (EXTPROC), which executes external procedures

■ Net8 Client, Net8 Server, and Oracle Protocol Adapter

Configuring Net8 for External Procedures 
External procedures entries should already be present in the LISTENER.ORA and 
TNSNAMES.ORA files if you have:

■ a new Oracle8 installation

■ migrated from SQL*Net release 2.x to Net8

■ installed Net8 into the same Oracle home as your SQL*Net release 2.x.
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For environments where the configuration files have been overwritten, edit the 
LISTENER.ORA and TNSNAMES.ORA files as follows: 

1. Add a system identifier (SID) name and a program name for EXTPROC in the 
server’s LISTENER.ORA file (entries are shown in boldface text): 

 LISTENER = 
        (ADDRESS_LIST = 
                (ADDRESS = 
                (PROTOCOL = IPC) 
                (KEY = INVENTORY) 
             ) 
                (ADDRESS = 
                (PROTOCOL = IPC) 
                (KEY = ORCL) 
            ) 
                (ADDRESS =                      
                (PROTOCOL = IPC)                
              (KEY = extproc)                 
                  )                                   
                (ADDRESS = 
                (PROTOCOL = TCP) 
                (Host = INVENTORY) 
                (PORT = 1521) 
            ) 
        ) 
STARTUP_WAIT_TIME_LISTENER = 0 
CONNECT_TIMEOUT_LISTENER = 10 
TRACE_LEVEL_LISTENER = ADMIN 
SID_LIST_LISTENER = 
        (SID_LIST =  
           (SID_DESC = 
               (SID_NAME = ORCL) 
           ) 
          (SID_DESC =                         
               (SID_NAME = extproc)             
                       (PROGRAM = extproc)                  
              )                                    
        ) 
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2. Add a service name entry for EXTPROC in the server’s TNSNAMES.ORA file 
(entries are shown in boldface text):

INVENTORYDB.WORLD = 

        (DESCRIPTION = 

                (ADDRESS = 

                (PROTOCOL = TCP) 

                (Host = INVENTORY) 

                (PORT = 1521) 

              ) 

                (CONNECT_DATA = (SID = ORCL)) 

         ) 

extproc_connection_data.world =                   

        (DESCRIPTION =                            

                (ADDRESS =                        

                (PROTOCOL = IPC)                  

                (KEY = ORCL)                      

            )                                     

        (CONNECT_DATA = (SID=extproc)) 

) 

Please note that the value for KEY must match the KEY value specified in the 
LISTENER.ORA file. In order to support a multiple Oracle home environment, the 
Oracle Installer automatically creates unique keys for the external procedures in 
different Oracle homes. 

How Do External Procedure Calls Work? 
The network listener now listens for databases services like External Procedure 
Calls. When a PL/SQL or SQL application calls an external procedure, the Net8 
network listener launches a session-specific process called EXTPROC. Through the 
network listener service, PL/SQL passes the following information to EXTPROC. 

■ shared library name 

■ external procedure name 

■ parameters (if necessary) 

 EXTPROC then loads the shared library and invokes the external procedure.                                            
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Using the Oracle SNMP Agent

This chapter describes how to use the Oracle SNMP Agent.

Specific topics discussed are:

■ What is the Purpose of SNMP?

■ Oracle SNMP Agent

■ Oracle SNMP Agent for Oracle Services

■ Configuring Oracle SNMP Agent

■ Controlling the Master Agent and the Encapsulator

■ Understanding the MASTER.CFG File

■ Understanding the ENCAPS.CFG File
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What is the Purpose of SNMP?
SNMP (Simple Network Management Protocol) is a standard internet protocol 
enabling certain nodes in a network, the management stations or managing nodes, 
to query other network components or applications for information concerning 
their status and activities. Such a query is known as an SNMP poll. The items that 
can be so polled are called managed elements. 

The software used by a management station is called a management framework or 
management station. The management station uses the SNMP protocol to request 
information from subagents on the nodes being managed, and those agents send 
back the appropriate responses. The agents can also, independently of the 
framework, transmit messages called traps to well–known addresses in response to 
specific events. This is done to enable quick and possibly automatic reactions to the 
specific conditions that the traps indicate.

All requests sent to a given network node are handled by the same master agent. 
This agent redirects the requests to the appropriate managed elements on the node, 
in some cases using subagents. The information that SNMP can obtain is described 
in a structure called a Management Information Base (MIB), which is located on the 
node of the managed element.

Oracle SNMP Agent 
The Oracle SNMP Agent enables Oracle products to be located, identified, and 
monitored by any SNMP–based network management system. 

Oracle SNMP Agent allows a database to be remotely monitored by any 
SNMP-capable management software in a TCP/IP network. This feature enables 
key Oracle products running anywhere on an enterprise’s network to be located, 
identified, and monitored by a management station running at a centrally located 
node, in much the same way and using much the same tools as traditionally have 
been used to monitor the activity of the network itself. It thereby integrates the tasks 
of database administrators and of network administrators, enabling both to use 
some of the same tools and to better integrate their tasks. 
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Oracle SNMP Agent for Oracle Services
Oracle SNMP Agent allows you to configure an:

■ OracleSNMPPeerMasterAgent

■ OracleSNMPPeer Encapsulator

OracleSNMPPeerMasterAgent  The OracleSNMPPeerMasterAgent is the process on a 
managed node that accepts queries from the management framework and 
communicates with the subagents to answer the query. It also can send SNMP traps 
independently in response to specific conditions. Only one master agent can exist 
on each managed node. Any node that does not have an agent will not be able to 
respond to SNMP requests.

OracleSNMPPeerEncapsulator  If you are currently using an incompatible agent, such 
as Microsoft SNMP, you must install the Encapsulator to encapsulate the Microsoft 
master agent such that all SNMP requests from a Network Management Station 
(NMS) are sent to OracleSNMPPeerMasterAgent, which then forwards the relevant 
requests to the encapsulated master agent through the encapsulator. If the 
encapsulator is not configured, Microsoft SNMP will not work.

Additional Information: For a complete description of SNMP 
concepts and terms, see the Oracle SNMP Support Reference Guide. It 
provides detailed listings of what the management information 
contains and suggestions on how to use it effectively in developing 
SNMP–based management applications.

Note: For this release, Oracle Networking products (Oracle 
Listener and Oracle Names) do not support SNMP. Therefore, the 
corresponding MIBs are not supported, but the Oracle8 8.0.5 and 
8.0.6 servers support SNMP and the database MIB is supported.

Note: MIB files for Oracle products are installed in ORACLE_
HOME\NET80\DOCS directory. The Oracle SNMP agent can be 
installed in only one Oracle home on a system.
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Configuring Oracle SNMP Agent

This section briefly describes the major tasks that the network administrator must 
perform to enable the Oracle SNMP Agent.

To configure Oracle SNMP support on a managed node:

1. Specify the port where master agent is listening.

The port is specified in the TRANSPORT section of the MASTER.CFG file 
located at ORACLE_HOME\NET80\ADMIN.

For example, add the following section to the file:

TRANSPORT       ordinary        SNMP

OVER UDP SOCKET

AT PORT 161

2. Specify the authentication in the COMMUNITY section of the MASTER.CFG 
file:

COMMUNITY    public

  ALLOW ALL OPERATIONS

  USE NO ENCRYPTION

Continue to Step 3 if the Encapsulator is to be used.

Note: Oracle SNMP Agent is installed with the Installer. For 
information on how to install the product, see "Typical Installation 
Results" on page 3-2.

Note: It is recommended to use port 161 for 
OracleSNMPPeerMasterAgent since it is the default port for SNMP 
communication. However, you may specify a different port 
available as long as the management application on your NMS can 
be configured to send SNMP requests to the master agent listening 
on this port.
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3. Specify an unused port where the encapsulated agent, Microsoft SNMP Service, 
should be listening. 

The port is specified in SERVICES file located at NT_
HOME\SYSTEM32\DRIVERS\ETC.

For example, make sure you have the following line in the file:

snmp              1161/udp    snmp

4. Edit the Encapsulator configuration file, ENCAPS.CFG, located at ORACLE_
HOME\NET80\ADMIN to specify which non-PEER master agents are to be 
encapsulated.

You must at least add an AGENT entry, including MIB subtrees manageable by 
NMS, for the encapsulated master agent.

For example, you should have a section like the following in the file:

AGENT AT PORT 1161 WITH COMMUNITY public

SUBTREES 

1.3.6.1.2.1.1,

1.3.6.1.2.1.2,

1.3.6.1.2.1.3,

1.3.6.1.2.1.4,

1.3.6.1.2.1.5,

1.3.6.1.2.1.6,

1.3.6.1.2.1.7,

1.3.6.1.2.1.8,

1.3.6.1.2.1.77

FORWARD ALL TRAPS;

Note: If there has already been an entry for SNMP in the file, 
change the port from 161 (default number) to something else that 
is available (1161 in this example).

Note: The port (1161 in this example) must match the one you 
specified in Step 3.
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Controlling the Master Agent and the Encapsulator

Starting the Master Agent
You may start the master agent from the command line or from the Windows NT 
Control Panel’s Services dialog box. Both ways are described next.

To start the master agent from the command line:

Invoke the master agent as follows:

C:\> CD ORACLE_HOME\BIN
C:\> AGENT CONFIGURATION_FILE TEMPORARY_FILE

where CONFIGURATION_FILE is the name of the master configuration file and 
TEMPORARY_FILE is a temporary file where storage information is to be stored. 
The master configuration file name is defaulted to MASTER.CFG.

To start the master agent:

1. From the Control Panel window, double-click Services. 

The Services window appears. Look for the OracleSNMPPeerMasterAgent 
service. A blank in Status column indicates that the service is stopped.

If the master is running, skip to Step 3. If the master is not running, continue to 
Step 2.

2. Select the OracleSNMPPeerMasterAgent service, and click Start.

The master agent is started.

3. In the Services window, choose the Close button.

Starting the Encapsulator
You may start the encapsulator from the command line or from the Windows NT 
Control Panel’s Services dialog box. Both ways are described below.

Note: CONFIGURATION_FILE and TEMPORARY_FILE are 
mandatory.

Note: If the Encapsulator is to be used, the master agent must be 
started first. See "Starting the Master Agent" on page 9-6.
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To start the encapsulator from the MS-DOS command prompt:

C:\> CD ORACLE_HOME\BIN
C:\> ENCAPS [options]

There are six command line options as shown below:

The options are:
:

-T PORT Specifies the incoming trap port where the encapsulator listens to 
receive SNMP traps sent by encapsulated master agents.

Default: no traps forwarded

-S PORT Specifies the port from which the encapsulator sends SNMP requests 
to encapsulated agents, and to which the encapsulated agents send 
their responses.

Default: assigned by the host

-H HOST Specifies the master agent’s host address, that is, the host where the 
master agent resides. This may or may not be the host of the 
encapsulated agent, specified in the ENCAPS.CFG file.

Default: localhost

-P PORT Specifies the master agent’s listening SMUX port, that is, the port to 
which the encapsulator sends its SMUX traffic.

Default: 199

-W WAIT Specifies the SNMP response time-out (in seconds) from the 
encapsulated master agent.

Default: 2 seconds

-C FILE Specifies the encapsulator’s configuration file. This file is defaulted 
to ENCAPS.CFG.

Master Agent -

Master Agent host 

-

-

-Encapsulator Configuration 

Incompatible 
Master Agent

time-out 

traps

Encapsulator
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To start the encapsulator from the Control Panel Window:

1. From the Control Panel window, double-click Services. 

The Services window appears. Look for the OracleSNMPPeerEncapsulator 
service. A blank in Status column indicates that the service is stopped.

If the master is running, skip to Step 3. If the master is not running, continue to 
Step 2.

2. Select the OracleSNMPPeerEncapsulator service, and click Start.

The encapsulator is started.

3. In the Services window, choose the Close button.
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Understanding the MASTER.CFG File
The MASTER.CFG file controls several aspects of the OracleSNMPPeerMaster 
Agent, including:

■ choice of transport protocols

■ community-based access control

■ community-based naming

A sample file is shown in Figure 9–1:

Figure 9–1 MASTER.CFG Configuration File

#########################################################################
# Default Agent Configuration File
#
#       This file allows MANAGERS to be specified.  This is used to
#       specify which managers will be receiving which traps.
#
#       Also, COMMUNITYs can be specified. This allows that agent to
#       be configured such that it will only except requests from
#       certain managers and with certain community strings.
#
# Syntax
# TRANSPORT <name>  SNMP
#                    [OVER UDP SOCKET]
#                    [AT <addr>]
# COMMUNITY <communityName>
#                ALLOW <op> [,<op>]*  [OPERATIONS]
#                     [AS ENTITY <entityName>]
#                     [MEMBERS <addrs> [,<addrs>] ]
TRANSPORT    ordinary        SNMP
   OVER UDP SOCKET
   AT PORT 161
COMMUNITY    public
   ALLOW ALL OPERATIONS
   USE NO ENCRYPTION

Note: The MASTER.CFG file is automatically installed on the 
server at ORACLE_HOME\NET80\ADMIN.
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Below is a description of the TRANSPORT and COMMUNITY parameters.

Understanding the ENCAPS.CFG File
The ENCAPS.CFG configuration file specifies which incompatible agents are to be 
encapsulated and what to make visible to the Network Management Station (NMS).

A sample file is shown in Figure 9–2:

Figure 9–2 ENCAPS.CFG Configuration File

##########################################################################
#
#       THIS IS AN EXAMPLE OF AN ENCAPSULATOR CONFIGURATION FILE.
#
#       USING THIS FILE, ENCAPSULATOR WILL ENCAPSULATE A NON-PEER
#       MIB2 AGENT ON THE SAME PROCESSOR, THAT’S LISTENING FOR SNMP
#       REQUESTS AT PORT 1161.
#
#       IT ALLOWS THE NETWORK MANAGEMENT STATION TO VIEW THE 8 SUBTREES
#       MANAGED BY THAT AGENT, AND TO RECEIVE ALL THE TRAPS EMITTED BY
#       THAT AGENT.  ALL THE REQUESTS AND TRAPS PASS THROUGH THE PEER
#       AGENT AND ENCAPSULATOR.  AT THE SAME TIME THAT THE PEER AGENT
#       IS HANDLING ENCAPSULATOR, IT ALSO HANDLES ALL SUB-AGENTS THAT
#       WERE DEVELOPED WITH THE PEER TOOLKIT TO MANAGE OTHER MIBS.
# Syntax:
# [ 
# AGENT  [ON HOST <ip>]  [AT PORT <port>]  [WITH COMMUNITY <community>]
# SUBTREES <treelist>
# [FORWARD <traplist> TRAPS]
# ;
# ]+
#       

TRANSPORT Defines an interface over which the master agent listens for SMUX 
connections from subagents or SNMP requests.

COMMUNITY Provides a form of authentication for access to information.

Note: This parameter is not the same as the COMMUNITY 
parameter in the TNSNAMES.ORA file.
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AGENT AT PORT 1161 WITH COMMUNITY public
SUBTREES        

1.3.6.1.2.1.1,
1.3.6.1.2.1.2,
1.3.6.1.2.1.3,
1.3.6.1.2.1.4,
1.3.6.1.2.1.5,
1.3.6.1.2.1.6,
1.3.6.1.2.1.7,
1.3.6.1.2.1.8,
1.3.6.1.4.1.77

FORWARD ALL TRAPS;

AGENT Defines which incompatible master agents are encapsulated. Each 
AGENT entry defines which port the encapsulated master agent is 
listening for incoming SNMP requests and which community string 
Oracle Peer SNMP should use on SNMP requests sent to that agent.

SUBTREES Identifies which of the subtrees managed by the encapsulated agent 
should be made visible to the NMS by listing the object identifiers.

FORWARD TRAPS Defines which traps sent by encapsulated agents on a host will be 
forwarded by Oracle Peer SNMP to encapsulator’s master agent.
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Performing Administration Tasks

This chapter discusses some common network administration tasks that may need 
to be performed on the server and client. 

Specific topics discussed are:

■ Performing Oracle Names Server Administration Tasks

■ Performing Server Administration Tasks

■ Performing Oracle Connection Manager Administration Tasks

■ Performing Client Administration Tasks

■ Enabling Tracing
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Performing Oracle Names Server Administration Tasks
Common administration tasks to perform on the Oracle Names Server include:

■ Starting Oracle Names Server

■ Stopping Oracle Names Server

Starting Oracle Names Server
If you are using Oracle Names, start an Oracle Names Server on the computer 
where Oracle Names Server is installed and configured with the NAMESCTL80 
control utility or the Control Panel:

Use the control utility NAMESCTL80... Use the Windows NT Control Panel...

1. Verify whether the Oracle Names Server is 
running or not running. 

From the command line, enter:

C:\> NAMESCTL80

NAMESCTL> STATUS

If the STATUS command indicates the Oracle 
Names Server is running, go to Step 3. If the 
Oracle Names Server is not running, go to Step 2.

2. Start the Oracle Names Server. Enter:

NAMESCTL> START

3. Exit from the NAMESCTL80 utility. Enter:

NAMESCTL> EXIT

1. From the Control Panel window, double-click 
Services.

The Services window appears. Look for the 
OracleHOME_NAMENamesService80 service. A 
blank in the Status column indicates that the 
service is not running. If the service is already 
running, go to Step 3.

2. Select the OracleHOME_NAMENamesService80 
service, and click Start.

The service starts.

3. In the Services window, click Close.
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Stopping Oracle Names Server
Stop an Oracle Names Server (if you are using it) when you have completed 
database connections.

Use the control utility NAMESCTL80... Use the Windows NT Control Panel...

1. From the command line, enter: 

C:\> NAMESCTL80

NAMESCTL> STOP

2. Exit from the NAMESCTL80 utility. Enter:

NAMESCTL> EXIT

1. From the Control Panel window, double-click Services.

The Services window appears. Look for the 
OracleHOME_NAMENamesService80 service. A 
blank in the Status column indicates that the service 
is not running. If the service is not running, go to Step 
3.

2. Select the OracleHOME_NAMENamesService80 
service, and click Stop.

The Services confirmation dialog box appears, 
prompting you if it is OK to stop the service.

3. Click Yes to acknowledge the message, and click 
Close to exit the Services window.
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Performing Server Administration Tasks
Common administration tasks to perform on the server side include:

■ Starting the Network Listener

■ Stopping the Network Listener

Starting the Network Listener
The following table explains how to start the network listener using either the 
control utility LSNRCTL80 or the Windows NT Control Panel:

Note: Start Oracle SNMP support (if needed) after starting the 
network listener. See Chapter 9, "Using the Oracle SNMP Agent".
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Using the control utility LSNRCTL80... Use the Windows NT Control Panel...

1. Verify whether the network listener is running or 
not running. 

From the command line enter:

C:\> LSNRCTL80

LSNRCTL> STATUS LISTENER_NAME

where LISTENER_NAME is the name of the network 
listener defined in the LISTENER.ORA file with the 
alias LISTENER. It is not necessary to identify the 
network listener if you are using the default 
network listener, named LISTENER.

If the STATUS command indicates the network 
listener is running, go to Step 2. If the network 
listener is not running, go to Step 3.

2. Even if the network listener is running, Oracle 
Corporation advises you to stop the network 
listener, and start it again. To stop the network 
listener, enter:

LSNRCTL> SET PASSWORD PASSWORD

LSNRCTL> STOP LISTENER_NAME

SET PASSWORD is only required if the password is 
set in the LISTENER.ORA file. The password 
defaults to ORACLE.

3. Start the network listener. Enter:

LSNRCTL> START LISTENER_NAME

OracleHOME_NAMETNSListenerLSNR is created if 
this command is run for the first time against a 
non-default network listener name.

4. Exit from the LSNRCTL80 utility. Enter:

LSNRCTL> EXIT

1. From the Control Panel window, double-click 
Services. 

The Services window appears. Look for 
OracleHOME_NAMETNSListener80 (the 
service name if you are using the default 
network listener name LISTENER) or 
OracleHOME_NAMETNSListener80LSNR 
(where LSNR is the non-default network 
listener name). OracleHOME_
NAMETNSListener80LSNR is only created if 
the following command has been run:

LSNRCTL80 START LISTENER_NAME

A blank in the Status column indicates that the 
service is not running. If the service is already 
running, go to Step 3.

2. Select the OracleHOME_NAMETNSListener80 
or OracleHOME_NAMETNSListener80LSNR 
service, and click Start.

The service starts.

3. In the Services window, click Close.
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Stopping the Network Listener
Stop the network listener when all database connections have completed, and the 
Oracle Names Server has been stopped.

Using the control utility LSNRCTL80... Use the Windows NT Control Panel...

1. From the command line, enter:

C:\> LSNRCTL80

LSNRCTL> SET PASSWORD PASSWORD

LSNRCTL> STOP LISTENER_NAME

where LISTENER_NAME is the name of the 
network listener defined in the LISTENER.ORA file. 
It is not necessary to define the network listener if 
you are using the default network listener name, 
LISTENER.

SET PASSWORD is only required if the password is 
set in the LISTENER.ORA file. The password 
defaults to ORACLE.

2. Exit from the LSNRCTL80 utility. Enter:

LSNRCTL> EXIT

1. From the Control Panel window, double-click 
Services.

The Services window appears. Look for 
OracleTNSListener80 (the service name if you 
are using the default network listener name 
LISTENER) or OracleTNSListener80LSNR 
(where LSNR is the non-default network listener 
name). OracleTNSListene80LSNR is only 
created if the following command has been run:

LSNRCTL80 START LISTENER_NAME

A blank in the Status column indicates that the 
service is not running. If the service is not 
running, go to Step 3.

2. Select the OracleTNSListener80 or 
OracleTNSListener80LSNR service, and click 
Stop.

The Services confirmation dialog box appears, 
prompting you if it is OK to stop the service.

3. Click Yes to confirm the message, and click 
Close to exit the Services window.
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Performing Oracle Connection Manager Administration Tasks
Common administration tasks to perform on the Oracle Connection Manager 
computer include:

■ Starting Oracle Connection Manager(s)

■ Stopping Oracle Connection Manager(s)

Starting Oracle Connection Manager(s)

The table below explains how to start an Oracle Connection Manager using either 
the command line utility CMCTL80 or the Windows NT Control Panel.

Note: Start Oracle Names (if you are using it) and the network 
listener before starting Oracle Connection Manager.
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To start Use the control utility CMCTL80... Use the Windows NT Control Panel...

...in an Oracle Names 
environment

1. From the command line, enter:

C:\> CMCTL80

CMCTL> START CMAN

2. Exit from the CMCTL80 utility. 
Enter: 

CMCTL> EXIT

1. From the Control Panel window, 
double-click Services.

The Services window appears.

2. Look for the OracleHOME_
NAMECMAdminService80 and 
OracleHOME_
NAMECManService80 services. A 
blank in the Status column indicates 
that a service is not running. If 
these service are already running, 
go to Step 4.

3. Select the OracleHOME_
NAMECMAdminService80 service 
to acquire information about 
available Oracle Names Servers, 
and click Start.

The service starts.

4. Select the OracleHOME_
NAMECManService80 service to 
start the Oracle Connection 
Manager and click Start. A blank in 
the Status column indicates that the 
service is not running.

The service starts.

5. In the Services window, click Close.
10-8 Net8 Getting Started                     



Performing Oracle Connection Manager Administration Tasks
...in a non-Oracle Names 
environment

1. From the command line, enter:

C:\> CMCTL80

CMCTL> START CM

2. Exit from the CMCTL80 utility. 
Enter:

CMCTL> EXIT

1. From the Control Panel window, 
double-click Services.

The Services window appears. Look 
for the 
OracleCManService80service. A 
blank in the Status column indicates 
that the service is not running. If 
this service is already running, go 
to Step 3.

2. Select the OracleCManService80 
service to start the Oracle 
Connection Manager, and click 
Start.

The service starts.

3. In the Services window, click Close.

To start Use the control utility CMCTL80... Use the Windows NT Control Panel...
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Stopping Oracle Connection Manager(s)
Stop the Oracle Connection Manager when the Oracle Names Server and network 
listener have been stopped:

To stop Use the control utility CMCTL80... Use the Windows NT Control 
Panel...

...in an Oracle Names 
environment

1. From the command line, enter:

C:\> CMCTL80

CMCTL> STOP CMAN

2. Exit from the CMCTL80 utility. Enter:

CMCTL> EXIT

1. From the Control Panel window, 
double-click Services.

The Services window appears. 
Look for the 
OracleCMAdminService80 and 
OracleCManService80 services. 
A blank in the Status column 
indicates that the service is not 
running. If these service are 
already stopped, go to Step 4.

2. Select 
OracleCMAdminService80 from 
the list of services, and click 
Stop.

The Services confirmation dialog 
box appears, prompting you if it 
is OK to stop the service.

3. Click Yes to acknowledge the 
message.

4. Select OracleCManService80, 
and click Stop.

The Services confirmation dialog 
box appears, prompting you if it 
is OK to stop the service.

5. Click Yes to acknowledge the 
message, and click Close to exit 
the Services window.
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...in a non-Oracle Names 
environment

1. From the command line, enter:

C:\> CMCTL80

CMCTL> STOP CM

2. Exit from the CMCTL80 utility. Enter:

CMCTL> EXIT

1. From the Control Panel window, 
double-click Services.

The Services window appears. 
Look for the 
OracleCManService80 service. A 
blank in the Status column 
indicates that the service is not 
running. If this service is already 
stopped, go to Step 3.

2. Select OracleCManService80, 
and click Stop.

The Services confirmation dialog 
box appears, prompting you if it 
is OK to stop the service.

3. Click Yes to acknowledge the 
message, and click Close to exit 
the Services window.

To stop Use the control utility CMCTL80... Use the Windows NT Control 
Panel...
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Performing Client Administration Tasks
After testing the server side configuration, perform client side administration tasks 
by:

■ Starting the Client Cache Service

■ Specifying Naming Methods

■ Modifying Service Names and Addresses

Starting the Client Cache Service
If you are using Oracle Names, you may enable client caching on clients with the 
NAMESCTL80 control utility or the Control Panel (for Windows NT only). Client 
caching will update the SDNS.ORA file with the new Oracle Names Server 
information. If you do not want to update the SDNS.ORA file, it is not necessary to 
start this service.

Use the control utility NAMESCTL80... Use the Windows NT Control Panel...

1. At the command prompt, enter:

C:\> NAMESCTL80

NAMESCTL> START_CLIENT_CACHE

2. Exit from the NAMESCTL utility. Enter:

NAMESCTL> EXIT

Note: The Control Panel is not available for 
Windows 95/98 clients. You must use the 
NAMESCTL80 control utility.

1. From the Control Panel window, 
double-click Services.

The Services window appears. Look for 
the OracleHOME_NAMEClientCache80 
service. A blank in the Status column 
indicates that the service is not running. 
If the service is already running, go to 
Step 3.

2. Select the OracleHOME_
NAMEClientCache80 service, and click 
Start.

3. In the Services window, click Close.
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Specifying Naming Methods
To specify the type of names resolution you want to use:

1. Choose Start > Programs > Oracle for Windows NT/Windows 95/98 > Oracle 
Net8 Assistant.

2. Select the Profile folder.

The profile details appear on the right side of the page.

3. Choose Naming from the drop-down list.

4. Click the Methods tab.
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5. Choose from the Available Methods list which naming method you want to use:

6. Order the naming methods according to which method you want Net8 to try 
first when resolving service names. Select the naming method in the Selected 
Methods list, and use the Promote or Demote button to move the selection up 
or down in the list.

7. Choose Save Network Configuration from the File menu.

8. Choose Exit from the File menu to exit the Oracle Net8 Assistant application.

Naming Method Description

ONAMES Oracle Names

Service names are resolved centrally, through a Names 
Server. You may need to set a Preferred Names Server 
(using the Oracle Net8 Assistant). See the Oracle Net8 
Assistant online help for more information.

See “Using the Oracle Names Method” in Chapter 6, 
"Configuring the Network".

TNSNAMES Local Naming

Service names are resolved using the TNSNAMES.ORA file 
which resides on the client.

See “Using the Local Naming Method” in Chapter 6, 
"Configuring the Network"

HOSTNAME Host Naming

Service names are resolved using the Host Naming Adapter. 
Certain criteria must be met to use host naming names 
resolution. 

See “Using the Host Naming Method” in Chapter 6, 
"Configuring the Network"

CDS Cell Directory Services

This naming method is available with the Advanced 
Networking Option (ANO). See Chapter 7, "Connecting To a 
Database" and Oracle Advanced Networking Option 
Administrator’s Guide.

NDS NetWare Directory Services (NDS)
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Modifying Service Names and Addresses
If you configured the network using the local naming method, you may:

■ Modify a Service Name

■ Delete a Protocol Address

■ Delete a Service Name

■ Add an Additional Address

These changes are saved to the TNSNAMES.ORA file.

Modify a Service Name
To modify a service name:

1. From a server or client computer, choose Start > Programs > Oracle for 
Windows NT/Windows 95/98 - HOME_NAME > Oracle Net8 Easy Config.

Oracle Service Name Wizard page displays.

2. Select Modify.

3. Select the service name from the list box on the right side of the page, and click 
Next.

4. Select the network protocol you want to use (this protocol adapter must also 
installed on the clients), and click Next.

5. Enter the appropriate information for your chosen protocol in the fields, and 
click Next.

6. Enter the name of the system ID (SID) of the database to which you want to 
connect in the Database SID field, and click Next. The default SID is ORCL.

7. Click Test Service to test the simple network you have just configured.

8. Enter a valid User name and Password, such as SYSTEM and MANAGER, for 
the database you want to connect to, and click Test.

9. Click Done when the test is complete.

The final window appears.

10. Click Finish to save your configuration and dismiss the Oracle Net8 Easy 
Config application.

Oracle Net8 Easy Config modifies the service name in the TNSNAMES.ORA 
located in ORACLE_HOME\NET80\ADMIN.
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Delete a Protocol Address
To delete a protocol address from a service name in the TNSNAMES.ORA file:

1. From the server or client computer, choose Start > Programs > Oracle for 
Windows NT/Windows 95/98 - HOME_NAME > Oracle Net8 Assistant from 
the taskbar.

The Oracle Net8 Assistant displays.

2. Double-click the Service Names folder to expand the directory of existing 
service names.

3. Select the service name from which you want to delete the protocol address, 
and click Delete Address.

4. Choose Save Network Configuration from the File menu.

The TNSNAMES.ORA file is re-created.

5. Choose Exit from the File menu.

The Oracle Net8 Assistant application exits.

Delete a Service Name
To delete a service name from the TNSNAMES.ORA file:

1. From the server or client computer, choose Start > Programs > Oracle for 
Windows NT/Windows 95/98 - HOME_NAME > Oracle Net8 Easy Config.

Oracle Service Name Wizard page displays.

2. Select Delete.

3. Select the service name from the list box on the right side of the window, and 
click Next.

A message appears asking you to confirm your decision to delete the service 
name.

4. Click OK to confirm.

The final page appears.

5. Click Finish to save your modifications, and exit the Oracle Net8 Assistant 
application. Click Cancel to abandon your changes, and exit the Oracle Net8 
Assistant application.

If you click Finish, the service name is deleted, and the TNSNAMES.ORA file is 
re-created.
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Add an Additional Address
If you configured the network using the local naming method, you can add an 
address to an existing service name.

To add an additional protocol address for a service name:

1. From the server or client computer, choose Start > Programs > Oracle for 
Windows NT/Windows 95/98 - HOME_NAME > Oracle Net8 Assistant.

Oracle Net8 Assistant appears.

2. Double-click the Service Names folder to expand the directory of existing 
service names.

3. Select the service name you want to add the additional address to, and click 
New Address.

4. Enter the Protocol, Host Name, Port Number, and SID.

5. Choose Save Network Configuration from the File menu.

The TNSNAMES.ORA file is re-created.

6. Choose Exit from the File menu.

The Oracle Net8 Assistant application exits.
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Enabling Tracing

The trace facility produces a detailed sequence of statements that describe network 
events as they are executed. Tracing an operation allows you to obtain more 
information on the internal operations of the components of Net8 than is provided 
in a log file. This information is output to files that can be evaluated to identify the 
events that led to an error. 

Tracing assists you in diagnosing and troubleshooting networking performance and 
problems. Components that can be traced using the trace facility are: 

■ network listener 

■ Net8 components on the client and server 

■ Oracle Connection Manager 

■ Oracle Names Server 

Default trace file names are:

■ Client — SQLNET.TRC or SQLNETTHREAD_ID.TRC if the TRACE_UNIQUE_
CLIENT parameter is used 

■ Server — SERVERTHREAD_ID.TRC 

■ Listener—LISTENER.TRC

■ Oracle Names Server—NAMES.TRC

■ Oracle Connection Manager—CMAN.TRC

Tracing is enabled by:

■ Using the Oracle Net8 Assistant

■ Manually Adding Parameters

■ Using the Control Utilities

Note: The trace facility uses a large amount of disk space and may 
have a significant impact upon system performance. Therefore, you 
should enable tracing only when necessary.
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Using the Oracle Net8 Assistant
The Oracle8 Net8 Assistant can be used to enable:

■ SQLNET.ORA Tracing

■ LISTENER.ORA Tracing

SQLNET.ORA Tracing
The Oracle8 Net8 Assistant enables tracing for client and/or server by setting 
parameters in the SQLNET.ORA file. When Net8 is run, SQLNET.TRC is created in 
ORACLE_HOME\NET80\TRACE.

To enable SQLNET.ORA tracing for a particular client or server:

1. From the taskbar, choose Start > Programs > Oracle for Windows NT/Windows 
95/98 - HOME_NAME > Oracle Net8 Assistant.

2. Select Profiles.

The profile details appear on the right side of the screen.

3. Select General from the drop-down list.

4. Click the Tracing tab.
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Enabling Tracing
The fields for tracing display:

5. Specify your tracing settings for the client and/or server:

Tracing Setting Description

Trace Level Determines the detail of trace:

OFF—Tracing is not enabled. OFF is the default setting.

USER—Tracing is set to a level appropriate for users. Traces 
to identify user-induced error conditions.

ADMIN—Tracing is set to a level appropriate to database 
administrators. Traces to identify installation-specific 
problems.

SUPPORT—Tracing is set to a level appropriate for customer 
support.
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6. Choose Save Network Configuration from the File menu.

7. Choose Exit from the File menu to exit the Oracle Net8 Assistant.

The Oracle Net8 Assistant application exits.

LISTENER.ORA Tracing
The Oracle8 Net8 Assistant enables tracing for client and/or server by setting 
parameters in the SQLNET.ORA file. When Net8 is run, LISTENER.TRC is created 
in ORACLE_HOME\NET80\TRACE.

To enable LISTENER.ORA tracing:

1. From the taskbar, choose Start > Programs > Oracle for Windows NT - HOME_
NAME > Oracle Net8 Assistant on the server.

2. Select Listeners.

The available network listeners display.

3. Select a network listener.

The network listener details appear on the right side of the screen.

4. Select General Parameters from the drop-down list.

5. Click the Logging and Tracing tab.

Trace Directory Specify the directory to which the trace file will be written. 
The default directory is ORACLE_HOME\NET80\TRACE.

Trace Filename Specify the name of the trace file. You may enter any valid 
filename. The default filename is TRACE.TRC.

Unique Trace File Select this checkbox to create unique trace files named 
SQLNETTHREAD_ID.TRC. 

Tracing Setting Description
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Enabling Tracing
The fields for logging and tracing display:

6. Select Tracing Enabled.

7. Specify your tracing settings:
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8. Choose Save Network Configuration from the File menu.

9. Choose Exit from the File menu to exit the Oracle Net8 Assistant.

The Oracle Net8 Assistant application exits.

Trace Setting Description

Trace Level Determines the detail of trace:

OFF—Tracing is not enabled. OFF is the default setting.

USER—Tracing is set to a level appropriate for users. Traces 
to identify user-induced error conditions.

ADMIN—Tracing is set to a level appropriate to database 
administrators. Traces to identify installation-specific 
problems.

SUPPORT—Tracing is set to a level appropriate for customer 
support.

Trace Directory Specify the directory to which the trace file will be written. 
The default directory is ORACLE_HOME\NET80\TRACE.

Trace File Specify the name and directory of the trace file. You may 
enter any valid filename. The default filename is TRACE.TRC 
and the default directory is ORACLE_
HOME\NET80\TRACE.
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Manually Adding Parameters
To set SQLNET.ORA and LISTENER.ORA tracing parameters using component 
configuration files: 

1. Set trace parameters in the configuration files: 

2. If you modified the configuration files while the component was running, start 
or restart the component to enable the changed parameters. 

Using the Control Utilities
 To set trace parameters using component control utilities: 

1. For the network listener LSNRCTL80 utility, use the TRACE command to set 
the trace level while the network listener is running. 

2. For Oracle Names NAMESCTL80 utility, use the NAMES.TRACE_LEVEL 
command to set the trace level while the Names Server is running. 

For this type of 
tracing:

Modify this file... By adding the following... To create the 
following trace 
file:

Client and Server SQLNET.ORA

LISTENER.ORA

TRACE_LEVEL_
CLIENT/LISTENER/SERVER=0/4/10/1
6

TRACE_DIRECTORY_
CLIENT/LISTENER/SERVER=directory_
name

LOG_DIRECTORY_
CLIENT/LISTENER/SERVER=directory_
name

SQLNET.TRC

LISTENER.TRC

Oracle Names Server NAMES.ORA NAMES.TRACE_LEVEL=0/4/10/16 NAMES.TRC

Oracle Connection 
Manager

CMAN.ORA TRACING = YES CMAN.TRC
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Analyzing Trace Files
Use Trace Assistant to interpret your *.TRC files.   

Follow the instructions in section “10.4.3 Using the Trace Assistant to Examine Your 
Trace Files”, in the Oracle Net8 Administrator’s Guide to run the Trace Assistant.
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Directory Structure

This appendix describes the directory structure and files of Net8. If any files are 
missing, see your CD-ROM insert for (re)installation instructions.

Specific topic discussed is:

■ Net8 Directory Structure
ture A-1



Net8 Directory Structure
Net8 Directory Structure
Oracle Installer places all Oracle Networking Products products into subdirectories 
of ORACLE_HOME. 

Directory Name Contains

\NET80 files for Oracle Network Products release 8.0

 \NET80 also contains the following subdirectories

\ADMIN configuration files used by Net8

\ADMIN\SAMPLE sample configuration files 

\DOC networking README files

\LOG log files placed here by default

\ERROR error files

\NAMES Oracle Names files

\NET8ASST Oracle Net8 Assistant files

\TNSAPI Net8 API files

\TRACE Net8 trace files placed here by default
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Modifying and Adding Configuration

Parameters

This appendix describes how to edit and add Oracle-related settings. 

Specific topics discussed are:

■ Understanding Net8 Registry Parameter and Subkeys

■ Modifying a Registry Value

■ Understanding Optional Configuration Parameters

■ Adding Optional Configuration Parameters
ters B-1
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Understanding Net8 Registry Parameter and Subkeys
Net8 contains the following registry entries:

■ Net80 Parameter

■ Net8 Service Subkeys

Net80 Parameter

Net8 Service Subkeys
HKEY_LOCAL_MACHINE\SYSTEM\CURRENTCONTROLSET\SERVICES 
contains subkeys that correspond to services. Depending upon what is installed, 
possible Net8 services are:

■ OracleHOME_NAMEClientCache80

■ OracleHOME_NAMECMAdminService80

■ OracleHOME_NAMECManService80

■ OracleHOME_NAMENames80

■ OracleHOME_NAMETNSListener80

Description Default Value Entry

Specifies the location of the Net8 directory. ORACLE_HOME\NET80

NET80 is Located in... If You Have...

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE One home directory

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ 
HOMEID

where ID is incremented for each additional Oracle home 
directory on your computer (for example, HOME1 is for a 
second directory, HOME2 is for a third directory, etc.).

Two or more home 
directories
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Modifying a Registry Value
Each service subkey contains the following parameters:

Modifying a Registry Value

To edit the Oracle-related settings:

1. Start the registry in one of the following ways:

Parameter Description

DisplayName Specifies the service name.

ImagePath Specifies the fully-qualified path name of the 
executable invoked by the service and any 
command line arguments passed to the executable 
at runtime. 

ObjectName Specifies the logon user account and computer to 
which the service should log on.

Caution: Do not edit your registry unless it is absolutely 
necessary. If there is an error in your registry, your Oracle8 
database may become nonfunctional.

On Windows NT: ■ From the command prompt, enter:

C:\>REGEDT32

■ Choose Start > Run, enter REGEDT32 in the Open field, 
and click OK.

On Windows 95/98: ■ From the command prompt, enter:

C:\>REGEDIT

■ Choose Start > Run, enter REGEDIT in the Open field, 
and click OK.
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Modifying a Registry Value
The Registry Editor window appears:

2. Navigate to the values you want to view or modify by double-clicking keys.
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Modifying a Registry Value
The left-hand side of the windows shows the hierarchy of registry keys, and the 
right-hand side of the window shows various values associated with a key:

3. Double-click the parameter you want to edit.

An editor dialog box appears:

4. Make any necessary edits, and click OK.

5. Choose Exit from the Registry menu.
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Understanding Optional Configuration Parameters
You can use the following parameters on Windows NT and Windows 95/98:

■ LOCAL

■ TNS_ADMIN

■ USE_SHARED_SOCKET

Net8 first checks for the parameters as environment variables, and uses the values 
defined. If environment variables are not defined, these parameters are searched for 
in the registry.

LOCAL
You can add the LOCAL parameter to make a connection without specifying a 
connect string service name. The value for LOCAL is the service name in the 
TNSNAMES.ORA file located in the ORACLE_HOME\NET80\ADMIN directory.

For example, if the LOCAL parameter is specified as finance, you connect to a 
database from Server Manager with the following:

SVRMGR> CONNECT SCOTT/TIGER 

Net8 checks if LOCAL is defined as an environment variable or as a parameter the 
registry, and uses finance as the service name. If it exists, Net8 connects.
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TNS_ADMIN
You can add the TNS_ADMIN parameter to change the directory name for 
configuration files from the default location. For example, if you set TNS_ADMIN 
to ORACLE_HOME\TEST\ADMIN, the configuration files are used from 
ORACLE_HOME\TEST\ADMIN.

USE_SHARED_SOCKET
You can set the USE_SHARED_SOCKET parameter to TRUE to enable the use of 
shared sockets. It this parameter is set to TRUE, the network listener passes the 
socket descriptor for a client connections to the database thread. The result is the 
client does not need to establish a new connection to the database thread, and 
database connection time improves. Also, all database connections share the port 
number used by the network listener, and this may be useful if you are setting up 
third-party proxy servers.

Enabling this option, however, does not allows you to bring the network listener up 
and down if any database connection spawned by the network listener is active. 
You may need to shut down all the databases serviced by a network listener before 
you can bring down and restart a network listener. This is because shared sockets 
implementation in WINSOCK2 does not allow a thread to a network listener on a 
port number reliably if some other connections are active on the port.

This parameter only works in a dedicated server mode in a TCP/IP environment.

Adding Optional Configuration Parameters
You can add these optional configuration parameters in three ways: 

■ Using the Registry

■ Using the Control Panel on Windows NT 

■ Using the command line with the SET command:

C:\>SET LOCAL=SERVICE_NAME
This method only lasts for the current login session.
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Using the Registry
The parameters must have a value class of REG_EXPAND_SZ and be located:

The instructions below explain how to add a parameter entry to the registry.   

To add a parameter to the registry:

1. Start the registry in one of the following ways:

The Registry Editor window appears.

2. Navigate to the proper key.

3. Choose the Add Value option in the Edit menu.

Parameter is Located in... If You Have...

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE One Oracle home 
directory

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\ 
HOMEID

where ID is incremented for each additional Oracle home 
directory on your computer.

Two or more Oracle 
home directories

On Windows NT: ■ From the command prompt, enter:

C:\>REGEDT32

■ Choose Start > Run, enter REGEDT32 in the Open field, 
and click OK.

On Windows 95/98: ■ From the command prompt, enter:

C:\>REGEDIT

■ Choose Start > Run, enter REGEDIT in the Open field, 
and click OK.
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The Add Value dialog box appears:

4. In the Value Name field, enter the name that you want to assign to the currently 
selected key.

5. In the Data Type box, select the REG_EXPAND_SZ value class.

6. Click OK.

The String Editor dialog box appropriate for the data type appears:

7. Enter the value for the parameter, and click OK.

The Registry Editor adds the parameter. 

8. Choose Exit from the Registry menu.

The registry exits.

Using the Control Panel on Windows NT
The instructions below explain how to add a parameter entry to the Control Panel 
System Properties window. This functionality is only available on Windows NT.

To add a parameter:

1. From the Control Panel window, double-click System.

The System Properties window appears.

2. Choose the Environment tab.
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The Environment view appears:

3. Click in the System Variables list box.

4. Enter the parameter name in the Variable field and its value in the Value field.

5. Click Set.

The parameter is added to the System Variables list box.

6. Click OK.

7. Log out and log back in for the changes to take effect.
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Configuration Files

This appendix describes the configuration files.

Specific topics discussed are:

■ Understanding the Configuration Files

■ Understanding the TNSNAMES.ORA File

■ Understanding the SQLNET.ORA File

■ Understanding the LISTENER.ORA File

■ Understanding the CMAN.ORA File
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Understanding the Configuration Files
Oracle Network Products use the following configuration files:

Below is a description of the configuration files:

On Your Server On Your Client

CMAN.ORA SQLNET.ORA

LISTENER.ORA TNSNAMES.ORA

SQLNET.ORA

TNSNAMES.ORA

Configuration File Description

CMAN.ORA Contains Oracle Connection Manager parameters.

LISTENER.ORA Includes service names and addresses of all network listeners 
on a computer, the system IDs (SIDs) of the databases for 
which they listen, and various control parameters used by the 
network listener. 

NAMES.ORA Contains control parameters for preferred Oracle Names 
Servers.

This file is not needed for well-known Oracle Names Servers.

SQLNET.ORA Includes optional diagnostic parameters, client information 
about Oracle Names Servers, and can contain other optional 
parameters.

TNSNAMES.ORA Includes a list of service names of network databases mapped 
to connect descriptors.
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A description of how the files are created is described below:

Note: It is possible to have system and local versions of TNSNAMES.ORA 
and SQLNET.ORA files. Any service name or parameter is first searched in 
the local version of the configuration file. If the service name or parameters 
is not found in the local version, it is searched in the system version.

The system version is located in the ORACLE_HOME\NET80\ADMIN 
directory. A local version can exist in the current working directory where 
the application is running. For example, if you start SQL*Plus in ORACLE_
HOME\BIN, then Net8 looks for a local TNSNAMES.ORA in 
ORAWIN\BIN. If you start SQL*Plus in \PLUS, then Net8 looks for a local 
TNSNAMES.ORA in \PLUS. 

A consequence of this is that you can have multiple local files in the various 
directories from which you start applications. In most cases, it is 
recommended that only one TNSNAMES.ORA file exist and that it be 
located in the default ORACLE_HOME\NET80\ADMIN directory.

This file... Is created...

CMAN.ORA during installation on the server

LISTENER.ORA during installation on the server

NAMES.ORA on the server by Oracle Net8 Assistant when configuring 
preferred Oracle Names Servers

SQLNET.ORA during installation on the clients and server, and regenerated 
on the client by Oracle Net8 Assistant.

TNSNAMES.ORA on the clients and server by Oracle Net8 Easy Config or Oracle 
Net8 Assistant
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Understanding the TNSNAMES.ORA File
The TNSNAMES.ORA file is used by clients and distributed database servers to 
identify potential server destinations. It stores the service names of databases 
addresses.

A sample file is shown in Figure C–1:

Figure C–1 TNSNAMES.ORA Configuration File

Note: The Oracle Net8 Assistant creates TNSNAMES.ORA in ORACLE_
HOME\NET80\ADMIN on the clients. TNSNAMES.ORA must be 
manually added on the server for server-to-server connections.

################

# Filename......: tnsnames.ora
# Name..........: LOCAL_REGION.world
# Date..........: 04-DEC-96 13:50:40
################
INVENTORYDB.WORLD = <---INVENTORYDB is the service name; WORLD is the domain
  (DESCRIPTION =
    (ADDRESS_LIST =
        (ADDRESS = <---listener address  
          (PROTOCOL = TCP)
          (Host = INVENTORY) <---or, use IP address of NT server
          (Port = 1521)  <---must match port in LISTENER.ORA file
        )
    )
    (CONNECT_DATA = (SID = ORCL)
    )
  )

Connect Descriptor
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Relationship To Other Configuration Files
The address of the server in TNSNAMES.ORA is the same as the address of the 
network listener for a server in LISTENER.ORA. Similarly, the address in the 
TNSNAMES.ORA file includes the SID which is required (as SID_NAME) in the 
LISTENER.ORA file. Figure C–2 shows the matching elements:

Figure C–2 TNSNAMES.ORA and LISTENER.ORA

TNSNAMES.ORA
INVENTORYDB.WORLD = 
  (DESCRIPTION =
    (ADDRESS_LIST =
        (ADDRESS =   
          (PROTOCOL = TCP)
          (Host = INVENTORY)
          (Port = 1521) 
        )
    )
    (CONNECT_DATA = (SID = ORCL)
    )

  )

LISTENER.ORA
listener = 
    (ADDRESS_LIST =  
        (ADDRESS= 
          (PROTOCOL= TCP)
          (Host= INVENTORY) 
          (Port= 1521)
        )

 SID_LIST_LISTENER =
  (SID_LIST =
    (SID_DESC =
      (GLOBAL_DBNAME = inventory)
      (SID_NAME = ORCL)   

    )



Understanding the TNSNAMES.ORA File
The domain added to the service name in TNSNAMES.ORA is the same as the 
domain defined in the NAMES.DIRECTORY_PATH parameter in the 
SQLNET.ORA. Figure C–3 shows the relationship:

Figure C–3 TNSNAMES.ORA and SQLNET.ORA

Please note that the default domain WORLD appended to the service name if the 
server name does not have the .DOMAIN extension in a connect string. For 
example, the connect string SCOTT/TIGER@INVENTORYDB gets searched in the 
TNSNAMES.ORA as INVENTORYDB.WORLD because the SQLNET.ORA has a 
NAMES.DEFAULT_DOMAIN = WORLD. If the connect string has the DOMAIN 
extension, (such as SCOTT/TIGER@HR.US), the default domain is not appended.

TNSNAMES.ORA is comprised of two parts:

■ Specifying Service Names

■ Specifying Connect Descriptors

These parts are described in the following subsections. 

Specifying Service Names
The user specifies the service name (up to 64 characters), an easy to remember 
database alias name, with Net8 Easy Configuration Tool or Oracle Net8 
Assistant—a single word rather than the lengthier connect descriptor—to identify 
the service to which to connect. The TNSNAMES.ORA file consists of a series of 
service names mapped to TNS connect descriptors.

TNSNAMES.ORA
INVENTORYDB.WORLD = 
  (DESCRIPTION =
    (ADDRESS_LIST =
        (ADDRESS =   
          (PROTOCOL = TCP)
          (Host = INVENTORY)
          (Port = 1521) 
        )
    )
    (CONNECT_DATA = (SID = ORCL)
    )

  )

SQLNET.ORA
TRACE_LEVEL_CLIENT = OFF
sqlnet.authentication_services = (NONE)
names.directory_path = (TNSNAMES, HOSTNAME)
names.default_domain = world
automatic_ipc = off
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If you are using Oracle Names Server, the service name for a database must be 
exactly the same as the global database name defined by the system administrator. 
Net8 limits the total length of a global database name to 64 characters. Of these, up 
to eight are the DB_NAME as defined by the database administrator, and the 
remainder show the service’s place in the domain hierarchy (DB_DOMAIN). The 
name part of the service name can be longer than eight characters only if the DBA 
changes the name of the database using the RENAME GLOBAL_NAME parameter 
of the ALTER DATABASE statement. The total global database name, or service 
name, must remain at or below 64 characters.

Alternate service names can be assigned to a database service through the 
TNSNAMES.ORA file. The alternate service names can be names you choose 
because you find them convenient and easy to remember. For example, if a database 
is used by two different divisions of a company, Human Resources and Finance, 
you can map two different service name aliases, hr and finance to the database. The 
TNSNAMES.ORA file has three separate entries: 

■ service name that is the same as the global database name 

■ two aliases, mapped to the same connect descriptor

Specifying Connect Descriptors
All service name are assigned a connect descriptors in the TNSNAMES.ORA file. 
For a database, a connect descriptor describes the location of the network listener 
and the SID of the database to which to connect. For an Oracle Connection Manager, 
a connect descriptor describes the location of the Oracle Connection Manager, the 
location of the network listener, and the SID of the database to which to connect. 

After the service name is listed, a database connect descriptor starts with a 
DESCRIPTION parameter which indicates the beginning definition of a database 
listening address. After DESCRIPTION, a connect descriptor contains two sections: 

■ ADDRESS 

■ CONNECT_DATA 

ADDRESS
ADDRESS contains the information required to reach the application within a given 
protocol environment. It includes the 

■ protocol it uses

■ protocol-specific parameters
Configuration Files C-7



Understanding the TNSNAMES.ORA File
Oracle Net8 Assistant and Net8 Easy Configuration Tool automatically provide the 
correct protocol specific parameters for common protocols, but you must provide 
the appropriate values. For information about the parameter values of a given 
protocol, see the section "Configuring TNSNAMES.ORA for Oracle Protocol 
Adapters" on page C-10.

CONNECT_DATA
CONNECT_DATA denotes the SID of the remote database. When Net8 on the 
server side receives the connection request, TNS passes the CONNECT_DATA 
contents to the network listener, which identifies the desired database.

A sample CONNECT_DATA section looks like: 

(CONNECT_DATA = 
   (SID = ORCL)

If the network contains an Oracle Connection Manager, an additional SOURCE_
ROUTE parameter is required. This parameter creates a source route through all 
Oracle Connection Managers to the destination database:

(CONNECT_DATA = 
   (SID = ORCL)
(SOURCE_ROUTE = YES)

Note: If you specify a TCP/IP address prefixed with a 0, it is assumed to 
be an octal number, not a decimal number. For example, 39.223.72.44 is a 
decimal number, but 039.223.72.44 is an octal number. 

Keyword Description

CONNECT_DATA Indicates that application-specific data is supplied at 
connect time.

SID Specifies the SID of the database server. You must 
specify the SID in the CONNECT_DATA section of 
the connect descriptor
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Connect Descriptor Syntax
Below is the connect descriptor syntax of the TNSNAMES.ORA file:

SERVICE_NAME.world =   
  (DESCRIPTION =    
    (ADDRESS_LIST =    
        (ADDRESS =    
        (protocol adapter information)    
        )    
    )    
    (CONNECT_DATA =    
      (SID = SID)
        )   
  )    
See "Configuring TNSNAMES.ORA for Oracle Protocol Adapters" on page C-10 for 
a description of the keywords.
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Configuring TNSNAMES.ORA for Oracle Protocol Adapters
This section describes the address format used in a client’s TNSNAMES.ORA file 
for the following Oracle Protocol Adapters:

■ TCP/IP Addresses

■ SPX Addresses

■ Named Pipes Addresses

■ LU6.2 Addresses

■ Bequeath Addresses

TNSNAMES.ORA defines the location of Oracle8 Server computers to which a 
client can connect. 

The table below describes the parameters used by the Oracle Protocol Adapters. 
Refer to this table for definitions as you review the syntax examples provided 
throughout this section.

Oracle Protocol 
Adapter

Parameter Description

All PROTOCOL Indicates the type of network on which the 
TNS-based application resides. 

All SID Identifies the Oracle system ID of the database 
server to which to connect. The 
TNSNAMES.ORA file uses the same SID 
defined in the server’s LISTENER.ORA file.

TCP/IP HOST and PORT Identifies the server and its network 
listener port number for TNS-based 
application on the network. Ask your 
network administrator for the host names 
and port numbers of TNS-based 
applications on your TCP/IP network.

SPX SERVICE Defines the name of the TNS-based 
application on the network. (Mandatory for 
server and client.) Speak to your network 
administrator to learn the service names of 
TNS-based applications on your network.

Named Pipes SERVER Indicates the name of your Oracle8 Server 
computer.
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Named Pipes PIPE Indicates the pipe name you use to connect 
to your Oracle8 Server (the same PIPE 
keyword you specified on your Oracle8 
Server with Named Pipes). This name can 
be any arbitrary name.

Bequeath PROGRAM Identifies the Oracle8 executable.

Bequeath ARGV0 Identifies the Oracle system ID (SID).

Bequeath ARGS Identifies the source of the connection (local 
client).

LU6.2 LU_NAME Identifies the Oracle8 Server; must be a 
fully-qualified name.

LU6.2 LLU or LOCAL_LU Identifies the local LU alias. This parameter 
cannot be used with LLU_NAME.

LU6.2 LLU_NAME or LOCAL_
LU_NAME

Specifies the local LU name; must be a fully 
qualified name. This parameter cannot be 
used with LLU.

LU6.2 MODE or MDN Identifies the log mode entry of the LU6.2 
session; the value is typically ORAPLU62.

LU6.2 PLU or PARTNER_LU_
NAME

Identifies the Oracle8 Server; must be a 
fully qualified name.This parameter cannot 
be used with PLU_LA.

LU6.2 PLU_LA or PARTNER_
LU_LOCAL_ALIAS

Identifies the partner LU alias of the 
Oracle7 Server. This parameter cannot be 
used with PLU.

LU6.2 TP_NAME or TPN Identifies the transaction program name of 
the host computer. This parameter is not 
required for a connection to an MVS host.

Oracle Protocol 
Adapter

Parameter Description
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TCP/IP Addresses
When using the Oracle TCP/IP Protocol Adapter, specify the address of a 
TNS-based application in the following format: 

          (ADDRESS =    
          (PROTOCOL = TCP)    
          (HOST = SERVER_NAME)   
          (PORT = PORT_NUMBER))

Net8 Example on a TCP/IP Network
The entry below is taken from a client computer that connects to an Oracle8 
database with a SID of ORCL on a host name of INVENTORY by using the service 
name INVENTORYDB on a TCP/IP network. 

INVENTORYDB.WORLD =
  (DESCRIPTION =
    (ADDRESS_LIST =
        (ADDRESS =
          (PROTOCOL = TCP)
          (Host = INVENTORY)
          (Port = 1521)
        )
    )
    (CONNECT_DATA = (SID = ORCL)
    )
  )

SPX Addresses
When using the Oracle SPX Protocol Adapter, specify the address as follows: 

        (ADDRESS =    
          (PROTOCOL = SPX)    
          (SERVICE = TNS_APPLICATION)   
        )

Net8 Example on a SPX Network
The entry below is taken from a client computer that connects to an Oracle8 
database with a SID of ORCL and network listener service name of INVENTORY_
LSNR by using the service name INVENTORYDB on an SPX network. 
C-12 Net8 Getting Started



Understanding the TNSNAMES.ORA File
INVENTORYDB.WORLd =
  (DESCRIPTION =
    (ADDRESS_LIST =
        (ADDRESS =
          (PROTOCOL = SPX)
          (Service = INVENTORY_LSNR)
        )
    )
    (CONNECT_DATA = (SID = ORCL)
    )
  )

Named Pipes Addresses
When using the Oracle Named Pipes Protocol Adapter, specify the address of a 
TNS-based application as follows: 

        (ADDRESS =    
          (PROTOCOL = NMP)    
          (SERVER = COMPUTER_NAME)  
          (PIPE = PIPE _NAME)    
        )

Net8 Example on a Named Pipes Network
The entry below is taken from a client computer that connects to an Oracle8 
database with a SID of ORCL on a computer name of NT_INVENTORY_BOX by 
using the service name INVENTORYDB on a Named Pipes network. 

INVENTORYDB.WORLD =
  (DESCRIPTION =
    (ADDRESS_LIST =
        (ADDRESS =
          (PROTOCOL = NMP)
          (Server = NT_INVENTORY_BOX)
          (Pipe = ORAPIPE)
        )
    )
    (CONNECT_DATA = (SID = ORCL)
    )
  )
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LU6.2 Addresses
When using the Oracle LU6.2 Protocol Adapter for Windows NT, specify the 
address of a TNS-based application as follows: 

        (ADDRESS = 
          (COMMUNITY= LU62.world)
          (PROTOCOL=LU62)
          (TPN= TPN_NAME)
          (MODE=ORAPLU62)
          (PARTNER_LU_NAME = "PARTNER_LU_NAME")
          (LLU_NAME = LOCAL_LU_NAME)
        )

Net8 Examples on an LU6.2 Network

Example to connect to an IBM MVS instance:
mvs.world = (DESCRIPTION =
               (ADDRESS =
                 (COMMUNITY= LU62.world)
                 (PROTOCOL=LU62)
                 (TPN=RECVTP)
                 (MODE=ORAPLU62)
                 (PARTNER_LU_NAME = "ORACLE.TNSORAK")
                 (LLU = SENDLU)
               )
               (CONNECT_DATA=(SID=ORCL)
               )
             )

Note: LLU and PARTNER_LU_LOCAL_ALIAS can be used in 
place of LLU_NAME and PARTNER_LU_NAME. 

Additional Information: See the Administrator’s Guide in the 
Microsoft SNA Server Documentation folder for LU6.2 setup 
information.
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Example to connect to a Windows NT network listener:
nt.world = (DESCRIPTION =
               (ADDRESS =
                 (COMMUNITY= LU62.world)
                 (PROTOCOL=LU62)
                 (TPN=RECVTP)
                 (MODE=ORAPLU62)
                 (PARTNER_LU_NAME = "ORACLE.HQEW001")
                 (LLU = SENDLU)
               )
               (CONNECT_DATA=(SID=ORCL)
               )
             )

Bequeath Addresses
When using the Bequeath Protocol Adapter, specify the address of a TNS-based 
application as follows: 

        (ADDRESS = 
          (PROTOCOL = BEQ)    
          (PROGRAM = oracle80)
          (ARGV0 = oracle80SID)  
          (ARGS = ‘(DESCRIPTION=(LOCAL=YES)(ADDRESS=(PROTOCOL=beq)))’)
        )

Net8 Example on a Bequeath Network
The entry below is taken from a client computer that connects to a single Oracle8 
database.

Beq-local.world =
  (DESCRIPTION =
    (ADDRESS_LIST =
        (ADDRESS =
          (PROTOCOL = BEQ)
          (PROGRAM = oracle80)
          (ARGV0 = oracle80ORCL)
          (ARGS = ‘(DESCRIPTION=(LOCAL=YES)(ADDRESS=(PROTOCOL=beq)))’)
        )
    )
    (CONNECT_DATA = (SID = ORCL)
    )
  )
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Understanding the SQLNET.ORA File
The SQLNET.ORA file contains optional parameters used by clients and the server 
(when acting as client) on the network, such as logging, tracing, and security 
parameters.

A sample file is shown in Figure C–4:

Figure C–4 SQLNET.ORA Configuration File

TRACE_LEVEL_CLIENT = OFF  <---set this to 16 if tracing is required  
sqlnet.authentication_services = (NONE)
names.directory_path = (TNSNAMES, HOSTNAME)
names.default_domain = world
automatic_ipc = off

This section covers the following SQLNET.ORA configuration issues:

■ Specifying Dead Connection Detection

■ Using SQLNET.ORA Logging and Tracing Parameters

■ Understanding Client Parameters for Use with Oracle Names Server

■ Understanding the IPC Parameter

■ Understanding Authentication, Encryption, and Checksumming Parameters

Specifying Dead Connection Detection
The optional server parameter, SQLNET.EXPIRE_TIME, determines how often the 
network listener sends a probe to verify that a client/server connection is still 
active. If a client is abnormally terminated, a connection remains open indefinitely 
unless identified and closed by the system. If you specify this parameter, the 
network listener sends a probe periodically to determine whether there is an invalid 
connection to terminate. If the network listener finds a dead connection, or a 
connection no longer in use, it returns an error, causing the server process to exit. 
This parameter must be set in the SQLNET.ORA file on the server.

Note: The SQLNET.ORA file is automatically installed on the 
server and the clients in ORACLE_HOME\NET80\ADMIN. 
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Dead connection detection has costs associated with it:

■ Additional network traffic is generated to probe for dead connections. A probe 
packet is very small, but one is sent on each connection at the interval specified 
in the SQLNET.EXPIRE_TIME parameter in the SQLNET.ORA file. 

■ When dead connection detection is enabled, the Oracle8 database needs to do 
additional processing to distinguish the connection probing event from other 
events. You can test the performance of your application with or without the 
dead connection detection feature enabled.

■ For some protocols, the generic Net8 dead connection detection feature is no 
better than the native mechanism available in the underlying transport 
protocol. In that case, it is not necessary to enable it. For example, the native 
keep-alive mechanism provided by the TCP/IP stack is enabled by default, and 
it can be tuned by changing registry values, as explained in operating system 
documentation.

In short, evaluate carefully whether you benefit from enabling the dead connection 
detection feature. 

Using SQLNET.ORA Logging and Tracing Parameters
The following SQLNET.ORA logging and tracing parameters are available:

Note: The time set in this parameter is not necessarily the amount 
of time a dead connection remains. This parameter sets the time 
between probes for dead connections. Depending on the 
underlying protocol, shutting down a dead process can take longer.

Parameter Description

LOG_FILE_CLIENT

LOG_FILE_SERVER

Sets the name of the log file. By default the log name 
is SQLNET.LOG. 

LOG_DIRECTORY_CLIENT

LOG_DIRECTORY_SERVER

Establishes the destination directory for log files. By 
default, the client directory is the current working 
directory. By default the server directory is ORACLE_
HOME\NET80\LOG.
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All errors that occur in Net8 are written to log files, while detailed sequences of 
events as they happen are written to trace files. Trace files provide more information 
than log files.

TRACE_LEVEL_CLIENT

TRACE_LEVEL_SERVER

Indicates the level of detail the trace facility records. 
The trace level value can either be a value within the 
range of 0 to 16 (where 0 is no tracing and 16 
represents the maximum amount of tracing) or a 
value of OFF, ADMIN, USER, or SUPPORT. 

■ OFF (equivalent to 0) provides no tracing.

■ USER (equivalent to 4) traces to identify 
user-induced error conditions.

■ ADMIN (equivalent to 6) traces to identify 
installation-specific problems.

■ SUPPORT (equivalent to 16) provides trace 
information for troubleshooting information for 
support.

TRACE_FILE_CLIENT

TRACE_FILE_SERVER

Establishes the name of the file to which trace 
information is written. By default, the client trace file 
name is SQLNET.TRC. By default the server trace file 
is SERVERTHREAD_ID.TRC. 

TRACE_DIRECTORY_CLIENT

TRACE_DIRECTORY_SERVER

Sets the directory where the trace file is placed. By 
default, the client directory is the current working 
directory. By default, the server directory is 
ORACLE_HOME\NET80\TRACE.

TRACE_UNIQUE_CLIENT This parameter determines whether or not a unique 
trace file is created for each client. By default, the 
value is OFF. The same trace file name is used for 
every client. If the value is OFF, when a new trace file 
is created for a client, it overwrites the existing file. If 
the value is set to ON, a thread identifier is appended 
to the name of each trace file generated so that 
several can coexist. 

This parameter creates unique trace files named 
SQLNETTHREAD_ID.TRC.

Parameter Description
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You can also manually add the following optional tracing parameters for the 
TNSPING utility to SQLNET.ORA. TNSPING determines whether or not a service 
(such as a database, an Oracle Names Server, or other TNS services) on a Net8 
network can be successfully reached. 

■ TNSPING.TRACE_LEVEL

■ TNSPING.TRACE_DIRECTORY

Understanding Default Domains
The NAMES.DEFAULT_DOMAIN parameter indicates the domain from which the 
client most often requests names. When this parameter is set, the domain name is 
automatically appended to the service name in a connect string. For example, the 
connect string SCOTT/TIGER@INVENTORYDB gets searched in the 
TNSNAMES.ORA as INVENTORYDB.WORLD, because the SQLNET.ORA has a 
NAMES.DEFAULT_DOMAIN = WORLD. If the connect string has the DOMAIN 
extension, (such as SCOTT/TIGER@HR.US), the default domain is not appended.

Understanding Client Parameters for Use with Oracle Names Server 
If you use preferred (not well-known) Oracle Names Server, another parameter, 
NAMES.PREFERRED_SERVERS, is required. This parameter includes one or more 
addresses of the Names servers in the order the client prefers to use them. 

Understanding the IPC Parameter
The IPC interprocess communication parameter, AUTOMATIC_IPC, determines if 
Net8 attempts to connect to a database using IPC or through the network first. If the 
parameter is set to ON (it’s set to OFF by default), Net8 tries to connect using a 
service name as an IPC key. If it fails, it resolves the service name (using the 
TNSNAMES.ORA file or an Oracle Names Server) and uses it for connection. If the 
parameter is set to OFF, Net8 does not look for an IPC address and goes directly to 
the network.

Additional Information: See the Oracle Net8 Administrator’s Guide 
for more information about the logging and tracing parameters in 
SQLNET.ORA.

Additional Information:  See the Oracle Net8 Administrator’s Guide. 
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Understanding Authentication, Encryption, and Checksumming Parameters
Authentication, data encryption, and checksumming parameters ensure secure 
transmission of data over networks. Authentication is available with or without the 
Advanced Networking Option (ANO). Encryption and checksumming parameters 
are only available with ANO. 

Additional Information: See the Oracle Advanced Networking Option 
Administrator’s Guide for specific configuration information on these 
parameters.
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Understanding the LISTENER.ORA File
The LISTENER.ORA file is the configuration file for the network listener. It resides 
on the server and defines:

■ the network listener address

■ the SID of the database for which it listens

■ parameters that influence the network listener’s behavior, including tracing and 
logging

A sample file is shown in Figure C–5:

Figure C–5 LISTENER.ORA Configuration File

################
# Filename......: listener.ora
# Node..........: local.world
# Date..........: 24-MAY-97 13:23:20
################
LISTENER =
  (ADDRESS_LIST =
        (ADDRESS=
          (PROTOCOL= IPC)  <---IPC is the internal protocol  
          (KEY= oracle.world)
        )
        (ADDRESS=
          (PROTOCOL= IPC)
          (KEY= ORCL)
        )
        (ADDRESS=
          (PROTOCOL= NMP)
          (SERVER= inventory.com)
          (PIPE= ORAPIPE)
        )
        (ADDRESS= 
          (PROTOCOL= TCP)
          (Host= INVENTORY) <---or, use the IP address of server 
          (Port= 1521)
        )
        (ADDRESS= 

Note: The LISTENER.ORA file is automatically installed on the 
server in ORACLE_HOME\NET80\ADMIN.
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          (PROTOCOL= TCP)
          (Host= INVENTORY)
          (Port= 1526)
        )
        (ADDRESS= 
          (PROTOCOL= TCP)
          (Host= 127.0.0.1)
          (Port= 1521)
        )
  )
STARTUP_WAIT_TIME_LISTENER = 0
CONNECT_TIMEOUT_LISTENER = 10
TRACE_LEVEL_LISTENER = 0
SID_LIST_LISTENER =
  (SID_LIST =
    (SID_DESC =
      (GLOBAL_DBNAME = inventory.com)
      (SID_NAME = ORCL)  <---Database system identifier, default is ORCL   
    )
    (SID_DESC =
      (SID_NAME = extproc)
      (PROGRAM=extproc)
    )
  )
PASSWORDS_LISTENER = (oracle)
This section covers the following LISTENER.ORA configuration issues:

■ Defining the Network Listener Name

■ Defining the Network Listener Address

■ Describing the Databases on the Network Listener

■ Using LISTENER.ORA Control Parameters

■ Using Oracle Names

■ Using the Host Naming
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Defining the Network Listener Name
You can create connections to multiple databases in two ways, using one or multiple 
network listeners: 

■ you specifically configure one network listener to multiple databases

■ you configure multiple network listeners, each for a specific database. All the 
network listeners on a single computer share one LISTENER.ORA file.

The default network listener name is LISTENER, which is the recommended name 
in a standard installation that requires only one network listener on a computer. The 
network listener name must be unique on the computer running Oracle8 database. 
If you have more than one network listener on a computer, each requires a unique 
name. 

The TURTLE node, for example, might have three network listeners with the 
names:

■ LSNR1_TURTLE

■ LSNR2_TURTLE

■ LSNR3_TURTLE

Defining the Network Listener Address
The network listener usually listens both for internal connection requests and for 
connection requests from across the network.

IPC Addresses for the Network Listener (Windows NT Only) 
The network listener listens for IPC calls if IPC addresses are in the LISTENER.ORA 
file.

The IPC address format, which is the same across platforms, is as follows:

(ADDRESS=
   (PROTOCOL=IPC)
   (KEY=string)
)

Note: The listener name is limited to 45 character for the first 
installed multiple Oracle home. For subsequent Oracle homes, the 
character length is limited to 45 characters for the home name and 
listener name combined.
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Net8 Easy Configuration Tool and Oracle Net8 Assistant create two IPC addresses 
for each database for which a network listener queries. In one, the key value is 
equal to the service name. This IPC address is used for connections from 
applications on the same node. Service names are described in the section 
"Understanding the TNSNAMES.ORA File" in this appendix. In the other IPC 
address, the key value is equal to the database SID.

LU6.2 Addresses
The network listener must have a fully qualified local LU name rather than a 
partner LU name (that may be specified in the TNSNAMES.ORA). Below is a 
sample LU6.2 address:

        (ADDRESS=
          (PROTOCOL= LU62)
          (TPN = RECVTP)
          (LLU_NAME = "ORACLE.HQEW001")
          (MODE = ORAPLU62)
        )

Configuring the Listener to Handle Larger Volumes of Connection Requests
If you expect the listener to handle large volumes of connection requests, you may 
specify a queue for the process. This will allow the listener to dynamically handle 
larger numbers of concurrent connection requests.

To specify a queue size for a listener, enter a value to the QUEUESIZE keyword at 
the end of any listening address in your listener configuration file.

A typical listener configuration file with the queue size specified.

LISTENER =
  (ADDRESS_LIST =
        (ADDRESS= 
          (PROTOCOL= TCP)
          (HOST= INVENTORY)
          (PORT= 1521)
          (QUEUESIZE = 20)
        )
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Describing the Databases on the Network Listener 
The LISTENER.ORA file describes the database SIDs for which the network listener 
queries. These are the same SIDs listed in the client’s TNSNAMES.ORA file. 
LISTENER.ORA is made up of keyword-value pairs.

SID_LIST_LISTENER_NAME=
   (SID_LIST =
      (SID_DESC =
         (SID_NAME = SID)
      )
   )
The SID is the Oracle SID of the database server. 

       (SID_NAME = ORCL)

Defining Listener Prespawned Dedicated Server Processes
This release does not support Prespawned Dedicated Server Processes by the 
listener. Do not include the following parameters in each SID_DESC of the 
LISTENER.ORA file:

■ PRESPAWN_MAX

■ PROTOCOL

■ POOL_SIZE

■ TIMEOUT

Note: Currently, you can only configure the queue size for 
listeners operating on TCP/IP. The default queue size is 5 for the 
Windows NT 4.0 Workstation and 50 for the Windows NT 4.0 
Server. Queue size for the NT 4.0 server can be increased however, 
the queue size for the NT 4.0 workstation cannot be increased due 
to operating system limitations.
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Using LISTENER.ORA Control Parameters
The following parameters control the behavior of the network listener:

Parameter Description

LOG_FILE_LISTENER_NAME Sets the name of the log file for the network listener. By 
default, the log name is SQLNET.LOG.

LOG_DIRECTORY_LISTENER_NAME Establishes the destination directory for the log file that is 
automatically generated for network listener events. By 
default, the directory is ORACLE_
HOME\NET80\ADMIN\LOG.

PASSWORDS_LISTENER_NAME Allows one or more passwords. If this optional parameter 
specifies one or more passwords, then the use of one of these 
passwords is required to perform DBA tasks against the 
network listener using the Listener Control Utility.

STARTUP_WAITTIME_LISTENER_NAME Sets the number of seconds that the network listener sleeps 
before responding to the first network listener control status 
command.

TRACE_LEVEL_LISTENER_NAME Indicates the level of detail the trace facility records. The trace 
level value can either be a value within the range of 0 to 16 
(where 0 is no tracing and 16 represents the maximum amount 
of tracing) or a value of OFF, ADMIN, USER, or SUPPORT. 

■ OFF (equivalent to 0) provides no tracing.

■ USER (equivalent to 4) traces to identify user-induced 
error conditions.

■ ADMIN (equivalent to 6) traces to identify 
installation-specific problems.

■ SUPPORT (equivalent to 16) provides trace information 
for troubleshooting information for support.

TRACE_FILE__LISTENER_NAME Establishes the name of the file to which trace information is 
written.

TRACE_DIRECTORY__LISTENER_NAME Sets the directory where the trace file is placed.
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Using Oracle Names
Clients do not need a TNSNAMES.ORA file if an Oracle Names Server is used. If 
the TNSNAMES.ORA is created, the client may use it to resolve the service name 
before resolving it through the Names Servers. Oracle Names requires the following 
entries in the LISTENER.ORA file for a network listener to register itself as a service 
to a well-known Oracle Names Server:

SID_LIST_LISTENER_NAME=
   (SID_LIST =
      (SID_DESC =
         (SID_NAME = ORCL)
         (GLOBAL_DBNAME = ORCL.world)
        )
   )
where LISTENER_NAME is the name of the network listener. LISTENER is the 
name of the default network listener.

Additionally, the Oracle Names allows databases to automatically register with 
Oracle Names Servers and allows clients to automatically find Oracle Names 
Servers. Oracle Names requires the following entry in the LISTENER.ORA file:

USE_PLUG_AND_PLAY_LISTENER_NAME=ON

GLOBAL_DBNAME This is the name with which the network listener registers the 
database instance with an Oracle Names Server (in this example 
ORCL) and the name by which the Oracle Names Server 
identifies a database. 

When clients request the connect information for a database 
from an Oracle Names Server, this is the alias they use. 

WORLD is the domain. Domain is defined in the SQLNET.ORA 
file by the NAMES.DEFAULT_DOMAIN parameter. 

USE_PLUG_AND_PLAY Instructs the network listener to find and register with a 
well-known Oracle Names Server. 

When the network listener starts, it looks for hosts with the 
well-known host names, tries to gather connection information 
from the Oracle Names Server, and registers its SID(s) with it.
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Using the Host Naming
Clients do not need a TNSNAMES.ORA file if the host naming adapter is used. A 
Oracle8 server requires the following entry in the LISTENER.ORA file to use host 
naming names resolution:

SID_LIST_LISTENER_NAME=
   (SID_LIST =
      (SID_DESC =
         (SID_NAME = ORCL)
         (GLOBAL_DBNAME = HOSTNAME)
        )
where 

■ LISTENER_NAME is the name of the network listener. LISTENER is the name 
of the default network listener.

■ HOSTNAME is the TCP/IP host name of the server computer.
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Understanding the CMAN.ORA File
The CMAN.ORA file is the configuration file for the Oracle Connection Manager on 
the server. 

A sample file is shown in Figure C–6:

Figure C–6 CMAN.ORA Configuration File

#
# Connection Manager config file
# cman.ora
#
#
# cman’s listening addresses
#

cman = (ADDRESS_LIST=
           (ADDRESS=(PROTOCOL=tcp)(HOST=inventory.com)(PORT=1610))
           (ADDRESS=(PROTOCOL=tcp)(HOST=inventory.com)(PORT=1620))
       )
#
# cman’s configurable params
#
#         MAXIMUM_RELAYS               defaults to 8
#         LOG_LEVEL                    defaults to 0
#         TRACING                      defaults to no
#         RELAY_STATISTICS             defaults to no
#         SHOW_TNS_INFO                defaults to no
#         USE_ASYNC_CALL (for nscall/nsanswer/nsaccept calls)
#                                      defaults to yes
#         AUTHENTICATION_LEVEL         defaults to 0
#         MAXIMUM_CONNECT_DATA         defaults to 1024
#         ANSWER_TIMEOUT               defaults to 0
#

cman_profile = (parameter_list=
                   (MAXIMUM_RELAYS=1024)
                   (LOG_LEVEL=1)
                   (TRACING=yes)
                   (RELAY_STATISTICS=yes)
                   (SHOW_TNS_INFO=yes)
                   (USE_ASYNC_CALL=yes)
                   (AUTHENTICATION_LEVEL=1)
               )
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#
#==========================================================================
# cman is used as a TCP fire wall proxy IF AND ONLY IF “cman_rules” exists
#==========================================================================
#

#cman_rules = (rule_list=
#                 (rule=(src=spcstn)(dst=x)(srv=x)(act=accept))
#             )
The CMAN.ORA consists of following sections: 

CMAN
The listening address is a combination of the service name and address. The format 
of the address is similar to the listening addresses in the LISTENER.ORA file, except 
for the exclusion of the CONNECT_DATA segment.

In the example below, the Oracle Connection Manager is listening on two addresses, 
SPX and TCP/IP. The Oracle Connection Manager can listen on any protocol that 
Oracle supports on the platform the Oracle Connection Manager is running on. 

CMAN= 
    (ADDRESS_LIST= 
       (ADDRESS= 
            (PROTOCOL=SPX) 
            (SERVICE=CMAN) 
       ) 
       (ADDRESS= 
           (PROTOCOL=TCP) 
           (HOST=CMAN.US.ORACLE.COM) 
           (PORT=1610) 
       ) 
    ) 

CMAN Contains the listening address for the Oracle Connection 
Manager. 

CMAN_PROFILE Contains CMAN configuration parameters. 

CMAN_RULES Contains the rules for filtering incoming connection requests. 
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CMAN_PROFILE
The CMAN_PROFILE section defines Oracle Connection Manager parameters: 

CMAN_PROFILE= 
    (PARAMETER_LIST= 
         (MAXIMUM_RELAYS=64) 
         (LOG_LEVEL=0) 
         (TRACING=YES) 
         (RELAY_STATISTICS=YES) 
         (SHOW_TNS_INFO=NO) 
         (USE_ASYNC_CALL=YES) 
         (AUTHENTICATION_LEVEL=0) 
    )

Parameter Description

ANSWER_TIMEOUT Determines the timeout for connections to the Oracle 
Connection Manager.

■ 0 is the default

■ range is 0 to n

AUTHENTICATION_LEVEL 1 instructs the CMAN to reject connect requests that are not 
using Secure Network Services. Secure Network Services is part 
of the Oracle Advanced Networking Option. 

0 is the default, which means Secure Network Services is not 
required 

MAXIMUM_CONNECT_DATA Determines the maximum number of concurrent connections 
allowed.

■ default is 1024

■ range is 257-4096

MAXIMUM_RELAYS Determines the maximum number of concurrent connections 
allowed.

■ default is 8 

■ range is 0 to 10240

LOG_LEVEL Determines the level of logging performed by the CMAN.

■ default is 0, which means no logging is performed 

■ range is 0 to 4 
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RELAY_STATISTICS YES instructs the CMAN to maintain statistics pertaining to 
relay I/O activities such as: 

■ number of IN bytes 

■ number of OUT bytes 

■ number of IN packets 

■ number of out packets 

Default is NO.

SHOW_TNS_INFO Yes instructs the CMAN to include TNS events in the log file 

Default is NO 

TRACING YES enables tracing for the Oracle Connection Manager. 

Default is NO 

USE_ASYNC_CALL YES instructs the CMAN to use all asynchronous functions 
while in the answering, accepting, or calling phase of 
establishing a connection 

Default is NO 

Note: CMAN supports out-of-band breaks, it will forward it on 
to the server. 

Parameter Description
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CMAN_RULES
The CMAN_RULES section defines access control rules: 

In order to have access control on your database server, you need to specify whom 
to accept or reject in the RULES configuration parameter. The rules specification 
involves these elements:

■ source hostname(s) for designated incoming clients

■ destination hostname(s) for designated servers

■ the destination database — SID

■ whether to accept or reject if the session request matches the first three rules

You can specify several rules for a single access control to fine tune whom accesses 
your database server.

CMAN_RULES= 
   (RULE_LIST= 
        (RULE= 
            (SRC = shost) 
            (DST = dhost) 
            (SRV = service) 
            (ACT = ACCEPT | REJECT) 
        ) 
     ) 

Multiple RULEs can be defined within the RULE_LIST. The rules in the first 
matched RULE are applied to the request. When CMAN_RULES exists, the Oracle 
Connection Manager adheres to the principle “that which is not expressly permitted 
is prohibited.” If the CMAN_RULES are not defined, then everything is permitted. 

Where Description

SHOST source host name or IP address of session request (client) 

DHOST destination host name or IP address (server) 

SERVICES SID name

ACCEPT | REJECT accept or reject the incoming requests based on the above three 
parameters. 
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Troubleshooting

This appendix describes how to resolve problems that may arise when you use Net8 
products. 

Specific topics discussed are:

■ Diagnosing Net8

■ Net8 Logging and Tracing

■ Resolving Common Error Messages

■ Resolving Oracle Names Server Problems

■ Resolving Improper Configuration of External Procedures

■ Net8 Troubleshooting Hints and Tips from the Field

■ Contacting Oracle Services Support
ting D-1



Diagnosing Net8
Diagnosing Net8
If you have just completed installing and configuring your Net8 product and an 
attempt to make a basic peer-to-peer (single protocol/single community network) 
connection returns an ORA ERROR, this section may help you diagnose the cause 
of the problem. Any underlying fault, noticeable or not, is reported by Net8 with an 
error number or message that is not always indicative of the actual problem.

This section helps you determine which parts of Net8 do function properly rather 
than the parts that do not work. This section helps you determine if the problem is:

■ Oracle software

■ other network layers

■ operating system layer

A problem can be identified if you progressively test various network layers.

For more information on specific error messages or technical bulletins on errors 
received when performing these diagnostics test, please check the following 
resources available to you: 

■ Bulletins through the GSX Problem/Solution Database Oracle Metalink Web 
Site at http://support.oracle.com. If this is your first visit: 

1. Click “registration page” and complete the registration form.

2. Back at http://support.oracle.com, select the Java or non-Java version of 
MetaLink.

3. Enter your user name and password.

4. Enter relevant search terms in the text box at the top of the page.

5. Click SUBMIT, or use the ADVANCED button for search tips.

■ Oracle Net8 Administrator’s Guide

■ Oracle Support Services
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Understanding Proper Net8 Installation
Net8 is Oracle Corporation’s remote data access software. It enables both 
client/server and server/server communication (with applications residing on 
different computers communicating as peer applications) across any network. 

The architecture of TNS is comprised of two software components that need to be 
installed on both the server and all the client computers:   

■ Net8 Client or Server version

■ Protocol Specific Adapter (If you are using TCP/IP, install the Oracle TCP/IP 
Protocol Adapter, etc.) 

To verify proper installation:

Follow the instructions in "Verifying Installation and Setup" on page 3-4.

Server Diagnostics

Answer the questions below:

■ Is any other system (workstations/servers) able to connect to the server using 
Net8?

■ Have server, database, or network listener configuration remained the same for 
some time?

If you answer yes to any of the above questions/statements, skip this section and 
continue to "Client Diagnostics" on page D-5. If you are not sure or answered no to 
any of the above questions, please continue. 

Diagnosing Net8 on the server involves:

Note: A supported third party network transport layer must be 
also installed and tested. 

Note: You may need assistance from the server administrator to 
follow the instructions in this section.
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■ Step 1: Verify the Database Is Running

■ Step 2: Perform a Loopback Test

Step 1: Verify the Database Is Running
To check that the database is up:

Log on to the database using SQL*Plus or Server Manager and connect with a valid 
username/password. For example:   

C:\> SQLPLUS SYSTEM/MANAGER 

A message appears, confirming that you are connected with the database. If you 
receive the following errors, ask your database administrator to assist you:

■ ORA-1017: invalid U/P

■ ORA-1034: Oracle not available

Step 2: Perform a Loopback Test
To perform a loopback test:

1. Check that the LISTENER.ORA, TNSNAMES.ORA, and SQLNET.ORA files 
exist in the ORACLE_HOME\NET80\ADMIN folder.

2. Follow the instructions in "Testing the Configuration on the Server" on 
page 6-31 to perform a loopback test.

If the loopback test continues to fail, continue to Step 3. 

If the loopback test passes, skip to "Client Diagnostics" on page D-5.

3. Check the Problem/Solution Database Web site at http://support.oracle.com for 
more specific information on the error received or contact Oracle Support 
Services. 
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Client Diagnostics
At this point, you know the Net8 server side network listener is functioning 
properly, because you were able to answer Yes to any of the following statements: 

■ I verified a loopback test on the server, and the connection worked. 

■ I have other computers (servers, workstation) connecting to this same Oracle8 
Server using Net8. 

■ Connections from this workstation worked previous to making changes on this 
computer (for example, installed new products or modified the network 
configuration).

To perform diagnostics on the client:

1. Check that you have installed the appropriate Oracle Protocol Adapter.

2. Check base connectivity for underlying network transport. You may need the 
assistance of the network administrator. 

Net8 technology depends upon the underlying network for a successful 
connection. 

3. Ensure all Net8 software has been installed by following the instructions in 
"Understanding Proper Net8 Installation" on page D-3 to ensure both the Net8 
Client and the appropriate Oracle Protocol Adapter are installed. 

Protocol Verify that you can...

TCP/IP Use file transfer or terminal emulation utilities (FTP, TELNET, 
and PING) from the workstation to the server where the 
network listener and database reside. 

SPX Perform a Netware login to the computer that the database is 
running on. Ensure you can map drives or use other Novell 
services such as Print Servers and File Servers on the Network. 
Check that the network listener service is broadcasting by 
doing a DISPLAY SERVERS from the Novell Server or any 
Novell File Server on the SPX network.

Named Pipes See other computers or servers on the MSFT network. Ensure 
you are able to share drives within the MSFT network. 
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4. Ensure the client computer has the TNSNAMES.ORA and the SQLNET.ORA 
files in the ORACLE_HOME\NET80\ADMIN directory. 

The search order for SQLNET.ORA and TNSNAMES.ORA is as follows:

■ current working directory from where an application is executed

■ TNS_ADMIN environment variable

■ TNS_ADMIN parameter in the registry if the TNS_ADMIN environment 
variable is not defined

■ ORACLE_HOME\NETWORK\ADMIN if TNS_ADMIN is not defined

If you have any other working client computers connecting to your selected 
Oracle8 database using Net8, back up your existing files and copy both the 
working TNSNAMES.ORA and SQLNET.ORA files from the working computer 
onto the non-working client workstations. This eliminates the possibility of 
errors in the files.

5. Test the Net8 layer with SQL*Plus or Server Manager, as described in "Testing 
the Configuration on the Client" on page 6-38.

It is advised not to use TNSPNG80. TNSPNG80 works just like the TCP/IP 
PING utility. A socket is never created and open. The TNSPNG80 never 
connects with the network listener. It just ensures network listener is present at 
the server side.

6. If the connection still fails:

■ Use tracing as described in the next section, "Net8 Logging and Tracing" on 
page D-7.

■ Check the Problem/Solution Database Web site at http://support.oracle.com 
for a specific diagnostics bulletin on the error received.

■ Contact Oracle Support Services. 
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Net8 Logging and Tracing
Both log and trace files are available for you to use in troubleshooting your network 
problems. 

This section covers:

■ Logging

■ Tracing

■ Tracing for an Oracle Names Server

■ Oracle Trace for Net8

■ Trace Assistant

For server and network listener, log files are by default located in ORACLE_
HOME\NET80\LOG and trace files are by default located in ORACLE_
HOME\NET80\TRACE. For client, log and trace files are by default located in the 
current working directory.

Logging
All errors encountered in Oracle network products are appended to a log file for 
evaluation by a network or database administrator. The log file provides additional 
information for an administrator when the error message on the screen is 
inadequate to understand the failure. The log file, by way of the error stack, shows 
the state of the software at various layers.

The default log file names are:

■ Client or Server — SQLNET.LOG

■ Listener — LISTENER.LOG (if you are using the default network listener name 
LISTENER) or LISTENERLSNR.LOG (if the network listener name is not 
LISTENER)

■ Connection Manager—CMAN.LOG

■ Oracle Names —NAMES.LOG
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Tracing
Tracing can be used to examine and diagnose application connections across the 
network. The trace facility allows a network or database administrator to obtain 
more information on the internal operations of the components of an Oracle 
application network than is provided in a log file. Tracing an operation produces a 
detailed sequence of statements that describe the events as they are executed. All 
trace output is directed to trace output files that can be evaluated to identify the 
event that led to an error.

Default trace file names are:

■ Client — SQLNET.TRC or SQLNETTHREAD_ID.TRC if the TRACE_UNIQUE_
CLIENT parameter is used 

■ Server — SERVERTHREAD_ID.TRC 

■ Listener—LISTENER.TRC (if you are using the default network listener name 
LISTENER) or LISTENERLSNR.TRC (if the network listener name is not 
LISTENER)

■ Oracle Names Server—NAMESTHREAD_ID.TRC 

■ Connection Manager—CMAN.TRC

When a client application establishes the first Net8 connection, the Net8 parameters 
are read from SQLNET.ORA file and initialized. Subsequently, if the same client 
application establishes some more Net8 connections, the SQLNET.ORA file is not 
read and any changes that were made to the SQLNET.ORA file after the first Net8 
connection will not be used. For the new changes to the SQLNET.ORA file to take 
effect, you have to exit the client application and bring it up again. The behavior on 
the server side does not change from the previous versions. Any changes to the 
SQLNET.ORA file will be reflected in subsequent connections.

Client side tracing
If the TRACE_UNIQUE_CLIENT parameter in SQLNET.ORA file is not enabled, 
then all client applications will share the same trace file. If the TRACE_UNIQUE_
CLIENT parameter is enabled in SQLNET.ORA file, then each client application will 
have a unique trace file. In both the above cases, the trace statements will have a 
prefix in the form of (x), where 'x' is some number. All the trace statements 
belonging to one connection will have the same prefix.
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The Difference Between Logging and Tracing
Logging is used to log important events for Oracle components. For example, the 
network listener log file logs version number, protocols it is listening for, connection 
establishments, errors, and so on. However, tracing describes all software events as 
they occur; that is, even when an error is not occurring. Information is posted into 
the trace file to show what is happening in the software. Thus, tracing provides 
additional information about events whether or not there is an error. 

Tracing and logging parameters are added to the SQLNET.ORA and 
LISTENER.ORA files. These parameters are described in "Using SQLNET.ORA 
Logging and Tracing Parameters" on page C-17 and "Using LISTENER.ORA Control 
Parameters" on page C-26.

Tracing for an Oracle Names Server
In some situations, it may be necessary to set tracing on for the Oracle Names 
Server. Tracing is set on by adding the parameter NAMES.TRACE_LEVEL = 16 in 
the NAMES.ORA file on the server (this file is located in ORACLE_
HOME\NET80\ADMIN). 

The next time the Names Server is started, a trace file named NAMESTHREAD_
ID.TRC is created in directory ORACLE_HOME\NET80\TRACE. 

If a client connection is not properly established, client tracing can give more 
information. Client tracing is set by adding the TRACE_LEVEL_CLIENT = 16 
parameter to the SQLNET.ORA file.

Oracle Trace for Net8
Oracle Trace allows your trace information to be managed through an Oracle 
Enterprise Manager console in an Oracle Trace repository.

Oracle Trace is a general-purpose data collection product that is part of the Oracle 
Enterprise Manager systems management product family. Oracle Trace allows 
Oracle products to collect data for a variety of uses, such as performance 
monitoring, diagnostics, and auditing. 

Additional Information: For more specific details about SQL*Net 
logging and tracing, see Chapter 10, “Troubleshooting Net8”, of the 
Oracle Net8 Administrator’s Guide.
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Trace Assistant
Use Trace Assistant to interpret your *.TRC files.   

This utility will help you diagnose and troubleshoot network problems by giving 
you a better understanding of: 

■ the source and destination of trace files 

■ the flow of packets between network nodes 

■ which component of Net8 is failing 

■ pertinent error codes 

Follow the instructions in section “10.4.3 Using the Trace Assistant to Examine Your 
Trace Files”, in the Oracle Net8 Administrator’s Guide to run the Trace Assistant.

Resolving Common Error Messages
The error messages most commonly experienced by Oracle networking product 
users are:

■ ORA-12154: TNS: Could not resolve service name

■ ORA-12203:TNS:unable to connect to destination

■ ORA-3113: end of file communication channel

■ ORA-3121: No interface driver connection - function not 
performed

If you are using the Oracle Names Server, go to "Resolving Oracle Names Server 
Problems" on page D-16.

Additional Information: See the Oracle Enterprise Manager Oracle 
Trace User's Guide for information about using Oracle Trace.
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ORA-12154: TNS: Could not resolve service name
Cause:  Net8 could not find the connect descriptor specified in the 
TNSNAMES.ORA file.   

Action:  After verifying that the database is turned on, check the following:    

1. Make sure the domain specified by the SERVICE_NAME.domain parameter 
in the TNSNAMES.ORA file matches the value for the NAMES.DEFAULT_
DOMAIN parameter in the SQLNET.ORA file.

2. Try setting the TNS_ADMIN parameter in the registry to the directory 
where the configuration files are stored. 

3. If connecting from a login dialog box, do not begin the field for the connect 
string with an @ sign. Only use the @ sign if specifying the connect string in 
command line mode: 

SQLPLUS SCOTT/TIGER@SERVICE_NAME

4. Make sure you have a TNSNAMES.ORA file on the client if you are not 
using an Oracle Names Server.

5. Make sure your TNSNAMES.ORA file is the same on both the server and 
the client.  

6. Check for multiple copies of the TNSNAMES.ORA file. 

By default, TNSNAMES.ORA is located in ORACLE_
HOME\NET80\ADMIN.

7. In the TNSNAMES.ORA file, verify:

■ The service name matches the one you are specifying in the connect 
string. 

■ There are no syntax errors, especially stray characters and mismatched 
parentheses.

8. Make sure that there are no duplicate copies of SQLNET.ORA.   

9. Turn on client tracing and re-execute the operation. 

The client trace file shows a secondary error code. To turn on client tracing, 
add or modify the variable TRACE_LEVEL_CLIENT in the ORACLE_
HOME\NET80\ADMIN\SQLNET.ORA file to TRACE_LEVEL_CLIENT = 
16.
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ORA-12203:TNS:unable to connect to destination
ORA-12203 error is a generic error that often shields secondary errors. For this 
reason, check the latest SQLNET.LOG file located in ORACLE_HOME\NET80\LOG 
directory for secondary ORA messages. If after analyzing the log file you determine 
there are no secondary errors, determine if the problem may be caused by on the 
following scenarios:

Cause:  The incorrect Oracle Protocol Adapter for the selected networking 
protocol is installed. 

Action:  Ensure the correct DLL is installed by viewing the RGS file in the 
ORACLE_HOME\ORAINST directory:

A missing protocol adapter driver usually produces the following errors in 
the SQLNET.LOG or any client trace file: 

■ ORA-12203 

■ ORA-12538 

■ ORA-00508 

Cause:  An invalid service name was supplied in the connect string. 

Action:   Verify that the service name supplied in your connect string exists in 
your TNSNAMES.ORA file and the ADDRESS information for that TNS ser-
vice name is valid:

■  Is the HOST or SERVICE name correct? 

■  Is the PORT specified correct? 

Cause:  Net8 could not find the connect descriptor specified in the 
TNSNAMES.ORA file.   

Action:  After verifying that the database is running, check the following:    

1. Verify the Net8 network listener is running. Enter:

LSNRCTL80
LSNRCTL> STATUS LISTENER_NAME

File Operating System

WIN95.RGS Windows 95

NT.RGS Windows NT
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where LISTENER_NAME is the name of the network listener defined in the 
LISTENER.ORA file. It is not necessary to identify the network listener if 
you are using the default network listener, named LISTENER.

If the output indicates the network listener is not running, try starting it 
with the command:

LSNRCTL> START LISTENER_NAME
2. Ensure the TNSNAMES.ORA file is in the correct location.

By default, TNSNAMES.ORA is located in ORACLE_
HOME\NET80\ADMIN.

Cause:  The destination system’s network listener is not listening. 

Action:  Verify that the remote system’s network listener is running. Enter:

C:\> LSNRCTL80
LSNRCTL> STATUS LISTENER_NAME
where LISTENER_NAME is the name of the network listener defined in the 
server’s LISTENER.ORA file. It is not necessary to identify the network 
listener if you are using the default network listener, named LISTENER.

If the output indicates the network listener is not running, try starting it 
with the command:

LSNRCTL> START LISTENER_NAME
Cause:  There are underlying network transport problems. 

Action:   Verify with utilities supplied with the networking protocol being used 
that the protocol itself is functional. For example, with TCP/IP, try to PING the 
remote system. 

Cause:  TNSNAMES.ORA file is not located in the proper directory. 

Action:   Make sure the TNSNAMES.ORA file is located in ORACLE_
HOME\NET80\ADMIN (the default) directory or an alternative path, as 
explained in "Client Diagnostics" on page D-5.

Cause:  The (HOST=SERVER_NAME) for TCP/IP or (SERVICE=TNS_
APPLICATION) for SPX are not consistent on the clients and server computers.

Action:  Ensure the (HOST=SERVER_NAME) for TCP/IP or (SERVICE=TNS_
APPLICATION) for SPX are the same on the server and client workstations. 

For TCP/IP setups, make sure that the HOST parameter in the 
LISTENER.ORA on the server and the TNSNAMES.ORA file on the client 
point to the same name, or at least to names that are then translated to the 
Troubleshooting D-13



Resolving Common Error Messages
same IP address by each system. This is especially important for servers 
with multiple IP addresses assigned to the various network interfaces on 
the server. 

For SPX setups, the name must be the same on the server and client 
workstations. 

Cause:   The descriptor in the TNSNAMES.ORA file for the Oracle LU6.2 
Protocol Adapter does not have the value for PLU_LA in upper case. This is 
irrespective of the case used in the SIDEINFO.NSD file for the symbolic 
destination name. For example: 

 os2=  
       (DESCRIPTION=  
           (ADDRESS=(PROTOCOL=LU62)  
                    (PLU_LA=os2)))  
results in this error.

Action:  Change the value to uppercase. For example:

os2=  
       (DESCRIPTION=  
           (ADDRESS=(PROTOCOL=LU62)  
                    (PLU_LA=OS2)))  
where os2 is defined as the SYMBOLIC DESTINATION NAME in the 
SIDEINFO.NSD file. 
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ORA-3113: end of file communication channel
An ORA-3113 means that communications were lost for an unexpected reason. It is 
usually followed by a:

 ORA-3114: not connected to ORACLE
Cause:  The Oracle shadow process on the server died unexpectedly. 

Action:  Check if the SIDALRT.LOG file in ORACLE_
HOME\RDBMS80\TRACE on the server to see if any other Oracle errors 
occurred. 

Cause:  Computer crash or network failure at the server side. 

Cause:  Two servers with the same host names or IP addresses on the same 
network. 

Action:  To find the duplicate addresses turn off the computer that is receiving 
the error, PING its IP address. If the PING responds, then you have to find the 
offending computer.

Cause:     The TOKEN RING card has the Shared RAM size set to 8KB rather 
than 16KB. 

Action:  If you are using a TOKEN RING card, check the shared buffer size and 
try increasing it.

Cause:  An unexpected end–of–file was processed on the communication 
channel. The TCP/IP retransmission count on Windows 95 and Windows NT 
has a default value of 5. This means that the send side retransmits the packet 
five times or until it gets an acknowledgment. The timeout for each 
retransmission is two times the timeout for the previous retransmission 
(exponential backoff). With the default value of 5, the send side retransmits 5 
times (approximately 15 seconds) and if it does not get an acknowledgment, it 
assumes that the other side is down and closes the connection. If the link goes 
down for a minute or two the Net8 client receives this error.   

Action:  Modify the retransmission count. 

Please see your Microsoft-specific operating system manual for more 
information on tuning the Microsoft TCP/IP software.
Troubleshooting D-15



Resolving Oracle Names Server Problems
ORA-3121: No interface driver connection - function not performed
Cause:  This is caused from using a SQL*Net version 1 prefix in the connect 
string. 

Action:  Do not use the following prefixes in the connect string.

■ T:

■ X:

■ P:

Cause:  If you only specify the user name and password from a client computer 
with no local Oracle database installed.

Action:  Specify a connect string.

Resolving Oracle Names Server Problems
Problems with Oracle Names Server occur because:

■ Client Connections Not Established 

■ Service Is Not Resolved

Client Connections Not Established
The NAMESCTL80 utility provides the QUERY command, which queries the 
existence or contents of an object (for example, a database) stored in the Names 
Server. This command can be useful in situations where a client connection is not 
properly established. 

For example, you can query an Oracle Names Server for INVENTORYDB.WORLD 
alias through the NAMESCTL80 utility: 

C:\> NAMESCTL80  
NAMESCTL> QUERY INVENTORYDB.WORLD * 

The sample output looks like:

Total response time:   0.01
Response status:       normal, successful completion 
Authoritative answer:  yes 
Number of answers:     1
TTL:                   1 day
        ...(DESCRIPTION=(ADDRESS_LIST=(ADDRESS=(PROTOCOL=TCP)(HOST= 
INVENTORY)(PORT=1526)))(CONNECT_DATA=(SID=ORCL))) 
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Resolving Oracle Names Server Problems
The “a.smd” data type that stores the address for INVENTORYDB.WORLD allows 
you to determine if the address is correct (that is, for TCP/IP the host name and the 
port number must be the same as the ones defined in the LISTENER.ORA file on 
the server). 

Service Is Not Resolved
 When a service is not resolved through an Oracle Names Server:

1. Make sure that the parameter USE_PLUG_AND_PLAY_LISTENER_NAME (is 
defaulted to LISTENER) is set to TRUE in the LISTENER.ORA file on the server. 

2. Make sure that the parameter GLOBAL_DBNAME is set for each database in 
the SID_LIST_LISTENER_NAME (LISTENER_NAME is defaulted to 
LISTENER) section in the LISTENER.ORA file on the server. 

3. Use the LSNRCTL80 STAT command to see if the database you are trying to 
connect to is registered with the Names Server. The database is registered with 
the Names Server if the word Registered appears next to the database SID in 
the Services Summary section of the output. 

The LSNRCTL80 STAT output looks something like: 

LSNRCTL80 for 32-bit Windows: Version 8.0.4.0.0 - Production on 25-NOV-97 
18:51:15

(c) Copyright 1997 Oracle Corporation. All rights reserved.

Connecting to (ADDRESS=(PROTOCOL=IPC)(KEY=oracle.world))

STATUS of the LISTENER

------------------------

Alias                     LISTENER

Version                   TNSLSNR80 for 32-bit Windows: Version 8.0.4.0.0 - 
Production

Start Date                24-NOV-97 14:30:27

Uptime                    1 days 4 hr. 20 min. 50 sec

Trace Level               off

Security                  ON

SNMP                      OFF

Listener Parameter File   D:\orant\NET80\admin\listener.ora

Listener Log File         D:\orant\NET80\log\listener.log

Services Summary...
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Resolving Improper Configuration of External Procedures
 ORCL has 1 service handler(s)

 extproc has 1 service handler(s)

The command completed successfully

4. Query the Names Server through the NAMESCTL80 utility for the Net8 service 
you are using. In the output, check the address for the service you are using and 
make sure it is correct. See "Client Connections Not Established" on page D-16.

Resolving Improper Configuration of External Procedures
You receive the following error message if external procedures are not correctly 
configured for 3GL programming language in a PL/SQL environment, the Image 
Cartridge, the Time Series Cartridge, or the VIR Cartridge.

ORA-28575: unable to open RPC connection to external procedure agent 
ORA-06512: at "APPLICATIONS.OSEXEC", line 0 
ORA-06512: at "APPLICATIONS.TEST", line 4 
ORA-06512: at line 2 
Ensure external procedures are properly configured, these error messages display. 
Follow the procedures in "Configuring External Procedure Calls" on page 8-9.

Net8 Troubleshooting Hints and Tips from the Field
Below are some Net8 tips you may find helpful when you are having difficulty 
diagnosing the problem:

■ Try using the node or network address during configuration instead of the 
name of the server computer.

This eliminates any internal lookup problems (and make the connection slightly 
faster). 

For TCP/IP — Use the internet address, for example, 198.32.3.5 

Change the (HOST =SERVER_NAME) line in TNSNAMES.ORA with internet 
address, for example, (HOST=198.32.3.5).

■ Understand SPX/IX connection issues.

The workstation that is requesting a connection to be made with a remote 
network listener must first learn the location of that SPX service in the NetWare 
IPX network. 

The client workstation issues a lookup request for the SPX service. If the service 
can not be found, an error is sent back to the workstation.
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Net8 Troubleshooting Hints and Tips from the Field
■ Perform a loopback test on the server and FTP the files TNSNAMES.ORA and 
SQLNET.ORA to the client.   

■ Comment out unnecessary SQLNET.ORA parameters.

The SQLNET.ORA file may have parameters required for more enhanced uses, 
such as Dead Connection Detection. Older SQLNET.ORA files can have the 
Advanced Networking Option (ANO) parameters that do not work for 
SQL*Net. If these features are not fully configured, a basic connection can fail. 
The following parameters can be commented out: 

SQLNET.AUTHENTICATION_SERVICES (ANO Parameter) 

SQLNET.EXPIRE_TIME (Dead Connection Detection Parameter)

SQLNET.CRYPTO_SEED (ANO Parameter)

■ Check what is between you and the server. If it is a wide area network(WAN), 
identify any intermediate systems that are not working correctly. If all 
computers are fine, the problem may be a timing issue. Timing issues are 
associated with ORA-12203, ORA-12535, or ORA-12547 errors in the client log 
files. 

To resolve this, try speeding up the connection by using exact addresses instead 
of names and increase the CONNECT_TIMEOUT_LISTENER parameter in the 
LISTENER.ORA file. The default value for this parameter is 10 seconds. 

■ Determine which Oracle applications are failing. SQL*Plus may work, but 
CASE tools may not. If you determine the problem is a data volume issue, try to 
transfer a large (5 MB) file with the base connectivity. 

Questions to Ask When Troubleshooting
Below are some questions to ask yourself when diagnosing a problem:

■ Do all computers have a problem, or is it just one?

If one computer works and another does not, and you are confident that the 
same software (Oracle and third-party products) is installed, swap over the 
network cables (if they are close enough) to see if the problem moves. This 
indicates the problem is something between the client/server and not locally on 
the PC. 

■ What kind of links are between the client and the server, for example, X.25, 
ISDN, Token Ring, or leased line?
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Contacting Oracle Services Support
Sniffers and Lan Analyzers are useful for intermittent failing connections or 
detecting time-outs and resent packets. You can also see what side of the 
conversation is waiting for a response. 

■ Does the third party application fail, but Oracle applications work? 

Contacting Oracle Services Support
If after reading this appendix, you still cannot resolve your problems, call Oracle 
Services Support to report the error. Please have the following information at hand:

■ The hardware and operating system release number on which your 
application(s) is running.

■ The release numbers (up to five digits in release) of all Oracle networking 
products involved in the current problem. 

■ The third-party vendor and version you are using.

■ The kind of links that are between the client and server.

■ A description of what does work.

■ The exact error message.

■ A Net8 trace if possible. If not, the log file is sufficient.
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Net8 Services and Port Numb
E

Net8 Services and Port Numbers

This appendix describes the services and port numbers used by Net8. 

Specific topics discussed are:

■ Services

■ Port Numbers
ers E-1



Services
Services

Product Windows NT Service Name How to Start How to Stop

Network 
Listener

OracleHOME_
NAMETNSListener80 (the 
service name if you are using 
the default network listener 
name LISTENER) or 
OracleHOME_
NAMETNSListener80LSNR 
(where LSNR is the non-default 
network listener name)

OracleHOME_
NAMETNSListener80LSNR is 
only created if the following 
command has been run:

LSNRCTL80 START 
LISTENER_NAME

From the Windows NT Control 
Panel:

1. Double-click Services.

The Services dialog box 
appears. 

2. Select OracleHOME_
NAMETNSListener80 or 
OracleHOME_
NAMETNSListener80LSNR.

3. Click Start.

4. In the Services window, click 
the Close button.

From the Windows NT Control 
Panel:

1. Double-click Services.

The Services dialog box 
appears. 

2. Select OracleHOME_
NAMETNSListener80 or 
OracleHOME_
NAMETNSListener80LSNR.

3. Click Stop.

The Services confirmation 
dialog box appears, 
prompting you if it is OK to 
stop the service.

4. Click Yes to acknowledge the 
message, and click Close to 
exit the Services window.

SNMP OracleSNMPPeerEncapsulator

OracleSNMPPeerMasterAgent

From the Windows NT Control 
Panel:

1. Double-click Services.

The Services dialog box 
appears. 

2. Select

OracleSNMPPeerEncapsulator or 
OracleSNMPPeerMasterAgent.

3. Click Start.

4. In the Services window, click 
the Close button.

From the Windows NT Control 
Panel:

1. Double-click Services.

The Services dialog box 
appears. 

2. Select

OracleSNMPPeerEncapsulator or 
OracleSNMPPeerMasterAgent.

3. Click Stop.

The Services confirmation 
dialog box appears, 
prompting you if it is OK to 
stop the service.

4. Click Yes to acknowledge the 
message, and click Close to 
exit the Services window.
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Services
Oracle 
Names

OracleHOME_
NAMENamesService80

From the Windows NT Control 
Panel:

1. Double-click Services.

The Services dialog box 
appears. 

2. Select OracleHOME_
NAMENamesService80.

3. Click Start.

4. In the Services window, click 
the Close button.

From the Windows NT Control 
Panel:

1. Double-click Services.

The Services window appears. 

2. Select OracleHOME_
NAMENamesService80 from 
the listing.

3. Click Stop.

4. The Services confirmation 
dialog box appears, 
prompting you if it is OK to 
stop the service.

5. Click Yes to acknowledge the 
message, and click Close to 
exit the Services window.

Client Cache 
Service

OracleHOME_
NAMEClientCache80

From the Windows NT Control 
Panel:

1. Double-click Services.

The Services dialog box 
appears. 

2. Select the service.

3. Click Start.

4. In the Services window, click 
the Close button.

From the Windows NT Control 
Panel:

1. Double-click Services.

The Services dialog box 
appears. 

2. Select the service.

3. Click Stop.

The Services confirmation 
dialog box appears, 
prompting you if it is OK to 
stop the service.

4. Click Yes to acknowledge the 
message, and click Close to 
exit the Services window.

Product Windows NT Service Name How to Start How to Stop
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Services
Oracle 
Connection 
Manager

OracleHOME_
NAMECManService80

OracleHOME_
NAMECMAdminService80

From the Windows NT Control 
Panel:

1. Double-click Services.

The Services dialog box 
appears. 

2. Select OracleHOME_
NAMECMAdminService80

3. Click Start.

4. Select OracleHOME_
NAMECManService80 from 
the listing.

5. Click Start.

6. In the Services window, click 
the Close button.

From the Windows NT Control 
Panel:

1. Double-click Services.

The Services dialog box 
appears. 

2. Select OracleHOME_
NAMECMAdminService80

3. Click Stop.

The Services confirmation 
dialog box appears, 
prompting you if it is OK to 
stop the service.

4. Click Yes to acknowledge the 
message.

5. Select OracleHOME_
NAMECManService80 from 
the listing.

6. Click Stop.

The Services confirmation 
dialog box appears, 
prompting you if it is OK to 
stop the service.

7. Click Yes to acknowledge the 
message, and click Close to 
exit the Services window.

Product Windows NT Service Name How to Start How to Stop
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Port Numbers
Port Numbers

Product Default Port Number
How and Where to Change 
the Port Number?

Network Listener 1521

1526

Modify the LISTENER.ORA 
and TNSNAMES.ORA files 
using the Oracle Net8 
Assistant or a text editor.

SNMP 161 Modify the MASTER.ORA 
and ENCAPS.ORA files using 
the Oracle Net8 Assistant or a 
text editor.

Oracle Names 1575 Use the Oracle Net8 Assistant.

Oracle Connection 
Manager

1610

1620

Modify the CMAN.ORA 
configuration file using an 
ASCII text editor.
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Glossary

Note the following special terms when using this guide:

client

A client is a system that runs an Oracle-supported application and connects to the 
shared database(s) on an Oracle8 Server.

connect descriptor

A connect descriptor is a specially formatted description of the destination for a 
network connection. Connect descriptors are constructed using a set of keywords 
and values mapped to service names. For example, an Oracle Tool would use a 
service name representing a connect descriptor to initiate a TNS connection with an 
Oracle8 Server. Each connect descriptor is assigned a service name in the network 
definition and stored in the TNSNAMES.ORA network configuration file, in an 
Oracle Names database, or in a native naming service.

DNS

Domain Name System is a computer used to translate the host name specified in the 
TNSNAMES.ORA file into the host internet address (IP). 

External Naming

External naming refers to service name resolution by using a supported third-party 
naming service. 

external procedure

Function or procedure written in a third-generation language (3GL) that can be 
called from PL/SQL code. Only C is supported for Oracle8 external procedures.
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global database name

The global database name specifies the name by which the network listener 
registers the database instance with an Oracle Names Server and the name by 
which the Oracle Names Server identifies a database. You can use any alias, but 
Oracle Corporation recommends setting the global database name to the value of 
the INITSID.ORA’s DB_NAME and DB_DOMAIN parameters. The default global 
database name is ORACLE.WORLD. DB_DOMAIN can be overwritten by the 
NAMES.DEFAULT_DOMAIN parameter in SQLNET.ORA file.

HOME_NAME

Represents the Oracle home name if you use multiple Oracle homes. This 
convention is not applicable for the first Oracle home. The home name can be up to 
sixteen alphanumeric characters. The only special character allowed in the home 
name is the underscore. 

HOMEID

Represents a unique registry subkey for each Oracle home directory in which you 
install products. A new HOMEID is created and incremented each time you install 
products to a different Oracle home directory on one computer. Each HOMEID 
contains its own configuration parameter settings for installed Oracle products.

Host Naming

Resolves service names through a TCP/IP network's Domain Name System (DNS) 
or in the /ETC/HOSTS file. This method is recommended for simple TCP/IP 
environments.

instance

Combination of processes and threads that begins each time a database is started. 
Identified with a unique SID. A default SID, ORCx, is installed during installation 
of the Oracle8 database. 

When you install Oracle8 database for the first time on a computer, your SID is 
typically ORCL. For each subsequent Oracle8 database installation into a different 
Oracle home on the same computer, ORCL is automatically incremented by one 
(that is, for a second Oracle8 database installation, the SID is ORC1, for a third 
Oracle8 database installation, the SID is ORC2, etc.).

The background threads and memory areas required to access an Oracle8 database. 
A database system requires one instance and one database. Every Oracle8 instance 
has a single system global area (SGA); a multiple-user instance also requires several 
background threads.
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listener

A listener enables an Oracle8 Server to accept connections from client computers 
over Net8. Also, referred to as network listener.

Local Naming

Resolves service names to network addresses by using information configured and 
stored on each individual client. Local Naming is most appropriate for simple 
distributed networks with a small number of services that change infrequently. 

loopback

A loopback uses Net8 to go from the server right back to itself.

MIB

Management Information Base. The collection of variables that can be queried to 
describe attributes of an object, such as the use, performance, and initialization 
parameters of a database server. 

Net8

The Oracle client/server communication software that offers transparent operation 
to Oracle tools or databases over any type of network protocol and operating 
system.

network listener

An executable program that enables an Oracle8 server to accept connections from 
client computers over Net8. 

Oracle8 Database

Known formally as either Oracle8 Enterprise Edition or Oracle8, the Oracle8 
database is an Object Relational Database Management System (ORDBMS). 

Oracle8 Server

See server.

Oracle Names

Oracle Names stores names and addresses of all database services on a network on 
a Names Server. Connection requests are routed through the Names Server, which 
resolves the service name to a network address. The information is then returned to 
the client
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Oracle Names Server 

A server that uses Oracle Names to store a service’s network address along with its 
simple name sot that client applications can request connection with simple names, 
rather than lengthy addresses.

OracleSNMPPeerMasterAgent

The Oracle Peer SNMP Master Agent is the process on a managed node that accepts 
queries from the management framework and communicates with the subagents to 
answer the query.

OracleSNMPPeerEncapsulator

The OracleSNMPPeerEncapsulator allows you to encapsulate the Microsoft master 
agent so that all SNMP requests from a Network Management Station (NMS) are 
sent to Oracle Peer SNMP Master Agent.

Oracle Protocol Adapters

A set of products which map Net8 functionality to industry-standard protocols 
used in client-server connections. 

ORANT

Default Oracle home directory where Oracle Installer installs the Oracle8 database 
on Windows NT.

ORAWIN95

Default Oracle home directory where Oracle Installer installs the Oracle8 database 
on Windows 95.

region

A collection of Names Servers which share a common service registry.

server

A server is a host system that runs a multi-user Oracle8 Object Relational Database 
Management System (ORDBMS) and maintains at least one database that can be 
shared by remote clients. Server refers to the ORDBMS that is using Net8 and is 
capable of serving any Oracle client.

service name

A service name is a short, convenient name mapped to a network address contained 
in a TNS connect descriptor. Users need only know the appropriate service name to 
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make a TNS connection. Service names are created with the Oracle Net8 Easy 
Config or Oracle Net8 Assistant.

SID

A unique name for an Oracle database instance. To switch between Oracle 
databases, users must specify the desired SID. The SID is included in the 
CONNECT DATA parts of the connect descriptors in a TNSNAMES.ORA file, and 
in the definition of the network listener in the LISTENER.ORA file. Also known as 
system ID.

SQL

SQL is Structured Query Language—the internationally accepted standard for 
defining and manipulating relational databases.

SQL*Net

SQL*Net is the Oracle7 client/server communication software that offers 
transparent operation to Oracle tools or databases over any type of network 
protocol and operating system.

system ID

A synonym for instance identifier. Often abbreviated to SID.

TNS

Transparent Network Substrate (TNS) is the Oracle networking technology that 
provides a single application interface to all industry-standard networking 
protocols. 

TNS-based application

A TNS-based application uses the common functions of the TNS interface to 
transmit data across one or more networks. Net8 is a TNS-based application. 

well-known address

Address for Names Server(s) hardcoded into the Names Server and related clients. 
Names Server(s) become available at this well-known address(es), eliminating need 
for specification of address in configuration files.
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authentication adapters

described, 2-7
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CMAN_RULES, C-33
overview, C-29

CMAN.TRC file, 10-18, D-8
CMCTL80 utility, 6-35, 7-5, 10-8, 10-9, 10-10, 10-11
coexistence, 4-1 to 4-10
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defined, 4-3
installation, 4-10
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configuration, 6-1
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CMAN.ORA, 6-23, C-2, C-29
content, C-1 to C-33
LISTENER.ORA, 6-2, 6-3, C-2, C-21
NAMES.ORA, C-2
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TNSNAMES.ORA, 6-2, 6-3, C-2, C-4
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ARGS, C-11
ARGV0, C-11
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AUTOMATIC_IPC, 6-24, C-19
CONNECT_DATA, C-8
CONNECT_TIMEOUT_LISTENER, D-19
DB_DOMAIN, C-7
DESCRIPTION, C-7
DST, C-33
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HOST, C-10
KEY, 4-10
LLU, C-11
LLU_NAME, C-11
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LOCAL_LU, C-11
LOCAL_LU_NAME, C-11
LOG_DIRECTORY, C-26
LOG_DIRECTORY_CLIENT, C-17

LOG_DIRECTORY_
CLIENT/LISTENER/SERVER, 10-24

LOG_FILE, C-26
LOG_FILE_CLIENT, C-17
LOG_LEVEL, C-31
LU_NAME, C-11
MAXIMUM_CONNECT_DATA, C-31
MAXIMUM_RELAYS, C-31
MDN, C-11
MODE, C-11
modifying or adding, B-1 to B-10
NAMES.DEFAULT_DOMAIN, C-6, C-19, D-11, 
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SERVICE, C-10
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SID, C-10
SID_LIST_LISTENER_NAME, 6-33, 7-3
SOURCE_ROUTE, 6-28, C-8
SQLNET.AUTHENTICATION_SERVICES, 8-4, 

8-5, D-19
SQLNET.CRYPTO_SEED, D-19
SRC, C-33
SRV, C-33
STARTUP_WAITTIME, C-26
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TNSPING.TRACE_LEVEL, C-19
TP_NAME, C-11
TPN, C-11
TRACE_DIRECTORY, C-26
TRACE_DIRECTORY_CLIENT, C-18
TRACE_DIRECTORY_

CLIENT/LISTENER/SERVER, 10-24
TRACE_FILE, C-26
TRACE_FILE_CLIENT, C-18
TRACE_LEVEL, C-26
TRACE_LEVEL_CLIENT, C-18, D-11
TRACE_LEVEL_

CLIENT/LISTENER/SERVER, 10-24
TRACE_UNIQUE_CLIENT, C-18
TRACING, 10-24, C-32
USE_ASYNC_CALL, C-32
USE_PLUG_AND_PLAY, C-27
USE_PLUG_AND_PLAY_LISTENER_

NAME, D-17
USE_SHARED_SOCKET, B-7

configuring
advanced, 8-1 to 8-11
an additional address, 10-17
authentication adapters, 8-4
externa naming, 6-3
external naming, 8-2
external procedures, 8-9
Host Naming, 6-3, 6-4
listener addresses, C-10
Local Naming, 6-3, 6-6
Named Pipes Protocol Adapter, 8-6
naming methods, 6-22, 10-13
NDS Authentication Adapter, 8-4, 10-14
networking files for Oracle Protocol 

Adapters, C-10
Oracle Advanced Networking Option, 8-7
Oracle Connection Manager, 6-23
Oracle Names, 6-3, 6-11
overview, 6-2
testing on the client, 6-38
testing on the server, 6-31
the network, 6-1
Windows NT Native Authentication 

Adapter, 8-5
with Oracle Names, 6-2

without Oracle Names, 6-2
connect descriptor

defined, Glossary-1
identified by service names, C-7
specifying, C-7
use of, C-7

connect string, 1-2
CONNECT_DATA

definition of, C-8
example of, C-8
syntax, C-9
use of, C-8

CONNECT_DATA keyword, C-7
CONNECT_DATA parameter, C-8
CONNECT_DATA, Oracle Connection 

Manager, C-30
CONNECT_TIMEOUT_LISTENER 

parameter, D-19
connecting

Bequeath Protocol Adapter, 7-7, 7-8
client request, 1-3
external naming, 8-3
Host Naming, 7-7, 7-8
Local Naming, 7-7, 7-8
LOCAL parameter, B-6
multiple, C-23
NDS Authentication Adapter, 8-5
Oracle Names, 7-7, 7-8
Oracle Net8 Easy Config, 6-43
Oracle7 connections to Oracle8 databases, 4-3
Oracle8 connections to Oracle7 databases, 4-5
REMOTE parameter, B-6
server response, 1-3
specify destination address for TCP/IP, 6-38
TNSPING, 6-42
to a database, 7-1 to 7-8
to multiple databases, C-23
use PING, 6-40
verify, 6-42
with NDS Native Naming Adapter, 8-2

connection
concurrent, increasing number of, C-24

connection concentration, 2-6, 2-14
connection pooling, 2-14
Customer Support
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contacting, xvi
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supported platforms, 2-3
supported vendors, 2-9
using, 8-7

D
database connections, 7-1 to 7-8
DB_DOMAIN parameter, 6-16, C-7
DB_NAME parameter, 6-16
DCE Integration

described, 2-11
supported platforms, 2-3
supported vendors, 2-9

dead connection detection, C-16, C-17
default domains, C-21
DESCRIPTION parameter, C-7
diagnosing

client, D-5
external procedures, D-18
Oracle Names, D-16
server, D-3

directory, A-2
ADMIN, A-2
ERROR, A-2
LOG, A-2
NAMES, A-2
NET80, A-2
SAMPLE, A-2
TNSAPI, A-2

directory structure, A-1 to A-2
DisplayName parameter, B-3
DNS, 1-2, 6-3
DNS, defined, Glossary-1, Glossary-2
documentation

generic, xxv
Domain Name System, 1-2, 6-3, Glossary-2
DST parameter, C-33
Dynamic Discovery Option, 6-14

E
encapsulator

OracleSNMPPeerEncapsulator, 9-3

ERROR directory, A-2
error messages

resolving, xvi, D-1 to D-20
external naming, 8-2

client configuration, 8-3
connecting with Server Manager, 8-3
defined, Glossary-1
described, 2-13, 6-3
NDS Native Naming Adapter, 8-2
server configuration, 8-2
using, 8-2

external procedures
configuring, 8-9
defined, Glossary-1
requirements, 8-9
troubleshooting, D-18

F
firewall support, 2-6

G
generic document references

Defining the Network Listener Name, C-23
TNSNAMES.ORA, C-10

generic documentation references
Client Discovery of Names Servers, 6-13
CMCTL, 6-35
Configuring TNSNAMES.ORA, C-10
CONNECT command, 7-1
connect string, 7-1
Conventions, xxii
Defining the Network Listener Address, C-23
Defining the Network Listener Name, C-23
LISTENER.ORA, C-26
Logging, D-7
LSNRCTL, 6-34
NAMESCTL, 6-20
NAMES.LOG, D-7
Net8 Products, 2-2
ORA-3113

end of file communication channel, D-15
Oracle Advanced Networking Option 

Products, 2-10
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ORACLE_HOME, xxiii
Server Configuration, 6-6
Specifying Service Names, C-6
Tracing, D-8
Using SQLNET.ORA Logging and Tracing 

Parameters, C-17
global, 6-16
global database name, defined, 6-16, Glossary-2
GLOBAL_DBNAME parameter, C-27

configuration parameters
GLOBAL_DBNAME, 6-5, 6-17

GLOBAL_DBNAME parameter, with Host 
Naming, 6-5

GLOBAL_DBNAME parameter, with Oracle 
Names, 6-17

H
HOME_NAME, defined, xxiii, Glossary-2
HOMEID, defined, xxiv, Glossary-2
Host Naming

client configuration, 6-5
connecting with Server Manager, 7-7
connecting with SQL*Plus, 7-8
defined, Glossary-2
described, 2-13, 6-3
LISTENER.ORA, C-28
requirements, 6-4
server configuration, 6-5
supported vendors, 2-8
using, 6-4

HOST parameter, C-10
HOSTS file, 6-38

I
Identix (Biometric) Authentication Adapter

supported platforms, 2-3
supported vendors, 2-9
using, 8-7

Image Cartridge, external procedures, 8-9, D-18
ImagePath parameter, B-3
INITSID.ORA configuration file

listener load balancing configuration, 2-6, 2-14, 
2-15

installation, 3-1 to 3-4
results, 3-2
verifying, 3-4

instance, defined, Glossary-2
IP addresses

determining, 6-39
specifying, C-8

IPC
connection, 4-10, 5-5
KEY, 4-10

K
Kerberos Authentication Adapter

supported platforms, 2-3
supported vendors, 2-9
using, 8-8

KEY parameter, 4-10
keywords

specifying for Oracle Protocol Adapters, C-10

L
listener

1521 port, E-5
1526 port, E-5
ADDRESS, C-7
default name, C-23
defined, Glossary-3
describing databases, C-25
handling concurrent connections, C-24
increasing queue size, C-24
LSNRCTL80, 6-34, 7-4, 10-5, 10-6, D-12
OOracleHOME_NAMETNSListener80 

service, 10-5
OracleHOME_NAMETNSListener80 

service, 6-16, 6-34, 7-4, 10-6, E-2
OracleHOME_NAMETNSListener80LSNR 

service, 6-34, 7-4, 10-5, 10-6, E-2
starting from the command line, 6-34, 7-4, 10-5, 

D-12
starting from the Control Panel, 6-16, 6-34, 7-4, 

10-5
stopping from the command line, 10-6
stopping from the Control Panel, 10-6
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listener address, C-23
Bequeath Protocol Adapter address, C-15
LU6.2 Protocol Adapter address, C-14
Named Pipes Protocol Adapter address, C-13
SPX Protocol Adapter address, C-12
TCP/IP Protocol Adapter address, C-12

listener address configuration, C-10
listener load balancing, 2-15
LISTENER.LOG file, D-7, D-8
LISTENER.ORA file, 6-2, 6-3, C-2

Connection Manager, C-30
Host Naming, C-28
listener address, C-23
listener name definition, C-23
Oracle Names, C-27
overview, C-21
relationship to TNSNAMES.ORA, C-5

LISTENER.TRC file, 10-18, D-8
LLU parameter, C-11
LLU_NAME parameter, C-11
Local Naming

client configuration, 6-10
connecting with Server Manager, 7-7
connecting with SQL*Plus, 7-8
defined, Glossary-3
described, 2-13, 6-3
server configuration, 6-6
using, 6-6

LOCAL parameter, B-6
LOCAL_LU parameter, C-11
LOCAL_LU_NAME parameter, C-11
LOG directory, A-2
log files, D-7

LISENER.LOG, D-7, D-8
SQLNET.LOG, C-17, D-7

LOG_DIRECTORY parameter, C-26
LOG_DIRECTORY_CLIENT parameters, C-17
LOG_DIRECTORY_CLIENT/LISTENER/SERVER 

parameter, 10-24
LOG_FILE parameter, C-26
LOG_FILE_CLIENT parameter, C-17
LOG_LEVEL parameter, C-31
logging

listener, D-7, D-8
SQL*Net, C-17, D-7

loopback test, 6-36, 6-43, D-4
loopback, defined, Glossary-3
LSNRCTL80 utility, 6-34, 7-4, 10-5, 10-6, D-12

starting from the Control Panel, 9-6, 9-8
LU_NAME parameter, C-11
LU6.2 Protocol Adapter

address specification, C-14
described, 2-4
description, 2-4
supported platforms, 2-2
supported vendors, 2-8
supporting networks, 2-4
supporting topologies, 2-4

M
master agent

Oracle SNMPPeerMasterAgent, 9-3
MAXIMUM_CONNECT_DATA parameter, C-31
MAXIMUM_RELAYS parameter, C-31
MDN parameter, C-11
MIB, defined, Glossary-3
migration, 4-1 to 4-9

defined, 4-3
file names, 4-9
installation, 4-7
Oracle service names, 4-9
SQL*Net and Net8, 4-7

migration issues, 4-7
MODE parameter, C-11
MTS, 2-15
multiple configuration files, C-3
multiple Oracle homes, 5-1 to 5-6

CMCTL80, 5-2
control utilities, 5-2
defined, 5-2
listener, 5-5
listener startup mode, 5-5
LSNRCTL80, 5-2
NAMESCTL80, 5-2
Oracle Connection Manager, 5-6
Oracle Names Server, 5-6
port numbers, 5-5
service names, 5-4

multiplexing, 2-6
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multi-protocol interchange, 2-6, 4-2
multi-protocol support, 2-6, 4-2
multi-threaded server parameters, 6-30
multi-threaded server support, 2-15

N
Named Pipes Protocol Adapter

address specification, C-13
addresses for, C-13
described, 2-4
description, 2-4
supported platforms, 2-2
supported vendors, 2-8
with an Oracle Names Server, 8-6

NAMES directory, A-2
NAMESCTL80 utility, 6-20, 6-32, 7-2, 10-2, 10-3

discovering Oracle Names Servers, 6-20, 6-21
Oracle Names

NAMESCTL80, 7-6
NAMES.DEFAULT_DOMAIN parameter, C-6, 

C-19, D-11, Glossary-2
NAMES.DIRECTORY_PATH parameter, 6-22, 8-2
NAMES.ORA file, C-2
NAMES.PREFERRED_SERVICES parameter, C-19
NAMESthread_id.TRC file, D-8
NAMES.TRACE_LEVEL parameter, 10-24, D-9
NAMES.TRC file, 10-18
naming method

External Naming, 8-2
external naming, 6-3, 8-2
Host Naming, 6-3, 6-4, 10-14
Local Naming, 6-3, 6-6, 10-14
Oracle Names, 6-3, 6-11, 10-14

naming methods, 10-13
NDS Authentication Adapter

client configuration, 8-5
connecting with Server Manager, 8-5
described, 2-7
NetWare Server configuration, 8-4, 8-5
supported platforms, 2-2
supported vendors, 2-8
using, 8-4, 10-14

NDS Native Naming Adapter
described, 2-7

description, 2-7
establishing connections with, 8-2
supported vendors, 2-8
using, 8-2

Net8
architecture, 1-4
coexistence with SQL*Net V2, 4-10
concept described, 1-3
defined, Glossary-3
described, 1-4
differences from SQL*Net, 4-2, 4-9
introducing, 1-1 to 1-5
migration from SQL*Net, 4-7
overview, 1-1 to 1-5
products described, 2-1 to 2-16
service names, 4-9

Net8 Client
described, 2-3
supported platforms, 2-2

Net8 OPEN described, 2-16
Net8 Server

described, 2-3
supported platforms, 2-2

Net8, configuration changes to enable coexistence 
with SQL*Net Version 2, 4-10

NET80 directory, A-2
NET80 parameter, B-2
NetWare Directory Services (NDS) Native Naming 

Adapter, supported platforms, 2-2
network

topologies supporting LU6.2 protocol, 2-4
network access control, 2-6, 2-15
network configuration

centralized management, 6-2
localized management, 6-2

network listener, defined, Glossary-3
network protocols, described, 1-5
Network Security and Single Sign-On, supported 

platforms, 2-3
Network Security, described, 2-10

O
ObjectName parameter, B-3
Open Systems Interconnect (OSI) model, 2-4
Index-7



ORA-00508, D-12
ORA-06512, D-18
ORA-12154, D-11
ORA-12203, 6-41, D-12, D-19
ORA-1253, D-19
ORA-12535, 6-41
ORA-12538, D-12
ORA-12541, 6-41
ORA-12545, 6-38
ORA-12547, D-19
ORA-28575, D-18
ORA-3113, D-15
ORA-3114, D-15
ORA-3121, D-16
Oracle Advanced Networking Option

components described, 2-10
configuring, 8-7
described, 2-7
NDS Native Naming Adapter, 2-7
supported platforms, 2-3

Oracle Connection Manager, C-30
1610 port, E-5
1620 port, E-5
administration, 10-7
client configuration, 6-25
CMAN.ORA file, C-29
CMCTL80, 6-35, 7-5, 10-8, 10-9, 10-10, 10-11
configuration, 6-23
connection concentration, 6-23, 6-30
Connection Manager configuration, 6-29
described, 2-6
multi-protocol support, 6-23, 6-29
network access control, 6-23, 6-30, C-33
non-TCP/IP protocol adapters, 6-29
optional parameters, 6-30
OracleHOME_NAMECMAdminService80 

service, 6-35, 10-8, 10-10, E-4
OracleHOME_NAMECManService80 

service, 6-35, 10-8, 10-9, 10-10, 10-11, E-4
requirements, 6-24
server configuration, 6-30
starting from the command line, 6-35, 7-5, 10-8, 

10-9, 10-11
starting from the Control Panel, 6-35, 10-8, 10-9, 

10-11

stopping from the command line, 10-10
stopping from the Control Panel, 10-10
supported platforms, 2-2
TNSNAMES.ORA file, 6-28
tracing, 10-18

Oracle Home Selector, 5-3
Oracle home, defined, xxiii
Oracle Names, C-19

1575 port, E-5
administration, 10-2
client discovery of Names Servers, 6-13
configure clients and servers, 6-21
configuring, 6-11
connecting with Server Manager, 7-7, 7-8
connection not established, D-16
create SDNS.ORA file, 6-20
create well-known Oracle Names Server, 6-18
defined, Glossary-3
described, 2-13, 6-3
differences between versions, 6-14
discovering Oracle Names Servers, 6-20
Dynamic Service Registration, 6-12
LISTENER.ORA, C-27
Named Pipes Protocol Adapter, 8-6
NAMESCTL80, 6-20, 6-32, 7-2, 10-2, 10-3
Oracle Names Server configuration, 6-19
OracleHOME_NAMEClientCache80, E-3
OracleHOME_NAMEClientCache80 

service, 7-6, 10-12, E-3
OracleHOME_NAMENamesService80, E-3
OracleHOME_NAMENamesService80 

service, 6-32, 7-2, 10-2, 10-3, E-3
server configuration, 6-16
service not resolved, D-17
starting client cache from the command 

line, 7-6, 10-12
starting client cache from the Control Panel, 7-6, 

10-12
starting from the command line, 6-20, 6-32, 7-2, 

10-2
starting from the Control Panel, 6-20, 6-32, 7-2, 

7-5, 10-2
stopping from the command line, 10-3
stopping from the Control Panel, 10-3
supported platforms, 2-2
Index-8



trace files, D-9
tracing, 10-18
troubleshooting, D-16
using, 6-11

Oracle Names Server
defined, Glossary-4
described, 2-6
supported platforms, 2-2

Oracle Net8 Administrators Guide
TNSNAMES.ORA, C-10

Oracle Net8 Assistant, 4-2
adding an address, 10-17
configuring Oracle Connection Manager, 6-25
creating and configuring Oracle Names 

Servers, 6-20
described, 2-5, 2-12
discovering Oracle Names Servers, 6-21
naming methods, 6-22, 10-13
supported platforms, 2-2
tracing, 10-19

Oracle Net8 Easy Config, 4-2
creating a service name, 6-6
deleting a protocol address, 10-16
deleting a service name, 10-16
described, 2-5
loopback test, 6-36, 6-43
modifying a service name, 10-15
supported platforms, 2-2

Oracle Network Manager, 2-12, 4-2, 4-4
Oracle Protocol Adapters

defined, Glossary-4
described, 1-5, 2-4
overview, 1-5, 2-7
supported, 1-5

Oracle Security Server
described, 2-15
overview, 2-15

Oracle TCP/IP Protocol Adapter
addresses for, C-12

Oracle Trace, D-9
Oracle8 database, defined, Glossary-3
Oracle8 Server, defined, Glossary-3
OracleHOME_NAMEClientCache80 key, B-2
OracleHOME_NAMEClientCache80 service, 3-3, 

6-13, 7-6, 10-12, E-3

OracleHOME_NAMECMAdminService80 key, B-2
OracleHOME_NAMECMAdminService80 

service, 3-3, 6-24, 6-35, 10-8, 10-10, E-4
OracleHOME_NAMECManService80 key, B-2
OracleHOME_NAMECManService80 service, 3-3, 

6-35, 10-8, 10-9, 10-10, 10-11, E-4
OracleHOME_NAMENames80 key, B-2
OracleHOME_NAMENamesService80 service, 3-3, 

6-20, 6-32, 7-2, 10-2, 10-3, E-3
OracleHOME_NAMETNSListener80 key, B-2
OracleHOME_NAMETNSListener80 service, 3-3, 

6-16, 6-34, 7-4, 8-6, 10-5, 10-6, E-2
OracleHOME_NAMETNSListener80LSNR 

service, 6-16, 6-34, 7-4, 10-5, 10-6, E-2
OracleSNMPPeerEncapsulator, 

defined, Glossary-4
OracleSNMPPeerMasterAgent, 

defined, Glossary-4
ORANT, defined, Glossary-4
ORAWIN95, defined, Glossary-4
overview

of TNSNAMES.ORA file, 9-9, 9-10

P
PARTNER_LU_LOCAL_ALIAS parameter, C-11
PARTNER_LU_NAME parameter, C-11
PASSWORD parameter, C-26
PATH, 5-2

changing at command line, 5-3
changing at system level, 5-3
changing from Oracle Home Selector, 5-3

PING
testing TCP/IP, 6-40

PIPE parameter, C-11
PLU parameter, C-11
PLU_LA parameter, C-11, D-14
POOL_SIZE parameter, C-25
port numbers, E-1 to E-5
PORT parameter, C-10
PRESPAWN_MAX parameter, C-25
Prespawned Dedicated Server Processes, C-25
PROGRAM parameter, C-11
PROTOCOL parameter, C-10, C-25
protocol stack vendors, 2-8
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R
README files, A-2
region, defined, 6-19, Glossary-4
registry

adding parameters, B-1 to B-10
DisplayName, B-3
editing for Windows NT, B-8
ImagePath, B-3
modifying parameters, B-1 to B-10
NET80 parameter, B-2
ObjectName, B-3
OracleHOME_NAMEClientCache80 key, B-2
OracleHOME_NAMECMAdminService80 

key, B-2
OracleHOME_NAMECManService80 key, B-2
OracleHOME_NAMENames80 key, B-2
OracleHOME_NAMETNSListener80 key, B-2
REGEDIT, B-3, B-8
REGEDT32, B-3, B-8

RELAY_STATISTICS parameter, C-32
RENAME GLOBAL_NAME parameter, C-7
REORDER_NS, 6-20, 6-21

S
SAMPLE directory, A-2
SDNS.ORA file, 6-3, 6-13, 6-20
SecurID Authentication Adapter

supported platforms, 2-3
supported vendors, 2-9
using, 8-8

server
defined, Glossary-4
loopback test, 6-43
troubleshooting, D-3

server administration, 10-4
Server Manager, 7-7
SERVER parameter, C-10
SERVERthread_id.TRC file, 10-18, C-18, D-8
service

how to start and stop, E-2
listed, E-2

service names, 1-2, 6-2, E-1 to E-5
adding an address, 10-17

creating, 6-6
defined, Glossary-4
deleting, 10-16
modifying, 10-15
more than one for an SID, C-7
Net8, 4-9
relation to global database name, C-7
requirements, C-7
selecting, C-7
SQL*Net, 4-9
TNSNAMES.ORA, C-7

service names, differences between SQL*Net V2.x 
and Net8, 4-9

SERVICE parameter, C-10
SHOW_TNS_INFO parameter, C-32
SID, 6-2, C-10

as part of CONNECT_DATA, C-8
defined, Glossary-5
definition of, C-25

SID_DESC keyword
use of, 6-5, 6-17, C-25, C-27, C-28

SID_LIST_LISTENER_NAME parameter, 6-33, 7-3
SIDALRT.LOG file, D-15
SIDEINFO.NSD file, D-14
single log on

for accessing servers and databases, 8-2, 8-7
Single Sign-On, described, 2-10
SNA, 2-4
SOURCE_ROUTE parameter, 6-28, C-8
Special terms, Glossary-1
SPX Protocol Adapter

address specification, C-12
described, 2-4
supported platforms, 2-2
supported vendors, 2-8

SQL (Structured Query Language), 
defined, Glossary-5

SQL*Net
coexistence with Net8, 4-10
configuration changes to enable coexistence with 

Net8, 4-10
defined, Glossary-5
differences from Net8, 4-9
introducing, 1-2
migration to Net8, 4-7
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service names, 4-9
SQL*Net and Net8 differences, 4-2
SQL*Net Easy Configuration, 2-12, 4-2, 4-4
SQL*Plus, 7-8
SQLNET.AUTHENTICATION_SERVICES 

parameter, 8-4, 8-5, D-19
SQLNET.CRYPTO_SEED parameter, D-19
SQLNET.EXPIRE_TIME parameter, D-19
SQLNET.LOG file, C-17, D-7
SQLNET.ORA file, 6-3, C-2

authentication, C-20
checksumming, C-20
client parameters, C-19
contents of, C-16
dead connection detection, C-16
default domains, C-21
encryption, C-20
multiple copies, C-3
overview, C-16
purpose of, C-16
relationship to TNSNAMES.ORA, C-6

SQLNETthread_id.TRC file, 10-18, 10-21, C-18, D-8
SQLNET.TRC file, 10-18, 10-21, C-18, D-8
SRC parameter, C-33
SRV parameter, C-33
START_CLIENT_CACHE, 7-6, 10-12
STARTUP_WAITTIME parameter, C-26
SVRMGR30, 7-7
system ID, 6-2

defined, Glossary-5
System Network Architecture (SNA), 2-4

T
TCP/IP Protocol Adapter

address specification, C-12
described, 2-4
supported platforms, 2-2
supported vendors, 2-8

TCP/IP transport, 6-38
terminology, Glossary-1
testing the configuration on the client, 6-38
testing the configuration on the server, 6-31
testing with Oracle Net8 Easy Config, 6-36
testing with PING, 6-40

testing with TNSPING, 6-42
The, C-23
third party applications, 4-4
Time Series Cartridge, external procedures, 8-9, 

D-18
TIMEOUT parameter, C-25
TNS, 1-4, 1-5

defined, Glossary-5
TNS_ADMIN parameter, 4-12, B-7, D-6, D-11
TNSAPI directory, A-2
TNS-based application, defined, Glossary-5
TNSNAMES.ORA file, 6-2, 6-3, C-2, C-3, C-4

connect descriptors, C-7
CONNECT_DATA SID keyword, C-8
descriptor syntax, C-9
listener address, C-7
listener address configuration, C-10
overview, 9-9, 9-10, C-4
purpose of, C-4
relationship to LISTENER.ORA, C-5
relationship to SQLNET.ORA, C-6
service names, C-7
using service names, C-7

TNSPING
using, 6-42

TNSPING80 utility, 6-42
TNSPING.TRACE_DIRECTORY parameter, C-19
TNSPING.TRACE_LEVEL parameter, C-19
TP_NAME parameter, C-11
TPN parameter, C-11
TRACE, A-2
Trace Assistant, D-10

described, 2-12
TRACE directory, A-2
trace files, C-18, D-7

CMAN.TRC, 10-18, D-8
LISTENER.TRC, 10-18, D-8
NAMESthread_id.TRC, D-8
NAMES.TRC, 10-18
SERVERthread_id.TRC, 10-18, C-18, D-8
SQLNETthread_id.TRC, 10-18, 10-21, C-18, D-8
SQLNET.TRC, 10-18, 10-21, C-18, D-8
tracing on server

SQL*Net, 10-18, D-8
tracing on the Oracle Names Server, D-8
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TRACE_DIRECTORY parameter, C-26
TRACE_DIRECTORY_CLIENT parameter, C-18
TRACE_DIRECTORY_

CLIENT/LISTENER/SERVER 
parameter, 10-24

TRACE_FILE parameter, C-26
TRACE_FILE_CLIENT parameter, C-18
TRACE_LEVEL parameter, C-26
TRACE_LEVEL_CLIENT, D-11
TRACE_LEVEL_CLIENT parameter, C-18, D-11
TRACE_LEVEL_CLIENT/LISTENER/SERVER 

parameter, 10-24
TRACE_UNIQUE_CLIENT parameter, C-18
tracing, 10-18

analyze files, 10-25
control utilities, 10-24
LISTENER.ORA, 10-21
Oracle Names, D-9
Oracle Net8 Assistant, 10-19
parameters, 10-24
SQLNET.ORA, 10-19

tracing on client, 10-18, 10-21, C-18, D-8
tracing on Oracle Connection Manager, D-8
tracing on Oracle Names Server, 10-18
tracing on server, 10-18, C-18, D-8
tracing on the Oracle Connection Manager, 10-18
TRACING parameter, 10-24, C-32
Transparent Network Substrate, 1-4

described, 1-5
troubleshooting, xvi, D-1 to D-20

client, D-5
external procedures, D-18
Oracle Names, D-16
questions, D-19
server, D-3

TTL, 6-13

U
USE_ASYNC_CALL parameter, C-32
USE_PLUG_AND_PLAY parameter, C-27
USE_PLUG_AND_PLAY_LISTENER_NAME 

parameter, D-17
USE_SHARED_SOCKET parameter, B-7

V
VIR Cartridge, external procedures, 8-9, D-18

W
well-known address, definition of, Glossary-5
well-known Oracle Names Server, 6-18
Windows NT Native Authentication Adapter

described, 2-7
supported platforms, 2-2
supported vendors, 2-9
using, 8-5

WINSOCK2 support, 2-15, B-7
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